GAMBIT 2.2
Tutorial Guide

September 2004

Licensee acknowledges that use of Fluent, Inc.’s products can only provide an imprecise
estimation of possible future performance and that additional testing and analysis, independent of the Licensor’s products, must be conducted before any product can be finally
developed or commercially introduced. As a result, Licensee agrees that it will not rely
upon the results of any usage of Fluent, Inc.’s products in determining the final design,
composition, or structure of any product.

© 2004 by Fluent, Incorporated
All Rights Reserved. No part of this document may be reproduced or otherwise used in
any form without express written permission from Fluent, Incorporated.

Airpak, FIDAP, FLUENT, GAMBIT, Icepak, MixSim, and POLYFLOW are registered
trademarks of Fluent, Inc.
ImageMagick is © 1996 E.I. du Pont de Nemours and Co.
All other products or name brands are trademarks of their respective holders.

For GAMBIT Technical Support contact information, visit the Fluent, Inc. Web site at
www.fluent.com.

Fluent, Incorporated
Centerra Resource Park
10 Cavendish Court
Lebanon, NH 03766

TABLE OF CONTENTS
0. USING THIS TUTORIAL GUIDE .................................................... 0-1
0.1 What's in This Guide ..................................................................................... 0-1
0.2 How to Use This Guide .................................................................................. 0-2
0.3 Font Conventions............................................................................................ 0-3
0.4 Using the Mouse.............................................................................................. 0-4
0.4.1 Menus and Forms................................................................................. 0-4
0.4.2 Graphics Window ................................................................................ 0-4
0.5 GUI Components............................................................................................ 0-8
0.5.1 Graphics Window ................................................................................ 0-9
0.5.2 Main Menu Bar .................................................................................... 0-9
0.5.3 Operation Toolpad ............................................................................... 0-9
0.5.4 Form Field.......................................................................................... 0-11
0.5.5 Global Control Toolpad ..................................................................... 0-12
0.5.6 Description Window .......................................................................... 0-12
0.5.7 Transcript Window and Command Text Box .................................... 0-12

1. CREATING AND MESHING BASIC GEOMETRY....................... 1-1
1.1 Prerequisites.................................................................................................... 1-1
1.2 Problem Description....................................................................................... 1-2
1.3 Strategy............................................................................................................ 1-3
1.4 Procedure ........................................................................................................ 1-4
Step 1: Create a Brick ................................................................................... 1-5
Step 2: Create an Elliptical Cylinder............................................................. 1-8
Step 3: Unite the Two Volumes .................................................................. 1-10
Step 4: Manipulate the Display................................................................... 1-12
Step 5: Mesh the Volume............................................................................ 1-14
Step 6: Examine the Mesh .......................................................................... 1-16
Step 7: Save the Session and Exit GAMBIT .............................................. 1-19
1.5 Summary ....................................................................................................... 1-20

2. MODELING A MIXING ELBOW (2-D)........................................... 2-1
2.1 Prerequisites.................................................................................................... 2-1
2.2 Problem Description....................................................................................... 2-2
2.3 Strategy............................................................................................................ 2-3
2.4 Procedure ........................................................................................................ 2-4
Step 1: Select a Solver .................................................................................. 2-4
Step 2: Create the Initial Vertices ................................................................. 2-5
Step 3: Create Arcs for the Bend of the Mixing Elbow .............................. 2-10
Step 4: Create Straight Edges...................................................................... 2-13
Step 5: Create the Small Pipe for the Mixing Elbow .................................. 2-15
Step 6: Create Faces From Edges................................................................ 2-23

iii

Table of Contents

Step 7: Specify the Node Distribution ........................................................ 2-26
Step 8: Create Structured Meshes on Faces ................................................ 2-34
Step 9: Set Boundary Types........................................................................ 2-37
Step 10: Export the Mesh and Save the Session ......................................... 2-41
2.5 Summary ....................................................................................................... 2-42

3. MODELING A THREE-PIPE INTERSECTION (3-D) ................... 3-1
3.1 Prerequisites.................................................................................................... 3-1
3.2 Problem Description....................................................................................... 3-2
3.3 Strategy............................................................................................................ 3-3
3.4 Procedure ........................................................................................................ 3-5
Step 1: Select a Solver .................................................................................. 3-5
Step 2: Create the Geometry ......................................................................... 3-5
Step 3: Decompose the Geometry................................................................. 3-9
Step 4: Journal Files.................................................................................... 3-19
Step 5: Turn Off Automatic Smoothing of the Mesh.................................. 3-22
Step 6: Apply Boundary Layers at Walls.................................................... 3-24
Step 7: Mesh the Sphere Octant Volume .................................................... 3-28
Step 8: Mesh the Pipe Volumes .................................................................. 3-30
Step 9: Examine the Quality of the Mesh ................................................... 3-41
Step 10: Set Boundary Types...................................................................... 3-44
Step 11: Export the Mesh and Save the Session ......................................... 3-48
3.5 Summary ....................................................................................................... 3-49

4. MODELING A COMBUSTION CHAMBER (3-D) ......................... 4-1
4.1 Prerequisites.................................................................................................... 4-1
4.2 Problem Description....................................................................................... 4-2
4.3 Strategy............................................................................................................ 4-3
4.4 Procedure ........................................................................................................ 4-6
Step 1: Select a Solver .................................................................................. 4-6
Step 2: Set the Default Interval Size for Meshing ........................................ 4-6
Step 3: Create Two Cylinders ....................................................................... 4-8
Step 4: Subtract the Small Cylinder From the Large Cylinder.................... 4-12
Step 5: Shade and Rotate the Display ......................................................... 4-14
Step 6: Remove Three Quarters of the Cylindrical Volume ....................... 4-15
Step 7: Create the Chamber of the Burner .................................................. 4-18
Step 8: Blend the Edges of the Chamber .................................................... 4-20
Step 9: Decompose the Geometry............................................................... 4-23
Step 10: Generate an Unstructured Hexahedral Mesh ................................ 4-36
Step 11: Examine the Quality of the Mesh ................................................. 4-49
Step 12: Set Boundary Types...................................................................... 4-52
Step 13: Export the Mesh and Save the Session ......................................... 4-57
4.5 Summary ....................................................................................................... 4-58

iv

Table of Contents

5. SEDAN GEOMETRY—VIRTUAL CLEANUP ............................... 5-1
5.1 Prerequisites.................................................................................................... 5-1
5.2 Problem Description....................................................................................... 5-2
5.3 Strategy............................................................................................................ 5-3
5.4 Procedure ........................................................................................................ 5-4
Step 1: Select a Solver .................................................................................. 5-4
Step 2: Import the IGES File As-Is............................................................... 5-5
Step 3: Reset and Import the IGES File Using Virtual Cleanup................... 5-9
Step 4: Eliminate Very Short Edges............................................................ 5-12
Step 5: Automatically Connect All Remaining "Duplicate" Edges ............ 5-16
Step 6: Merge Faces.................................................................................... 5-18
Step 7: Mesh Faces on Car Body................................................................ 5-23
Step 8: Create a Brick Around the Car Body.............................................. 5-26
Step 9: Remove Unwanted Geometry......................................................... 5-29
Step 10: Create Straight Edges on the Symmetry Plane.............................. 5-30
Step 11: Create Faces on the Symmetry Plane............................................ 5-35
Step 12: Create a Volume ........................................................................... 5-41
Step 13: Mesh the Edges............................................................................. 5-43
Step 14: Mesh the Volume.......................................................................... 5-46
Step 15: Examine the Volume Mesh........................................................... 5-48
Step 16: Set Boundary Types...................................................................... 5-51
Step 17: Export the Mesh and Save the Session ......................................... 5-57
5.5 Summary ....................................................................................................... 5-58

6. SEDAN GEOMETRY—TOLERANT IMPORT .............................. 6-1
6.1 Prerequisites.................................................................................................... 6-1
6.2 Problem Description....................................................................................... 6-2
6.3 Strategy............................................................................................................ 6-3
6.4 Procedure ........................................................................................................ 6-4
Step 1: Select a Solver .................................................................................. 6-4
Step 2: Import the IGES File......................................................................... 6-5
Step 3: Check for Very Short Edges ............................................................. 6-8
Step 4: Merge Edges to Remove the Shortest Edge.................................... 6-10
Step 5: Merge Faces.................................................................................... 6-11
Step 6: Create a Brick Around the Car Body.............................................. 6-16
Step 7: Remove Unwanted Geometry......................................................... 6-19
Step 8: Create Straight Edges on the Symmetry Plane................................ 6-20
Step 9: Create Faces on the Symmetry Plane.............................................. 6-25
Step 10: Create a Volume ........................................................................... 6-30
Step 11: Apply Size Functions to Control Mesh Quality............................ 6-32
Step 12: Mesh the Volume.......................................................................... 6-35
Step 13: Examine the Volume Mesh........................................................... 6-37
Step 14: Set Boundary Types...................................................................... 6-40

v

Table of Contents

Step 15: Export the Mesh and Save the Session ......................................... 6-46
6.5 Summary ....................................................................................................... 6-47

7. MODELING FLOW IN A TANK ...................................................... 7-1
7.1 Prerequisites.................................................................................................... 7-1
7.2 Problem Description....................................................................................... 7-2
7.3 Strategy............................................................................................................ 7-3
7.4 Procedure ........................................................................................................ 7-6
Step 1: Select a Solver .................................................................................. 7-6
Step 2: Set the Default Interval Size for Meshing ........................................ 7-6
Step 3: Create Cylinders ............................................................................... 7-8
Step 4: Complete the Geometry Creation.................................................... 7-12
Step 5: Decompose the Geometry............................................................... 7-16
Step 6: Unite Some Parts of the Geometry ................................................. 7-23
Step 7: Subtract the Remaining Parts of the Symmetry Plane .................... 7-26
Step 8: Split off Annulus Pipe to Make the Volumes Meshable ................ 7-31
Step 9: Unite the Side Pipe ......................................................................... 7-40
Step 10: Mesh the Edges............................................................................. 7-42
Step 11: Apply Boundary Layers ................................................................ 7-45
Step 12: Mesh One of the Volumes ............................................................ 7-50
Step 13: Mesh Some Faces ......................................................................... 7-53
Step 14: Modify Mesh Settings on Some Faces.......................................... 7-58
Step 15: Mesh the Volumes ........................................................................ 7-61
Step 16: Examine the Volume Mesh........................................................... 7-65
Step 17: Set Zone Types and Export the Mesh ........................................... 7-67
7.5 Summary ....................................................................................................... 7-72

8. BASIC TURBO MODEL WITH UNSTRUCTURED MESH.......... 8-1
8.1 Prerequisites.................................................................................................... 8-1
8.2 Problem Description....................................................................................... 8-2
8.3 Strategy............................................................................................................ 8-4
8.4 Procedure ........................................................................................................ 8-5
Step 1: Select a Solver .................................................................................. 8-5
Step 2: Import a Turbo Data File .................................................................. 8-6
Step 3: Create the Turbo Profile ................................................................... 8-8
Step 4: Modify the Inlet and Outlet Vertex Locations ................................ 8-12
Step 5: Create the Turbo Volume................................................................ 8-14
Step 6: Define the Turbo Zones .................................................................. 8-16
Step 7: Apply 3-D Boundary Layers........................................................... 8-18
Step 8: Mesh the Blade Cross-Section Edges ............................................. 8-22
Step 9: Mesh the Center Spanwise Face ..................................................... 8-26
Step 10: Mesh the Volumes ........................................................................ 8-28
Step 11: Examine the Mesh ........................................................................ 8-30
Step 12: Specify Zone Types ...................................................................... 8-34
vi

Table of Contents

Step 13: Export the Mesh and Exit GAMBIT ............................................ 8-35
8.5 Summary ....................................................................................................... 8-36

9. LOW-SPEED CENTRIFUGAL COMPRESSOR............................. 9-1
9.1 Prerequisites.................................................................................................... 9-1
9.2 Problem Description....................................................................................... 9-2
9.3 Strategy............................................................................................................ 9-3
9.4 Procedure ........................................................................................................ 9-4
Step 1: Select a Solver .................................................................................. 9-4
Step 2: Import ACIS Geometry..................................................................... 9-5
Step 3: Create the Turbo Profile ................................................................... 9-8
Step 4: Modify the Inlet and Outlet Vertex Locations ................................ 9-11
Step 5: Create the Turbo Volume................................................................ 9-13
Step 6: Define the Turbo Zones .................................................................. 9-15
Step 7: Adjust Edge Split Points................................................................. 9-17
Step 8: Decompose the Turbo Volume ....................................................... 9-20
Step 9: Mesh the Volumes .......................................................................... 9-21
Step 10: Examine the Mesh ........................................................................ 9-23
Step 11: Specify Zone Types ...................................................................... 9-26
Step 12: Export the Mesh and Exit GAMBIT ............................................ 9-27
9.5 Summary ....................................................................................................... 9-28

10. MIXED-FLOW PUMP IMPELLER.............................................. 10-1
10.1 Prerequisites................................................................................................ 10-1
10.2 Problem Description................................................................................... 10-2
10.3 Strategy........................................................................................................ 10-3
10.4 Procedure .................................................................................................... 10-4
Step 1: Select a Solver ................................................................................ 10-4
Step 2: Import a Turbo Data File ................................................................ 10-5
Step 3: Create the Turbo Profile ................................................................. 10-8
Step 4: Modify the Inlet and Outlet Vertex Locations .............................. 10-11
Step 5: Create the Turbo Volume.............................................................. 10-13
Step 6: Define the Turbo Zones ................................................................ 10-15
Step 7: Apply 3-D Boundary Layers......................................................... 10-16
Step 8: Mesh the Pressure and Suction Faces........................................... 10-19
Step 9: Mesh the Volume.......................................................................... 10-21
Step 10: Examine the Mesh ...................................................................... 10-23
Step 11: Specify Zone Types .................................................................... 10-28
Step 12: Export the Mesh and Exit GAMBIT .......................................... 10-30
10.5 Summary ................................................................................................... 10-31

11. INDUSTRIAL DRILL BIT—STEP GEOMETRY ....................... 11-1
11.1 Prerequisites................................................................................................ 11-1
11.2 Problem Description................................................................................... 11-2

vii

Table of Contents

11.3 Strategy........................................................................................................ 11-4
11.4 Procedure .................................................................................................... 11-5
Step 1: Select a Solver ................................................................................ 11-5
Step 2: Import a STEP File ......................................................................... 11-6
Step 3: Merge Faces and Edges to Suppress Model Features..................... 11-9
Step 4: Use Cleanup Tools to Check and Clean Up Geometry................. 11-11
Step 5: Apply Size Functions to Control Mesh Quality............................ 11-18
Step 6: Mesh the Volume.......................................................................... 11-20
Step 7: Examine the Volume Mesh........................................................... 11-22
Step 8: Export the Mesh and Exit GAMBIT ............................................ 11-24
11.5 Summary ................................................................................................... 11-25

12. INDUSTRIAL DRILL BIT—DIRECT CAD IMPORT ............... 12-1
12.1 Prerequisites................................................................................................ 12-1
12.2 Problem Description................................................................................... 12-2
12.3 Strategy........................................................................................................ 12-4
12.4 Procedure .................................................................................................... 12-5
Step 1: Start Pro/ENGINEER ..................................................................... 12-5
Step 2: Start GAMBIT from within Pro/ENGINEER ................................ 12-6
Step 3: Open the Part File ........................................................................... 12-7
Step 4: Display the GAMBIT User Interface.............................................. 12-8
Step 5: Select the Solver ............................................................................. 12-9
Step 6: Import the CAD Geometry ........................................................... 12-10
Step 7: Merge Faces and Edges to Suppress Model Features................... 12-12
Step 8: Use Cleanup Tools to Check and Clean Up Geometry................. 12-14
Step 9: Apply Size Functions to Control Mesh Quality............................ 12-26
Step 10: Mesh the Volume........................................................................ 12-28
Step 11: Examine the Volume Mesh......................................................... 12-30
Step 12: Export the Mesh and Close GAMBIT ........................................ 12-32
Step 13: Exit Pro/ENGINEER and GAMBIT .......................................... 12-34
12.5 Summary ................................................................................................... 12-35

13. CATALYTIC CONVERTER ......................................................... 13-1
13.1 Prerequisites................................................................................................ 13-1
13.2 Problem Description................................................................................... 13-2
13.3 Strategy........................................................................................................ 13-3
13.4 Procedure .................................................................................................... 13-4
Step 1: Select a Solver ................................................................................ 13-4
Step 2: Import the IGES File....................................................................... 13-5
Step 3: Attempt to Heal the Geometry ........................................................ 13-8
Step 4: Eliminate the Bad and Overlapping Faces .................................... 13-11
Step 5: Smooth the Discontinuous Edge................................................... 13-13
Step 6: Replace the Overlapping Face ...................................................... 13-14
Step 7: Attempt Again to Heal the Geometry ........................................... 13-16
viii

Table of Contents

Step 8: Clean Up Holes in the Model ....................................................... 13-18
Step 9: Clean Up Short Edges................................................................... 13-22
Step 10: Clean Up Sharp Angles .............................................................. 13-26
Step 11: Clean Up Large Angles............................................................... 13-29
Step 12: Stitch the Faces to Create a Volume ........................................... 13-32
Step 13: Mesh the Large Circular Faces ................................................... 13-33
Step 14: Apply Size Functions to Control Mesh Quality.......................... 13-36
Step 15: Mesh the Volume........................................................................ 13-38
Step 16: Examine the Volume Mesh......................................................... 13-40
Step 17: Export the Mesh and Save the Session ....................................... 13-44
13.5 Summary ................................................................................................... 13-45

14. AIRPLANE GEOMETRY .............................................................. 14-1
14.1 Prerequisites................................................................................................ 14-1
14.2 Problem Description................................................................................... 14-2
14.3 Strategy........................................................................................................ 14-3
14.4 Procedure .................................................................................................... 14-4
Step 1: Select a Solver ................................................................................ 14-4
Step 2: Import the STEP File ...................................................................... 14-5
Step 3: Clean Up Duplicate Faces............................................................... 14-8
Step 4: View List of Duplicate Edges ....................................................... 14-11
Step 5: Heal the Geometry ........................................................................ 14-12
Step 6: Clean Up Holes............................................................................. 14-13
Step 7: Create a Brick around the Airplane Body..................................... 14-17
Step 8: Delete the Brick High-level Geometry.......................................... 14-20
Step 9: Connect Faces on the Symmetry Plane ......................................... 14-21
Step 10: Create the Flow Volume ............................................................. 14-23
Step 11: Clean Up Sharp Angles .............................................................. 14-25
Step 12: Clean Up Short Edges................................................................. 14-27
Step 13: Modify the Size Function Defaults............................................. 14-29
Step 14: Apply Size Functions to Control Mesh Quality.......................... 14-31
Step 15: Mesh the Airplane Body Surface................................................ 14-37
Step 16: Apply a Size Function to the Symmetry Plane............................ 14-40
Step 17: Mesh the Symmetry Plane .......................................................... 14-45
Step 18: Mesh the Flow Volume............................................................... 14-49
Step 19: Examine the Mesh ...................................................................... 14-51
Step 20: Export the Mesh and Save the Session ....................................... 14-55
14.5 Summary ................................................................................................... 14-56

ix

USING THIS TUTORIAL GUIDE

What’s in This Guide

0. USING THIS TUTORIAL GUIDE
0.1 What’s in This Guide
This guide contains step-by-step examples that teach you how to use GAMBIT to create
and mesh various geometries. Each example illustrates at least one new concept with
respect to GAMBIT geometry creation and mesh generation.
Tutorial 1 includes explicit instructions for all steps in the geometry creation, mesh generation, and examination of a completed mesh. Its purpose is to introduce the beginning
user to several basic features and operations that are available in GAMBIT. The
remaining tutorials are designed for the user who has read or worked through Tutorial 1
or who is already familiar with GAMBIT. Consequently, they are not as explicit in their
instructions as is Tutorial 1.
Some of the tutorials involve the importation of geometry data from existing files.
Specifically, the tutorials that involve data import, and the type of data imported, are as
follows:
•

Tutorial 5—IGES data

•

Tutorial 6—IGES data

•

Tutorial 7—Turbo data

•

Tutorial 8—ACIS data

•

Tutorial 9—Turbo data

•

Tutorial 11—STEP data

•

Tutorial 12—Direct CAD Import

•

Tutorial 13—IGES data

•

Tutorial 14—STEP data

The files that contain the data to be imported are located in the directory where GAMBIT
is installed. (NOTE: This file is included on your installation tape or CD.)
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0.2 How to Use This Guide
If you are new to GAMBIT, you should first work through Tutorial 1 in order to familiarize yourself with the GAMBIT graphical user interface (GUI) and with basic geometry
creation and meshing procedures. You may then want to try a tutorial that demonstrates
features that you are going to use in your application. For example, if you are planning to
start from an existing geometry that requires some cleanup, you should look at Tutorial 5.
Each tutorial demonstrates different GAMBIT features, so it is recommended that you do
each tutorial in order to get the full benefit from this Tutorial Guide.
Note that Step 1 in Tutorials 2 through 6 requires you to select the solver to be used for
the CFD calculation. In many cases, you could select a different solver than the one used
in the tutorial. The solver selection is included in the tutorials to demonstrate the process
of selecting a solver. It also illustrates that the choice of solver dictates the options available in various forms (for example, the boundary types available in the Specify Boundary
Types form).
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0.3 Font Conventions
The following font conventions are used throughout this manual to represent user input
data, the titles of forms and command buttons, options, and the names of modeling
objects.
Font

Description

Example(s)

Courier

Command line arguments,
file names, and other user
input from the keyboard

volume create sphere
GAMBIT.ini

Arial Narrow, Bold

Titles of buttons,
selectors, fields, and
forms as they appear in
the graphical user
interface

Model
Volume
Vertex

Arial Narrow

Titles of options and
commands

Interval size
Lower topology

Arial Narrow, Italic

Names of GAMBIT
topological entities and
coordinate systems

edge.1
vertex.3
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0.4 Using the Mouse
The GAMBIT GUI is designed for use with a three-button mouse. The function associated with each mouse button varies according to whether the mouse is operating on menus
and forms, or in the graphics window. Some graphics-window mouse operations involve
keyboard keys in conjunction with the mouse.
0.4.1 Menus and Forms
Mouse operations for GAMBIT menus and forms require only the left and right mouse
buttons and do not involve any keyboard key operations. Most of the mouse operations
performed on GAMBIT GUI menus and forms require only the left mouse button. The
right mouse button is used to open menus related to command buttons on the toolpads. On
some forms that include a text window, the right mouse button opens a hidden menu of
options such as that described in “Using a Pick List Form” in Section 3.2.8 of the
GAMBIT User’s Guide.
0.4.2 Graphics Window
There are three general types of GAMBIT GUI graphics-window mouse operations:
•

Display

•

Task

•

Vertex creation

Display operations allow you to directly manipulate the appearance of the model in any of
the enabled graphics-window quadrants. Task operations allow you to specify topological
entities and to execute geometry and meshing operations. The vertex creation operation
allows you to create vertices on any displayed coordinate-system grid. (For further information on these operations, see Section 3.3.2 of the GAMBIT User’s Guide.)

0-4
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Display Operations
GAMBIT graphics-window display operations employ all three mouse buttons as well as
the Ctrl keyboard key.
Keyboard Key/
Mouse Button

Mouse Motion

Left-click

Left-drag the cursor in any Rotates the model
direction.

Middle-click

Middle-drag the cursor in
any direction.

Translates the model

Right-click

Right-drag the cursor
vertically.

Zooms the model in or out

Right-click

Right-drag the cursor
horizontally.

Rotates the view of the model
about the center of the graphics
window

Ctrl-left-click

Left-drag the cursor
diagonally.

Enlarges the model, retaining the
model proportions. When you
release the mouse button,
GAMBIT enlarges the display

Double-middle-click

© Fluent Inc., Sep-04
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Task Operations
GAMBIT graphics window task operations employ all three mouse buttons in conjunction
with the Shift key to allow you to pick entities and to execute actions related to GAMBIT
forms. There are two types of task operations:
•

Picking entities

•

Executing actions

Picking Entities
Many GAMBIT modeling and meshing operations require you to specify one or more
entities to which the operation applies. There are two ways to specify an entity for a
GAMBIT operation:
•

Input the entity name in the appropriate list box on the specification form or select
it from the appropriate pick list.

•

Use the mouse to “pick” the entity from the model as displayed in the graphics
window.

When you use the mouse to pick an entity from the model that is displayed in the graphics
window, GAMBIT inserts the entity name in the currently active pick list as if you had
specified its name on the currently open specification form.
GAMBIT provides two types of entity-picking operations, each of which involves the
Shift key. Throughout this guide, you will see expressions such as “Shift-left-click,” which
indicates that you should press and hold the Shift key while clicking the left mouse button.
The two entity picking operations are as follows:
Operation

Description

Shift-left-click

Highlights the entity in the graphics window and includes it in
the currently active pick list.

Shift-middle-click

Toggles between adjoining multiple entities of a given type.

To select a group of objects, Shift-left-drag the mouse to create a box around the objects
to be selected. The specific objects chosen depend on the direction of mouse-pointer
movement when the box is created. Specifically:

0-6
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•

If you Shift-left-drag the mouse pointer toward the lower part of the graphics
window when creating the box, GAMBIT selects all objects touched by the box.

•

If you Shift-left-drag the mouse pointer toward the upper part of the graphics
window when creating the box, GAMBIT selects only those objects that are
completely enclosed in the box.

Executing Actions
When you Shift-right-click the mouse in the graphics window, GAMBIT accepts the
selection of an entity and moves the focus to the next pick list in the form. If the current
pick list is the last one in the form, Shift-right-click executes the operation associated with
the currently open form. In this case, the Shift-right-click operation is equivalent to the act
of clicking Apply on the bottom of the form.

© Fluent Inc., Sep-04
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0.5 GUI Components
GAMBIT allows you to construct and mesh models by means of its graphical user interface (GUI), which is designed to be mouse-driven. The GAMBIT GUI (Figure 0-1)
consists of eight components, each of which serves a separate purpose with respect to the
creating and meshing of a model. The following sections briefly describe the GUI components.
Operation
toolpad

Main menu bar

Geometry
subpad
Graphics
window

Transcript
window
Command
text box

Description
window

Global Control
toolpad

Figure 0-1: The GAMBIT GUI
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0.5.1 Graphics Window
The graphics window is the region of the GUI in which the model is displayed. It is
located in the upper left portion of the GUI and occupies most of the screen in the default
layout. Chapter 3 of the GAMBIT User’s Guide presents a more detailed description of
the graphics window.
0.5.2 Main Menu Bar
The main menu bar is located at the top of the GUI, directly above the graphics window.
It contains four menu items. Each of the items is associated with its own menu of
commands that allow you to perform various GAMBIT operations. To open the menu
associated with any item, left-click the item name (for example, File).
Chapter 4 of the GAMBIT User’s Guide presents detailed descriptions of the menu items,
as well as the commands available on each associated menu.
0.5.3 Operation Toolpad
The Operation toolpad is located in the upper right portion of the GUI. It consists of a
field of command buttons, each of which performs a specific function associated with the
process of creating and meshing a model.
Within the Operation toolpad, command buttons are grouped according to their hierarchy
and purpose in the overall scheme of creating and meshing the model. The topmost group
constitutes the main pad. All other command button groups constitute subpads.
Subpads
When you click a main-pad command button, GAMBIT opens an associated subpad. For
example, if you click the GEOMETRY command button on the main pad, GAMBIT opens
the Geometry subpad.
Each subpad contains command buttons that perform operations related to the overall
purpose of the subpad. For example, the Geometry subpad contains command buttons that
allow you to perform operations related to the creation and refinement of model geometry.
Some of the command buttons located on subpads open related subpads of their own. For
example, when you click the VOLUME command button on the Geometry subpad,
GAMBIT opens the Geometry/Volume subpad.
Each command button on the Geometry/Volume subpad is associated with a specification
form that allows you to specify parameters related to the function indicated on the button.
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Toolpad Command Buttons
Toolpad command buttons allow you to execute program commands related to building,
meshing, or viewing the model and working with the GUI. Some toolpad command
buttons cause a direct action to occur; others open specification forms.
All toolpad command buttons contain symbols representing their functions. Buttons that
perform more than one function (multifunction command buttons) contain small, downward-pointing arrowheads in their lower left corners.
For complete descriptions of the GAMBIT GUI toolpad and command buttons, see
Chapter 3 of the GAMBIT User’s Guide.
Tutorial Convention—Toolpad Command Buttons
GAMBIT geometry and meshing procedures operate by means of specification forms.
Each specification form is associated with a unique combination of GAMBIT toolpad
command buttons.
This tutorial guide employs the following convention to indicate the command button
combination associated with any specification form:
L1 → L2 → L3
where L1 represents the main-pad command button, and L2 and L3 represent the secondand third-level subpad command buttons, respectively. For example, the command button
combination associated with the Create Real Brick form is as follows:

GEOMETRY

→ VOLUME

→ CREATE VOLUME

Note that the toolpad choices are indicated in two ways:
•

The name of the command button that appears in the Description window of
the GAMBIT GUI

•

A picture of the command button

When you see this kind of flow chart in a tutorial, you should left-click the command
buttons in the order shown so that they appear depressed. A command button has a black
border on its top and left-hand side when it is depressed. The GEOMETRY command
button
at the top of the Operation toolpad in Figure 0-1 is an example of a
depressed button. The black border is on the bottom and right-hand side when the button
is not depressed; see the MESH command button

0-10

in Figure 0-1. Note that if a button
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is already depressed, you need not click that button again. In fact, clicking a selected
button will unselect it.
Toolpad choices that require pressing the right mouse button are indicated by an R to the
right of the corresponding command button icon, followed by the icon to select from the
list of available functions. For example,

R

right-click the CREATE VOLUME command button

indicates that you should
, then choose the CREATE REAL

CYLINDER option
from the resulting list. CREATE REAL CYLINDER is the
text that is written in the Description window when you hold the mouse cursor over the
menu item.
0.5.4 Form Field
When you click any subpad command button (except UNDO), GAMBIT opens an associated specification form. Specification forms, such as that shown in Figure 0-2, allow you
to specify parameters related to modeling and meshing operations, the assignment of
boundary attributes, and the creation and manipulation of GAMBIT coordinate systems
and grids.

Figure 0-2: Example GAMBIT specification form
When you open a specification form, it appears in the form field. The form field is located
at the right side of the GUI, immediately below the Operation toolpad.
Text boxes allow you to input alphanumeric data. They are located on forms and appear as
white, indented rectangles (for example, the Width text box in Figure 0-2). The title of any
text box appears immediately to its left. To enter data by means of a text box, left-click in
the box to enable it for user input, and then input the data from the keyboard.
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0.5.5 Global Control Toolpad
The Global Control toolpad is located at the lower right corner of the GUI. Its purpose is
to allow you to control the layout and operation of the graphics window as well as the
appearance of the model as displayed in any particular quadrant. Section 3.4 of the
GAMBIT User’s Guide describes the function and use of each button on the Global
Control toolpad.
0.5.6 Description Window
The Description window is located at the bottom of the GUI, immediately to the left of the
Global Control toolpad. The purpose of the Description window is to display messages
describing the various GUI components, including sashes, fields, windows, and command
buttons.
Messages displayed in the Description window describe the component of the GUI corresponding to the current location of the mouse pointer. As you move the mouse pointer
across the screen, GAMBIT updates the Description window message to reflect the
change in the location of the pointer.
0.5.7 Transcript Window and Command Text Box
The Transcript window is located in the lower left portion of the GUI. The Command text
box is located immediately below the Transcript window.
The purpose of the Transcript window is to display a log of commands executed and
messages displayed by GAMBIT during the current modeling session. The Command text
box allows you to perform GAMBIT modeling and meshing operations by means of
direct keyboard input, rather than by means of mouse operations on the GUI. See the
GAMBIT Command Reference Guide for more details.

0-12

© Fluent Inc., Sep-04

CREATING AND MESHING BASIC GEOMETRY

1. CREATING AND MESHING BASIC GEOMETRY
This tutorial illustrates geometry creation and mesh generation for a simple geometry
using GAMBIT.
In this tutorial you will learn how to:
•

Start GAMBIT

•

Use the Operation toolpad

•

Create a brick and an elliptical cylinder

•

Unite two volumes

•

Manipulate the display of your model

•

Mesh a volume

•

Examine the quality of the mesh

•

Save the session and exit GAMBIT

1.1 Prerequisites
This tutorial assumes you have no prior experience of working with GAMBIT. You
should, however, read Chapter 0, “Using This Tutorial Guide,” to familiarize yourself
with the GAMBIT interface and with conventions used in the tutorial instructions.
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1.2 Problem Description
The model consists of an intersecting brick and elliptical cylinder. The basic geometry is
shown schematically in Figure 1-1.

10

12
6

6
10

10
Figure 1-1: Problem specification
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1.3 Strategy
This first tutorial illustrates some of the basic operations for generating a mesh using
GAMBIT. In particular, it demonstrates:
•

How to build the geometry easily using the “top-down” solid modeling approach

•

How to create a hexahedral mesh automatically

The “top-down” approach means that you will construct the geometry by creating
volumes (bricks, cylinders, etc.) and then manipulating them through Boolean operations
(unite, subtract, etc.). In this way, you can quickly build complicated shapes without first
creating the underlying vertices, edges, and faces.
Once you have built a valid geometry model, you can directly and (in many cases) automatically create the mesh. In this example, the Cooper meshing algorithm is used to automatically create an unstructured, hexahedral mesh. More complicated geometries may
require some manual decomposition before you can create the mesh; this is demonstrated
in subsequent tutorials.
The steps you will follow in this tutorial are listed below:
•

Create two volumes (a brick and an elliptical cylinder).

•

Unite the two volumes.

•

Automatically generate the mesh.

•

Examine the quality of the resulting mesh.

To keep this introductory tutorial short and simple, certain steps that you would normally
follow have been omitted:
•

Adjusting the distribution of nodes on individual edges of the geometry

•

Setting continuum types (for example, identifying which mesh zones are fluid and
which are solid) and boundary types

These details, as well as others, are covered in subsequent tutorials.
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1.4 Procedure
Type
gambit -id basgeom

to start GAMBIT.
This command opens the GAMBIT graphical user interface (GUI). (See Figure 12.) GAMBIT uses the name you specify (in this example, basgeom) as a prefix to
all files it creates: for example, basgeom.jou.

Figure 1-2: The GAMBIT graphical user interface (GUI)

1-4
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Step 1: Create a Brick
1. Create a brick by doing the following:
a) In the Operation toolpad (located in the top right corner of the GAMBIT GUI),
select the GEOMETRY
command button by clicking on it with the left mouse
button. If the Geometry subpad does not appear when you select the GEOMETRY
command button, click it again.
The name of a command button is displayed in the Description window at the
bottom of the GAMBIT GUI when you hold the mouse cursor over the
command button. The GEOMETRY command button will appear depressed
when it is selected. Selecting the GEOMETRY command button opens the
Geometry subpad. Note that when you first start GAMBIT, the GEOMETRY
command button is selected by default.
b) Use the left mouse button to select the VOLUME
Geometry subpad.

command button in the

Again, this command button will be depressed when selected. Selecting this
command button opens the Geometry/Volume subpad.
c) Use the left mouse button to select the CREATE VOLUME
in the Geometry/Volume subpad.

command button

This command sequence opens the Create Real Brick form.

The above description of selecting command buttons can be shortened to the following:
© Fluent Inc., Sep-04
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GEOMETRY

→ VOLUME

→ CREATE VOLUME

The selection of the command buttons will be represented using this method for the
remainder of this tutorial, and in all subsequent tutorials.
d) Left-click in the text entry box to the right of Width in the Create Real Brick form,
and enter a value of 10 for the Width of the brick.
e) Use the Tab key on the keyboard to move to the Depth text entry box, and enter 6
for the Depth of the brick.
The text entry box for Height can be left blank; GAMBIT will set this value to
be the same value as the Width by default.
f) Select Centered from the option menu to the right of Direction.
NOTE: When you first open the Create Real Brick form, the Centered option is
selected by default.
i) Hold down the left mouse button on the option button to the right of Direction
until the option menu appears.
ii) Select Centered from the list.
g) Click Apply.
A message appears in the Transcript window at the bottom left of the
GAMBIT GUI to indicate that a volume, called volume.1, was created. The
volume will be visible in the graphics window, as shown in Figure 1-3.
If you make a mistake at any point in the geometry creation process, you can
to undo multiple levels of geometry
use the UNDO command button
creation. At this point, you have only performed one operation, so you can
only undo one operation.

1-6
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Figure 1-3: Rectangular brick volume (side view)
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Step 2: Create an Elliptical Cylinder
1. Create an elliptical cylinder.
a) Hold down the right mouse button while the cursor is on the CREATE VOLUME
command button.
b) Select the CREATE REAL CYLINDER option
menu.
!

from the resulting

CREATE REAL CYLINDER is the text that is written in the Description window
when you hold the mouse cursor over the

menu item.

This command sequence opens the Create Real Cylinder form.

The above method of selecting command buttons can be shortened to the following:
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

where R indicates a toolpad choice using the right mouse button.
c) Enter a Height of 10.
d) Enter a value of 3 for Radius 1.
e) Enter a value of 6 for Radius 2.

1-8
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f) Retain the default Axis Location of Positive Z.
g) Click Apply.
The brick and elliptical cylinder are shown in Figure 1-4.

Figure 1-4: Brick and elliptical cylinder
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Step 3: Unite the Two Volumes
1. Unite the brick and elliptical cylinder into one volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

This command sequence opens the Unite Real Volumes form.

Notice that the Volumes list box is yellow in the Unite Real Volumes form at
this point. The yellow color indicates that this is the active field in the form,
and any volume selected will be entered into this box on the form.
a) Hold down the Shift key on the keyboard and select the brick by clicking on one of
its edges in the graphics window using the left mouse button.
!

The Shift key must always be held down when selecting entities in the graphics window using the left mouse button. This operation will be referred to as
Shift-left-click in all further steps.
The brick will appear red in the graphics window and its name (volume.1) will
appear in the Volumes list box in the Unite Real Volumes form.

b) Shift-left-click the elliptical cylinder in the graphics window.
c) Click Apply to accept the selection and unite the elliptical cylinder and brick.

1-10

!

Alternatively, you could continue to hold down the Shift key and click the
right mouse button in the graphics window to accept the selection of the
volumes. This method allows you to rapidly accept selections and apply
operations with minimal movement of the mouse.

!

The Shift key must always be held down when clicking the right-mouse button
to accept the selection of entities in the graphics window. This operation is
referred to as Shift-right-click.
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The volume is shown in Figure 1-5. You can rotate the display (as shown in
Figure 1-5) by holding down the left mouse button in the graphics window and
moving the mouse to the left. More information on manipulating the graphics
display is given in the next step.

Figure 1-5: Brick and elliptical cylinder united into one volume
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Step 4: Manipulate the Display
1. Zoom out from the current view by holding down the right mouse button in the
graphics window and pushing the mouse away from you.
2. Rotate the view around the screen center by holding down the right mouse button and
moving the mouse from side to side.
3. Rotate the view in free-form mode by holding down the left mouse button and moving
the mouse.
4. Translate the display by holding down the middle mouse button and moving the
mouse.
5. Divide the graphics window into four quadrants by clicking the SELECT PRESET
CONFIGURATION

command button in the Global Control toolpad.

GAMBIT divides the graphics window into four quadrants and applies a different orientation to the model in each of the four quadrants. Each view of the
graphics window can be manipulated independently. All changes to the model
appear in all portions of the graphics window, unless you disable one or more
quadrants.

1-12
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Figure 1-6: GAMBIT GUI—four graphics-window quadrants
6. Restore a single display of the model.
a) Use the left mouse button to select the graphics-window “sash anchor”—the small
gray box in the center of the graphics window.
b) Use the mouse to drag the sash anchor to the bottom right corner of the graphics
window.
7. Restore the front view of the model by left-clicking the ORIENT MODEL
command button in the Global Control toolpad.
8. Scale the model to fit the graphics window by clicking the FIT TO WINDOW
command button in the Global Control toolpad.
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Step 5: Mesh the Volume
1. Create a mesh for the volume.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Shift-left-click the volume in the graphics window.
GAMBIT will automatically choose the Cooper Scheme Type as the meshing
tool to be used, and will use an Interval size of 1 (the default) under Spacing.
See the GAMBIT Modeling Guide, Chapter 3 for details about the Cooper
meshing tool.
b) Click Apply at the bottom of the Mesh Volumes form.
This accepts the volume you selected as the one to be meshed. It also accepts
the source faces (the faces whose surface meshes are to be swept through the
volume to form volume elements) that GAMBIT has chosen for the Cooper
meshing scheme and starts the meshing. A status bar appears at the top of the
GAMBIT GUI to indicate how much of the meshing is complete.

1-14
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The volume will be meshed as shown in Figure 1-7.

Figure 1-7: Meshed volume
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Step 6: Examine the Mesh
It is important that you check the quality of the resulting mesh, because properties
such as skewness can greatly affect the accuracy and robustness of the CFD solution. GAMBIT provides several quality measures (sometimes called “metrics”)
with which you can assess the quality of your mesh. In the case of skewness measures such as EquiAngle Skew and EquiSize Skew, for example, smaller values are
more desirable. It is also important to verify that all of the elements in your mesh
have positive area/volume. You should consult the documentation for the target
CFD solver for additional mesh quality guidelines.
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.
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a) Select Range under Display Type at the top of the Examine Mesh form.
A histogram appears at the bottom of the form. The histogram consists of a
bar chart representing the statistical distribution of mesh elements with
respect to the specified Quality Type. Each vertical bar on the histogram corresponds to a unique set of upper and lower quality limits.
The 3D Element type selected by default at the top of the form is a brick

.

b) Select or retain EquiSize Skew from the Quality Type option menu.
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c) Click on one of the green vertical bars in the histogram to view elements within a
certain quality range.
Each element has a value of skewness between 0 and 1, where 0 represents an
ideal element. The histogram is divided into 10 bars; each bar represents a
0.1 increment in the skewness value. For a good mesh, the bars on the left of
the histogram will be large and those on the right will be small.
Figure 1-8 shows the view in the graphics window if you click on the fourth
bar from the left on the histogram (representing cells with a skewness value
between 0.3 and 0.4).

Figure 1-8: Elements of the mesh within a specified quality range
d) Move the Upper and Lower slider boxes beneath the histogram to redefine the
quality range to be displayed.
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Step 7: Save the Session and Exit GAMBIT
1. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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1.5 Summary
This tutorial provided a quick introduction to GAMBIT by demonstrating how to create a
simple 3-D geometry using the “top-down” modeling approach. The Cooper scheme was
used to automatically generate an unstructured, hexahedral mesh. For more information
on the Cooper scheme, consult the GAMBIT Modeling Guide.
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2. MODELING A MIXING ELBOW (2-D)
In this tutorial, you will use GAMBIT to create the geometry for a mixing elbow and then
generate a mesh. The mixing elbow configuration is encountered in piping systems in
power plants and process industries. It is often important to predict the flow field and
temperature field in the neighborhood of the mixing region in order to properly design the
location of inlet pipes.
In this tutorial you will learn how to:
•

Create vertices using a grid system

•

Create arcs by selecting the center of curvature and the endpoints of the arc

•

Create straight edges between vertices

•

Split an arc using a vertex point

•

Create faces from edges

•

Specify the distribution of nodes on an edge

•

Create structured meshes on faces

•

Set boundary types

•

Prepare the mesh to be read into FLUENT 4

•

Export a mesh

2.1 Prerequisites
This tutorial assumes that you have worked through Tutorial 1 and you are consequently
familiar with the GAMBIT interface.
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2.2 Problem Description
The problem to be considered is shown schematically in Figure 2-1. A cold fluid enters
through the large pipe and a warmer fluid enters through the small pipe. The two fluids
mix in the elbow.

vout ,Tout

32
39.93°
16
v1 ,T1

16
4

12

32
v2 ,T2

Figure 2-1: Problem specification
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2.3 Strategy
In this tutorial, you will build a 2-D mesh using a “bottom-up” approach (in contrast to
the “top-down” approach used in Tutorial 1). The “bottom-up” approach means that you
will first create some vertices, connect the vertices to create edges, and connect the edges
to make faces (in 3-D, you would stitch the faces together to create volumes). While this
process by its very nature requires more steps, the result is, just as in Tutorial 1, a valid
geometry that can be used to generate the mesh.
The mesh created in this tutorial is intended for use in FLUENT 4, so it must be a single
block, structured mesh. However, this mesh can also be used in any of the other Fluent
solvers. This type of mesh is sometimes called a mapped mesh, because each grid point
has a unique I, J, K index. In order to meet this criterion, certain additional steps must be
performed in GAMBIT and are illustrated in this tutorial. After creating the straight edges
and arcs that comprise the geometry, you will create two faces: one for the main flow
passage (the elbow) and one for the smaller inlet duct. The mesh is generated for the
larger face using the Map scheme; this requires that the number of grid nodes be equal on
opposite edges of the face. You will force GAMBIT to use the Map scheme to mesh the
smaller face as well.
Several other features are also demonstrated in this tutorial:
•

Using a background grid and “snap-to-grid” to quickly create a set of vertices.

•

Using “pick lists” as an alternative to mouse clicks for picking entities.

•

Specifying a non-uniform distribution of nodes on an edge.

•

Setting boundary types.

•

Exporting a mesh for a particular Fluent solver (FLUENT 4 in this case).
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2.4 Procedure
Start GAMBIT.

Step 1: Select a Solver
1. Choose the solver you will use to run your CFD calculation by selecting the following
from the main menu bar:
Solver → FLUENT 4
This selects the FLUENT 4 solver as the one to be used for the CFD calculation.
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). The
solver currently selected is indicated at the top of the GAMBIT GUI.

2-4
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Step 2: Create the Initial Vertices
1. Create vertices to define the outline of the large pipe of the mixing elbow.
TOOLS

→ COORDINATE SYSTEM

→ DISPLAY GRID

This command sequence opens the Display Grid form.

a) Check that Visibility is selected.
This ensures that the background grid will be visible when it is created.
b) Select X (the default) to the right of Axis.
c) Enter a Minimum value of –32, a Maximum value of 32, and an Increment of 16.
d) Click the Update list button.
© Fluent Inc., Sep-04
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This creates a background grid with four cells in the x direction and enters the
x coordinates in the XY_plane X Values list.
e) Select Y to the right of Axis.
f) Enter a Minimum value of –32, a Maximum value of 32, and an Increment of 16.
g) Click the Update list button.
This creates a background grid with four cells in the y direction and enters the
y coordinates in the XY_plane Y Values list.
h) Check that Snap is selected under Options.
The vertices you create later in this step will be “snapped” to points on the
grid where the grid lines intersect.
i) Select Lines (the default) to the right of Grid.
The grid will be displayed using lines rather than points.
j) Click Apply.
GAMBIT creates a four-by-four grid in the graphics window. To see the
whole grid, you must zoom out the display (see Figure 2-2). You can zoom out
the display by pressing and holding down the right mouse button while moving
the cursor vertically upward in the graphics window.
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Figure 2-2: Four-by-four grid to be used for creating vertices

NOTE: You cannot use the FIT TO WINDOW
command button (located
on the Global Control toolpad) to zoom out the display because GAMBIT does
not treat the grid as a model component to be fit within the graphics window.
k) Ctrl-right-click the nine grid points shown in Figure 2-3.
“Ctrl-right-click” indicates that you should hold down the Ctrl key on the
keyboard and click on the point at which the vertex is to be created using the
right mouse button.
You can use the UNDO command button
incorrectly.
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Figure 2-3: Create vertices at grid points
l) Unselect the Visibility check box in the Display Grid form and click Apply.
The grid will be removed from the graphics window and you will be able to
clearly see the nine vertices created, as shown in Figure 2-4.

2-8

© Fluent Inc., Sep-04

MODELING A MIXING ELBOW (2-D)

Procedure

Figure 2-4: Vertices for the main pipe
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Step 3: Create Arcs for the Bend of the Mixing Elbow
1. Create an arc by selecting the following command buttons in order:
GEOMETRY

→ EDGE

→ CREATE EDGE

R

This command sequence opens the Create Real Circular Arc form.

a) Retain the default Method.
Notice that the Center list box is yellow in the Create Real Circular Arc form at
this point. The yellow color indicates that this is the active field in the form,
and any vertex selected will be entered into this box on the form.
b) Shift-left-click the vertex in the center of the graphics window (vertex E in Figure
2-5).
The selected vertex will appear red in the graphics window and its name will
appear in the Center list box under Vertices in the form.
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E

F

G

D

B

Figure 2-5: Vertices used to create arcs
c) Left-click in the list box to the right of End-Points to accept the selection of vertex
E and make the End-Points list box active.
!

Alternatively, you could continue to hold down the Shift key and click the
right mouse button in the graphics window to accept the selection of the
vertex and move the focus to the End-Points list box.
Note that the End-Points list box is now yellow—that is, this is now the active
list box, and any vertex selected will be entered in this box.

d) Shift-left-click the vertex to the right of the center vertex in the graphics window
(vertex F in Figure 2-5).
The vertex will turn red.
e) Select the vertex directly below the one in the center of the graphics window
(vertex D in Figure 2-5).
f) Click Apply to accept the selected vertices and create the arc.
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2. Repeat the above steps to create a second arc. The center of the arc is the vertex in the
center of the graphics window (vertex E in Figure 2-5). The endpoints of the arc are
the vertices to the right and below the center vertex that have not yet been selected
(vertices G and B, respectively, in Figure 2-5). The arcs are shown in Figure 2-6.

Figure 2-6: Vertices and arcs

2-12

© Fluent Inc., Sep-04

MODELING A MIXING ELBOW (2-D)

Procedure

Step 4: Create Straight Edges
1. Create straight edges for the large pipe.

→ EDGE

GEOMETRY

→ CREATE EDGE

R

This command sequence opens the Create Straight Edge form.

a) Shift-left-click the left endpoint of the smaller arc (vertex D in Figure 2-7).

C

D

A

B

H

I

F

G

Figure 2-7: Vertices used to create straight edges
b) Shift-left-click the vertices marked C, A, and B in Figure 2-7, in order.
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c) Click Apply to accept the selection of the vertices.
Three straight edges are drawn between the vertices.
d) Shift-left-click the vertices marked F, H, I, and G in Figure 2-7, in order.
e) Click Apply to accept the selection of the vertices.
The graphics window with the arcs and straight edges is shown in Figure 2-8.

Figure 2-8: Arcs and edges
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Step 5: Create the Small Pipe for the Mixing Elbow
In this step, you will create vertices on the outer radius of the bend of the mixing
elbow and split the large arc into three smaller arcs. Next, you will create vertices for
the inlet of the small pipe. Finally, you will create the straight edges for the small
pipe.
1. Create vertices on the outer radius of the bend, and split the large arc into three
sections.
GEOMETRY

→ EDGE

→ SPLIT/MERGE EDGES

This command sequence opens the Split Edge form.

a) Select the large arc as the edge to split by using the Edge pick list.
Note that you could select the edge in the graphics window; a pick list
provides an alternate way of picking an element.
i. Left-click the black arrow to the right of the Edge list box in the Split Edge
form.
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This action opens the Edge List form. There are two types of pick-list
forms: Single and Multiple. In a Single pick-list form, only one entity can
be selected at a time. In a Multiple pick-list form, you can select multiple
entities.

ii. Select edge.2 under Available in the Edge List form.
!

Note that the Available names may be different in your geometry,
depending on the order in which you created the edges.

iii. Click the − − −> button to pick edge.2.
edge.2 will be moved from the Available list to the Picked list. The large arc
is the edge that should be selected and shown in red in the graphics
window.
iv. Close the Edge List form.
This method of selecting an entity can be used as an alternative to Shiftleft-click in the graphics window. See the GAMBIT User’s Guide for
more information on pick lists.

2-16

© Fluent Inc., Sep-04

MODELING A MIXING ELBOW (2-D)

Procedure

b) Select Real connected (the default) under Type in the Split Edge form.
You should select this option because the edge you selected is real geometry,
not virtual geometry, and because you want the two edges created by the split
to share the vertex created when GAMBIT does the split. See the GAMBIT
Modeling Guide for more information on real and virtual geometry.
c) Select Point (the default) to the right of Split With.
You will split the edge by creating a point on the edge and then using this
point to split the edge.
d) Select Cylindrical from the Type option menu.
You can now use cylindrical coordinates to specify where GAMBIT should
split the edge.
e) Input a value of –39.93 degrees next to t under Local.
This is the angle between the horizontal direction and the position of the righthand side of the opening of the small pipe on the bend of the mixing elbow, as
shown in Figure 2-1.
f) Click Apply.
The large arc is split into two smaller arcs and a vertex is created.
g) Use the Edge List form (or Shift-left-click in the graphics window) to select the
larger of the two arcs just created (edge.9).
h) Input a value of –50.07 degrees next to t under Local.
This is the angle between the horizontal direction and the position of the lefthand side of the opening of the small pipe on the bend of the mixing elbow (90° + 39.93°), as shown in Figure 2-1.
i) Click Apply.
The arc is split into two parts and a second vertex is created on the bend of
the mixing elbow, as shown in Figure 2-9.
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Figure 2-9: Vertices created on outer radius of mixing elbow bend
2. Create points at the small inlet.
GEOMETRY

→ VERTEX

→ MOVE/COPY VERTICES

This command sequence opens the Move / Copy Vertices form.
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a) Select the second vertex created on the bend of the mixing elbow.
b) Select Copy under Vertices in the Move / Copy Vertices form.
c) Select Translate (the default) under Operation.
d) Enter the translation vector (0, -12, 0) under Global to create the new vertex at a
position 12 units below the vertex you selected.
The inlet is 12 units below the second point created on the outer radius of the
bend.
Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
e) Click Apply.
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f) Click the FIT TO WINDOW
command button at the top left of the Global
Control toolpad to scale the model to fit into the graphics window.
g) Select the vertex just created in the graphics window.
h) Enter the translation vector (4, 0, 0) under Global in the Move / Copy Vertices form
to create the new vertex at a position 4 units to the right of the vertex you selected.
i) Click Apply.
The vertices are shown in Figure 2-10.

Figure 2-10: Vertices to define the small pipe
3. Create straight edges for the small pipe.
GEOMETRY

→ EDGE

→ CREATE EDGE

This command sequence opens the Create Straight Edge form.
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a) Create straight edges for the small pipe by selecting the vertices marked K, L, M,
and J in Figure 2-11, in order, and accepting the selection.

K
L

J

M

Figure 2-11: Vertices to be used to create small pipe
The small pipe is shown (with the large pipe) in Figure 2-12.
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Figure 2-12: Completed small pipe
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Step 6: Create Faces From Edges
1. Create a face for the large pipe.
GEOMETRY

→ FACE

→ FORM FACE

This command sequence opens the Create Face From Wireframe form.

a) Shift-left-click each edge of the large pipe, in turn, to form a continuous loop.
!

The large pipe is created from the 10 edges shown in Figure 2-13. If you
select an incorrect edge, click Reset in the Create Face From Wireframe form
to unselect all edges, and then reselect the correct edges.
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Figure 2-13: Edges used to create face for large pipe
Note that the edges must form a continuous loop, but they can be selected in
any order. An alternative method to select several edges is to Shift-left-drag a
box around the edges. The box does not have to completely enclose the edges;
it only needs to enclose a portion of an edge to select it. The edges will be
selected when you release the mouse button.
b) Click Apply to accept the selected edges and create a face.
The edges of the face will turn blue.
2. Create a face for the small pipe by selecting the four edges shown in Figure 2-14 and
then accepting the selected edges.
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Figure 2-14: Edges used to create face for small pipe
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Step 7: Specify the Node Distribution
The next step is to define the grid density on the edges of the geometry. You will
accomplish this graphically by selecting an edge, assigning the number of nodes, and
specifying the distribution of nodes along the edge.
1. Specify the node density on the inlet and outlet of the large pipe.
MESH

→ EDGE

→ MESH EDGES

This command sequence opens the Mesh Edges form.

a) Shift-left-click the edge marked EA in Figure 2-15.
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EB
EE

EC

EF

EJ

EI
EG

EA
EH
ED
Figure 2-15: Edges to be meshed
The edge will change color and an arrow and several circles will appear on
the edge.
b) Shift-left-click the edge marked EB in Figure 2-15.
c) Check that Apply is selected to the right of Grading in the Mesh Edges form and
that Successive Ratio is selected in the Type option menu.
The Successive Ratio option sets the ratio of distances between consecutive
points on the edge equal to the specified Ratio.
d) Enter 1.25 in the text entry box to the right of Ratio.
Alternatively, you can slide the Ratio slider box (the small, gray rectangle with
a vertical line in its center that is located on the slider bar) until 1.25 is
displayed in the Ratio text box.
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e) Select the Double sided check box under Grading.
If you specify a Double sided grading on an edge, the element intervals are
graded in two directions from a starting point on the edge. GAMBIT
determines the starting point such that the intervals on either side of the point
are approximately the same length.
Note that Ratio changes to Ratio 1 and Ratio 2 when you select the Double sided
check box. In addition, the value you entered for Ratio is automatically entered
into both the Ratio 1 and the Ratio 2 text entry boxes.
f) Select Interval count from the option menu under Spacing and enter a value of 10 in
the text entry box. Check that Apply is selected to the right of Spacing.
GAMBIT will create 10 intervals on the edge.
g) Click the Apply button at the bottom of the form.
Figure 2-16 shows the mesh on the inlet and outlet edges of the large pipe.

EB
EE

EC

EF

EJ

EI
EG

EA
EH
ED
Figure 2-16: Edge meshing on inlet and outlet of large pipe
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2. Mesh the four straight edges of the large pipe.
a) Select the edges marked EC, ED, EE, and EF in Figure 2-16.
b) Check that Apply is selected to the right of Grading in the Mesh Edges form and
click the Default button to the right of Grading.
GAMBIT will unselect the Double sided check box and set the Ratio to 1.
c) Check that Apply is selected to the right of Spacing and select Interval count from
the option menu.
d) Enter a value of 15 in the text entry box below Spacing and click the Apply button
at the bottom of the form.
Figure 2-17 shows the mesh on the straight edges of the large pipe.

EB
EE

EC

EF

EJ

EI
EG

EA
EH
ED
Figure 2-17: Mesh on the straight edges of the large pipe
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3. Mesh the edge connecting the two pipes.
a) Select the edge marked EG in Figure 2-17.
b) Check that Apply is selected to the right of Grading in the Mesh Edges form and
enter a value of 1 for the Ratio.
c) Check that Apply is selected to the right of Spacing, select Interval count from the
option menu, and enter a value of 6 in the text entry box below Spacing.
d) Click the Apply button at the bottom of the form.
4. Mesh the two edges on the outer radius of the bend of the mixing elbow.
a) Select the edge marked EH in Figure 2-17. The arrow should point towards the
small pipe. Shift-middle-click the edge to reverse the direction of the arrow if
necessary.
!

The arrow is small and you may have to zoom into the edge to see it. It is
located near the center of the edge.

b) Select the edge marked EI in Figure 2-17. The arrow should point towards the
small pipe. Shift-middle-click the edge to reverse the direction of the arrow if
necessary.
c) Check that Apply is selected to the right of Grading in the Mesh Edges form and
enter a value of 0.9 for the Ratio.
d) Check that Apply is selected to the right of Spacing, select Interval count from the
option menu, and enter a value of 12 in the text entry box below Spacing.
e) Click the Apply button at the bottom of the form.
The mesh on the two edges on the outer radius of the bend is shown in Figure
2-18.
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EB
EE

EC

EF

EJ

EI
EG

EA
EH
ED
Figure 2-18: Mesh on outer bend of pipe
5. Set the grading for the inner bend of the mixing elbow.
a) Select the edge marked EJ in Figure 2-18.
b) Check that Apply is selected to the right of Grading in the Mesh Edges form and
enter a value of 0.85 for the Ratio.
c) Select the Double sided check box.
d) Unselect the Apply check box to the right of Spacing.
You will not set a spacing on this edge, instead you will let GAMBIT calculate
the spacing for you when it meshes the face. You will mesh the face using a
mapped mesh, so the number of nodes on the inner bend of the mixing elbow
must equal the number of nodes on the outer bend, and GAMBIT will
determine the correct number of nodes for you automatically.
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e) Unselect the Mesh check box under Options and click the Apply button at the
bottom of the form.
You unselected the Mesh check box because at this point you do not want to
mesh the edge; you only want to apply the Grading to the edge. GAMBIT will
mesh the edge using the specified Grading when it meshes the large pipe of the
mixing elbow in the next step.
Figure 2-19 shows the edge meshing for the mixing elbow geometry.
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Figure 2-19: Edge meshing for the mixing elbow
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Step 8: Create Structured Meshes on Faces
1. Create a structured mesh for the large pipe.
MESH

→ FACE

→ MESH FACES

This command sequence opens the Mesh Faces form.

a) Shift-left-click the large pipe in the graphics window.
Note that four of the vertices on this face are marked with an “E” in the
graphics window; they are End vertices. Therefore, GAMBIT will select the
Map Type of Scheme in the Mesh Faces form. See the GAMBIT Modeling
Guide for more information on Map meshing.
b) Click the Apply button at the bottom of the form.
GAMBIT will ignore the Interval size of 1 under Spacing, because the mapped
meshing scheme is being used and the existing edge meshing fully determines
the mesh on all edges.
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Notice that GAMBIT calculates the number of nodes on the inner bend of the
mixing elbow and displays these nodes before creating the mesh on the face.
The face will be meshed as shown in Figure 2-20.

Figure 2-20: Structured mesh on the large pipe of the mixing elbow
2. Mesh the small pipe of the mixing elbow.
a) Select the small pipe in the graphics window.
You will force GAMBIT to use the Map scheme to mesh the smaller face.
b) In the Mesh Faces form, select Quad from the Elements option menu under
Scheme and Map from the option menu to the right of Type.
This is an example of “enforced mapping”, where GAMBIT automatically
modifies the face vertex type on the face to satisfy the chosen meshing scheme.
See the GAMBIT Modeling Guide for more information on face vertex types.
c) Retain the default Interval size of 1 under Spacing and click the Apply button at the
bottom of the form.
The structured mesh for the entire elbow is shown in Figure 2-21.
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Figure 2-21: Structured mesh for the mixing elbow

2-36

© Fluent Inc., Sep-04

MODELING A MIXING ELBOW (2-D)

Procedure

Step 9: Set Boundary Types
1. Remove the mesh from the display before you set the boundary types.
This makes it easier to see the edges and faces of the geometry. The mesh is not
deleted, just removed from the graphics window.
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

b) Select the Off radio button to the right of Mesh near the bottom of the form.
c) Click Apply and close the form.
2. Set boundary types for the mixing elbow.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.

© Fluent Inc., Sep-04

2-37

Procedure

MODELING A MIXING ELBOW (2-D)

Note that FLUENT 4 is shown as the chosen solver at the top of the form. The
Specify Boundary Types form displays different Types depending on the solver
selected.
a) Define two inflow boundaries.
i. Enter the name inflow1 in the Name text entry box.
If you do not specify a name, GAMBIT will give the boundary a default
name based on what you select in the Type and Entity lists.
ii. Select INFLOW in the Type option menu.
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iii. Change the Entity to Edges by selecting Edges in the option menu below Entity.
iv. Shift-left-click the main inflow for the mixing elbow in the graphics window
(marked EA in Figure 2-22) and click Apply to accept the selection.

EB

EA
EK

Figure 2-22: Boundary types for edges of mixing elbow
This edge will be set as an inflow boundary.
v. Enter inflow2 in the Name text entry box.
vi. Check that INFLOW is still selected in the Type option menu and select the edge
marked EK in Figure 2-22 (the inlet for the small pipe). Click Apply to accept
the selection of the edge.
b) Define an outflow boundary.
i. Enter outflow in the Name text entry box.
ii. Change the Type to OUTFLOW by selecting OUTFLOW in the option menu
below Type.
iii. Select the main outflow for the mixing elbow (the edge marked EB in Figure
2-22) and click Apply to accept the selection.
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The inflow and outflow boundaries for the mixing elbow are shown in Figure
2-23. (NOTE: To display the boundary types in the graphics window, select
the Show labels options on the Specify Boundary Types form.)

Figure 2-23: Inflow and outflow boundaries for the mixing elbow
Note that you could also specify the remaining outer edges of the mixing
elbow as wall boundaries. This is not necessary, however, because when
GAMBIT saves a mesh, any edges (in 2-D) on which you have not specified a
boundary type will be written out as wall boundaries by default. In addition,
when GAMBIT writes a mesh, any faces (in 2-D) on which you have not
specified a continuum type will be written as FLUID by default. This means that
you do not need to specify a continuum type in the Specify Continuum Types
form for this tutorial.
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Step 10: Export the Mesh and Save the Session
1. Export a mesh file for the mixing elbow.
File → Export → Mesh…
This command sequence opens the Export Mesh File form. Note that the File Type
is Structured FLUENT 4 Grid.

a) Enter the File Name for the file to be exported (2-DELBOW.GRD).
b) Click Accept.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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2.5 Summary
This tutorial shows you how to generate a 2-D mesh using the “bottom-up” approach.
Since the mesh is to be used in FLUENT 4, it was generated in a single block, structured
fashion. Several other features that are commonly used for 2-D mesh generation were also
demonstrated, including entering vertices using a background grid, creating straight edges
and arcs, and specifying node distributions on individual edges. As compared to Tutorial
1, which omitted some details, all steps required to create a mesh ready to read into the
solver were covered, including how to set boundary types, choose a specific Fluent solver,
and finally write out the mesh file.
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3. MODELING A THREE-PIPE INTERSECTION (3-D)
This tutorial employs “primitives”—that is, predefined GAMBIT modeling components
and procedures. There are two types of GAMBIT primitives:
•

Geometry

•

Mesh

Geometry primitives are volumes possessing standard shapes—such as bricks, cylinders,
and spheres. Mesh primitives are standard mesh configurations.
In this tutorial, you will use geometry primitives to create a three-pipe intersection. You
will decompose this geometry into four parts and add boundary layers. Finally, you will
mesh the three-pipe intersection and will employ a mesh primitive to mesh one part of the
decomposed geometry.
In this tutorial you will learn how to:
•

Create volumes by defining their dimensions

•

Split a volume

•

Use GAMBIT journal files

•

Add boundary layers to your geometry

•

Prepare the mesh to be read into POLYFLOW

3.1 Prerequisites
This tutorial assumes you have worked through Tutorial 1 and you are consequently
familiar with the GAMBIT interface.
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3.2 Problem Description
The problem to be considered is shown schematically in Figure 3-1. The geometry
consists of three intersecting pipes, each with a diameter of 6 units and a length of 4 units.
The three pipes are orthogonal to each other. The geometry can be represented as three
intersecting cylinders and a sphere octant at the corner of the intersection.
6

10

Figure 3-1: Problem specification
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3.3 Strategy
In this tutorial, you will quickly create the basic geometry for a three-pipe intersection.
The basic geometry can be automatically meshed with tetrahedra, but your goal in this
tutorial is to create a conformal, hexahedral mesh for POLYFLOW, which requires some
decomposition of the geometry before meshing. Thus, the tutorial shows some of the typical procedures for decomposing a complicated geometry into “meshable” volumes.
The first decomposition involves using a brick to split off a portion of the three-pipe intersection. The resulting volume is described as a sphere “octant” (one-eighth of a sphere)
residing in the corner of the intersection, as shown in Figure 3-2. This volume, which is
very similar in shape to a tetrahedron, will therefore be meshed using GAMBIT’s Tet
Primitive scheme. Note that this creates a hexahedral mesh in a tetrahedral topology; it does
not create tetrahedral cells.

Figure 3-2: Decomposition of the three-pipe intersection geometry
The remaining geometry is then split into three parts, one for each pipe, as shown in
Figure 3-1. To do this, you will create an edge and three faces that are used to split the
volume into the required three parts. These volumes are meshed using GAMBIT’s Cooper
scheme (described in detail in the GAMBIT Modeling Guide). This tutorial illustrates
three different ways to specify the source faces required by the Cooper scheme.
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Two other helpful topics are covered in this tutorial: the use of journal files and the meshing of boundary layers. The journal file contains a record of all your command inputs to
GAMBIT. This file can be edited and your inputs can be converted into variable parameters that allow subsequent geometries (with changes in key dimensions, for example) to be
quickly created and meshed. The boundary layer meshing tools in GAMBIT allow you to
control how the mesh is refined near walls and other boundaries.
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3.4 Procedure
Start GAMBIT.

Step 1: Select a Solver
1. Choose the solver you will use to run your CFD calculation by selecting the following
from the main menu bar:
Solver → POLYFLOW
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). The
solver currently selected is indicated at the top of the GAMBIT GUI.

Step 2: Create the Geometry
1. Create the three pipes for the intersection.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Cylinder form.

a) Create the first pipe.
i. Enter a Height of 10 in the Create Real Cylinder form.
ii. Enter 3 for Radius 1.
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The text entry box for Radius 2 can be left blank; GAMBIT will set this
value by default to be the same value as Radius 1.
iii. Select Positive Z (the default) in the list to the right of Axis Location.
iv. Click Apply.
b) Create the second pipe. Use the same Height and Radius 1 as above, and select
Positive X in the list to the right of Axis Location.
c) Create the third pipe. Use the same Height and Radius 1 as above, and select
Positive Y in the list to the right of Axis Location.
2. Click the FIT TO WINDOW command button
toolpad, to view all three cylinders.

, at the top left of the Global Control

You can rotate the view by holding down the left mouse button and moving the
mouse. The cylinders are shown in Figure 3-3.

Figure 3-3: Three cylinders for the three-pipe intersection
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3. Create a sphere to complete the basic geometry.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Sphere form.

a) Enter 3 for the Radius.
b) Click Apply.
4. Unite the four volumes into one volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

This command sequence opens the Unite Real Volumes form.

a) Shift-left-click all of the volumes in the graphics window, and click Apply.
These volumes will be united into one volume. The completed geometry is
shown in Figure 3-4.
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Figure 3-4: The completed geometry
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Step 3: Decompose the Geometry
It is possible to automatically mesh this full geometry using the TGrid scheme.
However, it is not possible to automatically mesh this geometry with conformal
hexahedra. In order to generate a conformal hexahedral mesh, you must now
decompose the geometry into portions, each fulfilling the criteria of available
hexahedral meshing schemes. In this example, you will create a brick that will be
used to split the three-pipe volume, forming a sphere octant (one-eighth of a sphere)
where the three pipes intersect. You will then create an edge, and use it to form three
faces inside the geometry. These faces will be used to split the three-pipe intersection
volume into three pipe sections.
1. Create a brick.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Brick form.

a) Enter a value of 5 for the Width of the brick.
GAMBIT will set the Depth and the Height of the brick to be the same as the
Width if no values are entered in these fields in the form.
b) Select -X -Y -Z in the list next to Direction.
c) Click Apply.
The view in the graphics window is shown in Figure 3-5.
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Figure 3-5: Three-pipe geometry and brick
2. Split the volume and create a sphere octant volume where the three pipes intersect.
If you split one volume with another volume, the following volumes will result:
•

Volumes corresponding to the common region(s) from intersection.

•

Volumes corresponding to the region(s) defined by subtracting the second
volume from the first.

In other words, splitting a volume results in a combination of the intersection and
subtraction Boolean operations. The order of selecting the volumes is important.
For example, Figure 3-6 shows the difference between splitting volume A using
volume B, and vice versa.
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B

A

Split A with B

Intersecting volumes
Split B with A
Figure 3-6: Splitting volumes

GEOMETRY

→ VOLUME

→ SPLIT/MERGE VOLUMES

This command sequence opens the Split Volume form.
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a) Select the three-pipe volume in the graphics window.
b) Select Volume (Real) as the Split With option.
c) Left-click in the Volume list box located below the Split With section to make the
Volume list box active.
d) Unselect the Bidirectional option.
e) Select the brick and click Apply to accept the selection.
GAMBIT will split the three-pipe volume using the brick, leaving two
volumes: the three pipes (volume.1) and the sphere octant (volume.3).
3. Create a straight edge inside the three-pipe volume.
GEOMETRY

→ EDGE

→ CREATE EDGE

This command sequence opens the Create Straight Edge form.
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a) Shift-left-click the vertex at the origin (Gx, Gy, Gz).
b) Select the vertex that is shared by all three cylinders (x = y = z ).
c) Click Apply to accept the selected vertices and create an edge between them.
The edge is shown in Figure 3-7 and will appear yellow in the graphics
window.

Edge

Figure 3-7: Straight edge created inside the volume
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4. Create faces inside the three-pipe volume.
GEOMETRY

→ FACE

→ FORM FACE

This command sequence opens the Create Face From Wireframe form.

a) Create a face inside the geometry using the edge created in the previous step.
i. Select the edge created in the previous step.
ii. Select a curved edge on one of the cylindrical surfaces that is connected to the
edge just selected.
iii. Select the edge that closes the loop.
The three edges to be selected are shown in Figure 3-8.
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Figure 3-8: Three edges used to create a face
iv. Click Apply to accept the selection and create a face.
The edge created in the previous step will turn blue.
b) Create a second face by selecting the blue edge, a different curved edge connected
to the blue edge, and the edge that closes the loop.
c) Create a third face by selecting the blue edge, the third curved edge connected to
the blue edge, and the edge that closes the loop.
The three faces are shown in Figure 3-9. It may be useful to remove the
volumes from the display; it is then easier to see the faces you created. The
volumes are not deleted, just removed from the graphics window. To remove
the volumes from the display, click the SPECIFY DISPLAY ATTRIBUTES
command button
at the bottom of the Global Control toolpad. Select the
check box to the left of Volumes. Select the Off radio button to the right of
Visible near the bottom of the form, and click Apply. Turn the visibility of the
volumes back on after you have examined the faces.
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Figure 3-9: Three faces created inside the pipe intersection
5. Split the three-pipe volume using the faces created in the previous step.
GEOMETRY

→ VOLUME

→ SPLIT/MERGE VOLUMES

This command sequence opens the Split Volume form.
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a) Select the three-pipe volume in the graphics window.
b) Select Face (Real) as the Split With option.
c) Left-click in the Face list box located below the Split With section to make the Face
list box active.
d) Pick one of the internal faces created in the steps above.
Shift-middle-click on a face if you need to unselect it and select the face next
to it.
e) Click Apply to split the volume.
f) Repeat Steps (a) through (e), using one of the other two internal faces to split the
three-pipe volume.
g) Repeat Steps (a) through (e) again, using the remaining internal face to split the
three-pipe volume.
GAMBIT will create three volumes that are connected with common
geometry. The decomposed geometry is shown in Figure 3-10 and is now
ready to be meshed.
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3-17

Procedure

MODELING A THREE-PIPE INTERSECTION (3-D)

Figure 3-10: Decomposed geometry
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Step 4: Journal Files
!

Note that this step is not an essential part of the tutorial and is designed to provide
information on using journal files in GAMBIT.
Every time a GUI operation is performed in GAMBIT, the corresponding commands
are automatically written to a journal file. This journal file, therefore, provides a
backup copy of all the commands for the current session.
Journal files can be used to recreate a geometry or mesh that was created in a
previous session. You can view, run, and edit journal files in GAMBIT. See the
GAMBIT User’s Guide for more information on journal files.

1. View the journal file for the current GAMBIT session.
File → Run Journal…
This command sequence opens the Run Journal form.

a) Select the Edit / Run Mode option at the top of the form.
b) Click the Current Journal button.
The File Name for the current journal file will appear in the form.
c) Click Accept.
This action opens the Edit/Run Journal form. You can see the journal file for
the current session, showing every step completed.
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2. Edit the current journal file.
a) Left-click at the end of the first line and press the Enter key.
GAMBIT will open a new line where you can type a command.
b) Type reset in the new line.
!

If you run the journal file without executing the reset command, GAMBIT
creates new geometry on top of the existing geometry.

3. Save the journal file with a new name.
a) In the File Name text entry box at the bottom of the form, delete the text
“GAMBIT.#####/jou”.
##### is the process identifier for the current GAMBIT session. In the above
form, ##### is 1283.

b) Rename the journal file by typing 3pipe.geo in the File Name text entry box.
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c) Click the Save button at the bottom of the form.
The file will be saved to your working directory. By saving the journal file to
another name, you ensure that it will not be overwritten or appended.
4. Replay the steps you have taken in the current session.
a) Hold down the right mouse button in the TEXT EDIT FIELD (this name will be displayed in the Description window when the mouse cursor is over this field) of the
Edit/Run Journal form until a menu appears. Choose the Select All option in the
menu.
A black box in the LINE EXECUTION COLUMN of the Edit/Run Journal form
indicates that a line is selected. Note that all lines are now marked with a
black box. You can select/unselect individual lines by clicking the left mouse
button on the arrow on the left side of the required line.
b) Repeatedly click the Step button at the bottom of the Edit/Run Journal form until a
cylinder appears in the graphics window.
Note that GAMBIT’s current position in the journal file is marked by an
asterisk in the LINE EXECUTION COLUMN of the Edit/Run Journal form. The
Step button allows you to step through a journal file one line at a time. Each
time the Step button is clicked, GAMBIT will execute the next highlighted
line; it will skip any lines that are not highlighted.
GAMBIT has used the information in the journal file to recreate the first
cylinder you created in Step 2.
c) Click the Step button again.
A second cylinder appears in the graphics window.
d) Click the Auto button in the Edit/Run Journal form.
The Auto button allows you to automatically rerun a journal file. If the Auto
button is used, GAMBIT will automatically execute all lines that are
highlighted, and skip any lines that are not highlighted. GAMBIT just used
your journal file to redo the geometry creation and decomposition for the
three-pipe intersection. Each line of the journal file was displayed in the
Transcript window as it was executed.
e) Close the Edit/Run Journal form.
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Step 5: Turn Off Automatic Smoothing of the Mesh
It is necessary to turn off smoothing of the mesh in this example to prevent the
boundary layers from being smoothed out during the volume meshing.
Edit → Defaults…
This command sequence opens the Edit Defaults form.
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1. Select the MESH tab at the top of the form.
This displays the types of meshing for which you can set defaults.
2. Select the FACE radio button.
GAMBIT displays the Variables for which defaults are set in a list in the Edit
Defaults form.
3. Select AUTO_SMOOTH in the Variable list.
AUTO_SMOOTH will appear in the text entry box at the bottom of the list and its

default value will appear in the Value text entry box.
4. Enter a value of 0 in the Value text entry box.
5. Click the Modify button to the left of AUTO_SMOOTH.
The Value of the variable AUTO_SMOOTH will be updated in the list.
6. Close the Edit Defaults form.
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Step 6: Apply Boundary Layers at Walls
Boundary layers are layers of elements growing out from a boundary into the
domain. They are used to locally refine the mesh in the direction normal to a face or
an edge. A single boundary layer can be attached to several face/edge pairs or
volume/face pairs. The direction of the boundary layer is indicated during picking
with an arrow that points towards the middle of the active face or volume.
1. Create boundary layers on the edges where the sphere octant intersects the pipes.
MESH

→ BOUNDARY LAYER

→ CREATE BOUNDARY LAYER

This command sequence opens the Create Boundary Layer form.
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a) Enter 0.1 next to First row under Definition.
This defines the height of the first row of elements normal to the edge.
b) Enter 1.4 next to Growth factor.
This sets the ratio of distances between consecutive rows of elements.
c) Move the slider box below Rows until the number of rows = 4.
This defines the total number of element rows. Notice that GAMBIT updates
the Depth automatically. The depth is the total height of the boundary layer.
© Fluent Inc., Sep-04
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d) Retain the default Algorithm (Uniform).
e) Retain the default Transition pattern (1:1).
f) Select one of the three curved edges where the sphere octant intersects the pipes
(Figure 3-11).
The boundary layer will be displayed on the edge.
g) Check that the arrow indicating the direction of the boundary layer is pointing
towards the origin (Gx, Gy, Gz). If it is not, Shift-middle-click the edge until the
arrow is pointing in the correct direction.
h) Select a second curved edge where the sphere octant intersects the pipes and
ensure that the arrow on the edge is pointing towards the origin.
i) Repeat for the third curved edge.
The boundary layers will be displayed on the edges as shown in Figure 3-11.
j) Click Apply in the Create Boundary Layer form to apply the boundary layers to the
edges.

Figure 3-11: Boundary layer on three edges of the sphere octant
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2. Repeat the above steps to create the same boundary layer on the three curved edges
where the three pipes intersect, as shown in Figure 3-12. Again, the arrows on the
edges must point towards the origin.

Figure 3-12: Boundary layers on the three edges where the pipes intersect
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Step 7: Mesh the Sphere Octant Volume
1. Mesh the sphere octant.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select the sphere octant in the graphics window.
GAMBIT automatically selects Hex Elements and the Tet Primitive Type under
Scheme in the Mesh Volumes form, because the volume represents a logical
tetrahedron. (NOTE: The Tet Primitive scheme divides a logical tetrahedron
into four logical-hexahedral blocks and creates hexahedral mesh elements in
each block. The Tet Primitive scheme does not create tetrahedral mesh
elements. (See the GAMBIT Modeling Guide.))
b) Accept the default Interval size under Spacing in the Mesh Volumes form and click
the Apply button at the bottom of the form.
The mesh for the sphere octant is shown in Figure 3-13 Note the boundary
layers you applied on three faces of the sphere octant.
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Figure 3-13: Mesh on sphere octant
2. Remove the mesh from the display before you mesh the three pipes.
This makes it easier to see the edges and faces of the geometry. The mesh is not
deleted, just removed from the graphics window.
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

b) Select the Mesh:Off option near the bottom of the form.
c) Click Apply and close the form.
The boundary layers will still be visible in the graphics window.
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Step 8: Mesh the Pipe Volumes
You will now mesh the three pipes. These volumes will be meshed using GAMBIT's
Cooper scheme (described in detail in the GAMBIT Modeling Guide). This tutorial
illustrates three different ways to specify the source faces (the faces whose surface
meshes are to be swept through the volume to form volume elements) required by the
Cooper scheme. In the first example, you will modify the face vertex types for the side
face of one pipe. This is the safest way to ensure correct meshing. In the second
example, you will enforce the Submap scheme on the side face of the pipe. In the third
example, you will enforce the Cooper meshing scheme for the volume and hand-pick
all the source faces.
1. Mesh one of the pipes by changing the vertex type on the wall face to Side and then
using the Cooper meshing scheme to mesh the volume.
By changing the vertex type to Side on the wall face of the pipe, you will enable
GAMBIT to use the Submap scheme on this face. The criteria for the Cooper
meshing scheme will then be fulfilled for the pipe, and the pipe can be meshed
using the Cooper scheme.
a) Change the vertex type on the wall face to Side.
MESH

→ FACE

→ SET FACE VERTEX TYPES

This command sequence opens the Set Face Vertex Type form.

i. Select the Type:Side (default) option.
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ii. Select the wall face of the pipe (shown in Figure 3-14) in the graphics
window. Note the vertex on the wall face marked with an “E” for End (where
the three pipes intersect).

Wall face of
first pipe

End vertex

Figure 3-14: Wall face of the first pipe volume showing the End vertex
iii. Left-click in the Vertices list box.
iv. Select the vertex that was marked with an “E” in the graphics window (where
the three pipes intersect, as shown in Figure 3-14).
v. Click Apply in the Set Face Vertex Type form.
The vertex will be changed to Type “S” for Side. A message will appear in
the Transcript window stating that the vertex was set to type Side.
b) Mesh the pipe volume using the Cooper meshing scheme.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.
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i. Select the first pipe volume in the graphics window.
Note that Hex/Wedge Elements and the Cooper Type are automatically
selected under Scheme in the Mesh Volumes form because you changed
the vertex type on the wall face to Side.
GAMBIT automatically selects the source faces because you changed the
vertex type on the wall face to Side.
ii. Retain the default Interval size of 1 and click the Apply button at the bottom of
the form.
The pipe will be meshed as shown in Figure 3-15.
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Figure 3-15: Pipe meshed by changing the vertex type on the wall face to Side
and using the Cooper meshing scheme
!

It may be useful to remove the mesh from the display at this point; it is then
easier to see the faces of the geometry for the other two pipes. The mesh is
not deleted, just removed from the graphics window. To remove the mesh
from the display, click the SPECIFY DISPLAY ATTRIBUTES command button
at the bottom of the Global Control toolpad. Select the Off radio button
to the right of Mesh near the bottom of the form and click Apply.

2. Mesh the second pipe using the Submap scheme on the wall face of the pipe and using
the Cooper meshing scheme to mesh the volume.
By enforcing the Submap scheme on the wall face of the pipe, GAMBIT will
automatically modify the vertex types on this face to honor the Submap scheme.
The criteria for the Cooper meshing scheme will then be fulfilled for the pipe, and
the pipe can be meshed using the Cooper scheme.
a) Set the meshing scheme for the wall face to Submap.
MESH

→ FACE

→ MESH FACES

This command sequence opens the Mesh Faces form.
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i. Select the wall face of the second pipe (shown in Figure 3-16) in the graphics
window.

Wall face of
second pipe

Figure 3-16: Wall face of the second pipe volume
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ii. Select Quad in the Elements option menu under Scheme, and select Submap
under Type.
See the GAMBIT Modeling Guide for more information on the Submap
scheme.
iii. Retain the default Interval size of 1.
iv. Unselect the Mesh check box under Options.
You unselected the Mesh check box because at this point you do not want
to mesh the face; you only want to apply the meshing Scheme to the face.
GAMBIT will mesh the face using the specified Scheme when it meshes
the pipe volume.
v. Click the Apply button at the bottom of the form.
b) Mesh the pipe volume using the Cooper meshing scheme.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.
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i. Select the pipe volume in the graphics window.
Note that Hex/Wedge Elements and the Cooper Type are automatically
selected under Scheme in the Mesh Volumes form because you enforced
the Submap scheme on the side face of the pipe.
GAMBIT automatically selects the source faces because you enforced the
Submap scheme on the side face of the pipe.
ii. Retain the default Interval size of 1 under Spacing and click the Apply button at
the bottom of the form.
The pipe will be meshed as shown in Figure 3-17.

Figure 3-17: Pipe meshed using the Submap scheme for the wall face of the pipe and the
project scheme for the volume
!
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It may be useful to remove the mesh from the display at this point; it is then
easier to see the faces of the geometry for the last pipe.
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3. Mesh one of the pipes by hand-picking the source faces and then using the Cooper
meshing tool.

a) Select the third pipe in the graphics window.
The criteria for the Cooper scheme are not fulfilled for this pipe, because
GAMBIT cannot mesh the side face of the volume using the Map or Submap
meshing schemes. However, you can force GAMBIT to use the Cooper scheme
on this volume by selecting the Cooper scheme and then manually picking the
source faces (the faces whose surface meshes are to be swept through the
volume to form volume elements). When you click Apply, GAMBIT will
automatically enforce the Submap scheme on the side face and modify the
vertex types to honor the scheme selected. See the GAMBIT Modeling Guide
for more information on using the Cooper meshing scheme.
b) Select Hex in the Elements option menu under Scheme, and select Cooper under
Type.
c) Left-click in the Sources list box in the form, and then pick the source faces for
the mesh by selecting all the faces of the pipe except the pipe wall. The faces are
marked A through D in Figure 3-18.
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Shift-middle-click on a face to unselect it and select the face next to it. You
can also click Reset in the Mesh Volumes form to unselect all faces and
volumes, and reset all parameters entered in the form.
The four faces to be selected are at opposite ends of the pipe, as shown in
Figure 3-18. You can select the faces in the graphics window, or you can use
the Sources pick list.

B
C

D
A

Figure 3-18: Source faces used to mesh one of the pipe volumes
using the Cooper meshing scheme
d) Retain the default Interval size of 1 under Spacing and click the Apply button at the
bottom of the form.
4. Display the full mesh for the three-pipe intersection.
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
at the bottom of
the Global Control toolpad to open the Specify Display Attributes form.
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b) Select the Mesh:On option near the bottom of the form.
c) Click Apply to display the mesh, then Close the form.
The mesh for the three-pipe intersection is shown in Figure 3-19.
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Figure 3-19: Face meshes for the three-pipe intersection
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Step 9: Examine the Quality of the Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

a) Select the Sphere option under Display Type.
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This creates a section through the grid that is spherical in shape. For the
three-pipe geometry, a spherical section displays more useful information
than a planar section.
The 3D Element type selected by default at the top of the form is a brick

.

b) Select or retain EquiAngle Skew from the Quality Type option menu.
c) Select the + option under Cut Orientation near the bottom of the form.
The “+” option indicates that only elements on the positive side of the cut are
displayed. For a sphere, this means that only elements on the inside of the
sphere will be visible. The “0” option displays elements on the cut, and the “-”
option displays elements on the negative side of the cut (the outside of the
sphere in this case).
d) Click the SELECT PRESET CONFIGURATION
Control toolpad.

command button in the Global

This divides the graphics window into four quadrants and displays a different
view of the spherical section of the grid in each quadrant.
e) Hold down the left mouse button on the X slider box in the Examine Mesh form
and move it until the spherical cut is centered in the x direction in the graphics
window.
f) Move the Y and Z slider boxes to center the spherical cut in the y and z directions
in the graphics window. The graphics window display is shown in Figure 3-20.
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Figure 3-20: Spherical cut centered in the x, y, and z directions
g) Move the R slider box in the Examine Mesh form to view the mesh on different
spherical cuts in the graphics window.
h) Hold down the left mouse button on the GRAPHICS-WINDOW SASH anchor, the
small gray box in the center of the four quadrants of the graphics window, and
drag it diagonally across the graphics window to the bottom right corner.
This restores a single window.
i) Close the Examine Mesh form.
The spherical cut of the mesh will be removed and the face meshes will be
restored.
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Step 10: Set Boundary Types
1. Remove the mesh and boundary layers from the display before you set the boundary
types.
This makes it easier to see the edges and faces of the geometry. The mesh and
boundary layers are not deleted, just removed from the graphics window.
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

b) Select the Off radio button to the right of Mesh near the bottom of the form.
c) Click Apply.
d) Select the check box to the left of B. Layers and select Off from the option menu to
the right of Visible near the bottom of the form.
e) Click Apply and close the form.
2. Set boundary types for the three-pipe intersection.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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a) Define the flow inlet.
i. Enter the name inflow1 in the Name text entry box.
POLYFLOW boundary and continuum names require number suffixes (such
as “1” in the name “inflow1”). The numbers should be assigned
sequentially, as illustrated in this tutorial. (See the POLYFLOW Users’
Guide and online FAQs for more information.)
ii. Select ELEMENT_SIDE in the Type option menu.
The specific boundary types will be defined inside the POLYFLOW solver.
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iii. Check that Faces is selected as the Entity.
iv. Shift-left-click the end of one of the pipes (the face marked A in Figure 3-21)
and click Apply to accept the selection.

B

A

C

Figure 3-21: Boundary types for faces of the three-pipe intersection
b) Define the two flow outlets.
i. Enter the name outflow2 in the Name text entry box.
ii. Check that ELEMENT_SIDE is still selected in the Type option menu and Shiftleft-click the end of one of the other pipes in the graphics window (the face
marked B in Figure 3-21).
iii. Click Apply to accept the selection of the face.
iv. Set the Type for the end of the third pipe (the face marked C in Figure 3-21) to
be ELEMENT_SIDE, using the Name outflow3.
c) Define wall boundary types for the walls of the three-pipe intersection.
i. Enter the name wall4 in the Name text entry box.
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ii. Check that ELEMENT_SIDE is still selected in the Type option menu and pick
all of the wall faces (the outer walls of the three pipes and the outer face of the
sphere octant) in the graphics window.
!

You will select four faces in total.

iii. Click Apply to accept the selection of the faces.
The boundaries for the three-pipe intersection are shown in Figure 3-22.
(NOTE: To display the boundary types in the graphics window, select the
Show labels options on the Specify Boundary Types form.)

Figure 3-22: Boundary types for the three-pipe intersection
Note that when GAMBIT writes a mesh, any volumes (in 3-D) on which you
have not specified a continuum type will be written as FLUID by default. This
means that you do not need to specify a continuum type in the Specify
Continuum Types form for this tutorial.
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Step 11: Export the Mesh and Save the Session
1. Export a mesh file for the three-pipe intersection.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

a) Enter the File Name for the file to be exported (intersection.neu).
b) Click Accept.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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3.5 Summary
In this tutorial, you created geometry consisting of three intersecting pipes. Before creating the mesh, you decomposed the three-pipe geometry into four volumes: the three individual pipes and the wedge-shaped corner of the intersection (the sphere “octant”). These
constituent volumes were readily meshed using GAMBIT’s Cooper and Tet Primitive meshing schemes.
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4. MODELING A COMBUSTION CHAMBER (3-D)
In this tutorial, you will create the geometry for a burner using a top-down geometry construction method in GAMBIT (creating a volume using solids). You will then mesh the
burner geometry with an unstructured hexahedral mesh.
In this tutorial you will learn how to:
•

Move a volume

•

Subtract one volume from another

•

Shade a volume

•

Intersect two volumes

•

Blend the edges of a volume

•

Create a volume using the sweep face option

•

Prepare the mesh to be read into FLUENT 5/6

4.1 Prerequisites
This tutorial assumes that you have worked through Tutorial 1 and you are consequently
familiar with the GAMBIT interface.
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4.2 Problem Description
The problem to be considered is shown schematically in Figure 4-1. The geometry
consists of a simplified fuel injection nozzle that feeds into a combustion chamber. You
will only model one quarter of the burner geometry in this tutorial, because of the
symmetry of the geometry. The nozzle consists of two concentric pipes with radii of 4
units and 10 units respectively. The edges of the combustion chamber are blended on the
wall next to the nozzle.
20

30
20
12

4 10
40

Figure 4-1: Problem specification
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4.3 Strategy
In this tutorial, you will create a combustion chamber geometry using the “top-down”
construction method. You will create volumes (in this case, bricks and cylinders) and use
Boolean operations to unite, intersect, and subtract these volumes to obtain the basic
geometry. Finally, using the “blend” command, you will round off some edges to
complete the geometry creation.
For this model, it is not possible to simply pick the geometry and mesh the entire domain
with hexahedral elements, because the Cooper tool (which you will be using in this
tutorial) requires two groups of faces, one group topologically parallel to a sweep path,
and the other group topologically perpendicular. However, the rounded (blended) edges
fit in neither group. See the GAMBIT Modeling Guide for a more detailed description of
the Cooper tool. You need to decompose the geometry into portions that can be meshed
using the Cooper tool. There are several ways to decompose geometry in GAMBIT. In this
example, you will use a method whereby portions of the volume around the blend are split
off from the main volume. A detailed description of the decomposition strategy for the
combustion chamber is given below.
Note that there are several faces in the geometry for which the default meshing scheme is
the Pave scheme; most of these faces are perpendicular to the z direction. There are also
geometrical protrusions in the z direction, so this should be chosen as the main direction
for the Cooper meshing scheme. To make this possible, the paved faces in the x and y
directions (the two symmetry planes in the geometry shown in Figure 4-2) must be
changed to use the Submap or Map meshing scheme.
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Figure 4-2: The two symmetry planes in the combustion chamber geometry
By default, GAMBIT selects the Pave meshing scheme for these two faces because each
has a rounded edge where the blend occurs. If you split off the rounded corners of both
faces and connect them through a volume, you can use the Submap meshing scheme on
the remaining faces, and hence the Cooper meshing scheme for the volume.
Instead of creating two faces, one on each symmetry plane, you will create a face at the
junction of the two blended edges (face A in Figure 4-3). This face will then be swept in
two directions onto the symmetry planes (creating faces B and C in Figure 4-3), to split
the volume into three parts. The three volumes can then be meshed individually using the
Cooper tool.
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B

A

C

Figure 4-3: Faces created at the blended edges and on the symmetry planes
This tutorial also demonstrates a few ways of controlling the mesh density and the meshing schemes used on individual faces. You will mesh the small quarter-circle face that
forms the second inlet with a Tri Primitive scheme and a finer mesh size. Similarly, you will
mesh the annular face of the primary inlet with a fine mapped mesh. To meet the requirements of the Cooper tool, you will also need to create a mapped mesh on the face between
these two faces. Finally, you will use the automatic Cooper tool to mesh the remaining
faces and the volume.
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4.4 Procedure
Start GAMBIT.

Step 1: Select a Solver
1. Choose the solver you will use to run your CFD calculation by selecting the following
from the main menu bar:
Solver → FLUENT 5/6
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). For
some systems, FLUENT 5/6 is the default solver. The solver currently selected is
indicated at the top of the GAMBIT GUI.

Step 2: Set the Default Interval Size for Meshing
In this tutorial, you will change the default interval size used for meshing. The
mesh spacing is, by default, based on the interval size parameter, which you will
modify in the Edit Defaults form. The value you enter should be the estimated
average size of a mesh element in the model. This value will appear as the default
Interval size on all meshing forms. You will be able to change it on the meshing
forms, if required.
Edit → Defaults…
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1. Select the MESH tab at the top of the form.
2. Select the INTERVAL radio button near the top of the form.
3. Select SIZE in the Variable list.
SIZE will appear in the space at the bottom of the list and its default value will

appear in the Value text entry box.
4. Enter a value of 2 in the Value text entry box.
5. Click the Modify button to the left of SIZE.
The Value of the variable SIZE will be updated in the list.
6. Close the Edit Defaults form.
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Step 3: Create Two Cylinders
1. Create a cylinder to form the opening of the burner.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Cylinder form.

a) Enter a value of 12 for the Height of the cylinder.
b) Enter a value of 4 for Radius 1 of the cylinder.
The text entry box for Radius 2 can be left blank; GAMBIT will set this by
default to be the same value as Radius 1.
c) Select Positive Z (the default) as the Axis Location.
d) Click Apply.
2. Repeat the steps above to create a cylinder of Height = 20 and Radius 1 = 10 along the
Positive Z axis.
3. Click the FIT TO WINDOW command button
toolpad, to see the cylinders created.

, at the top left of the Global Control

The two cylinders are shown in Figure 4-4. Hold down the left mouse button and
move the mouse to rotate the view in the graphics window. You can zoom out from
the current view by holding down the right mouse button and pushing the mouse
away from you.
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Figure 4-4: Two cylinders
4. Move the first cylinder you created so that it is at the front of the large cylinder.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.
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a) Shift-left-click the small cylinder in the graphics window.
“volume.1” will be entered next to Volumes in the Move / Copy Volumes form.
b) Select Move (the default) under Volumes in the Move / Copy Volumes form.
c) Select Translate (the default) under Operation.
d) Enter a Global translation vector of (0, 0, 8) to move the cylinder 8 units in the z
direction.
Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
e) Click Apply.
The two cylinders are shown in Figure 4-5. Notice that the small cylinder has
been moved from the back of the large cylinder to the front.
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Figure 4-5: Two cylinders after moving the small cylinder
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Step 4: Subtract the Small Cylinder From the Large Cylinder
1. Create one volume from the two cylinders by subtracting one cylinder from the other.
The order of selecting the volumes is important. For example, Figure 4-6 shows
the difference between subtracting volume B from volume A, and vice versa.

B
A

Subtract B from A

Intersecting volumes
Subtract A from B
Figure 4-6: Subtracting volumes

GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R

This command sequence opens the Subtract Real Volumes form.
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a) Shift-left-click the large cylinder in the graphics window.
b) Left-click in the list box to the right of Subtract Volumes to accept the selection of
volume.2 and make the Subtract Volumes list box active.
!

Alternatively, you could continue to hold down the Shift key and click the
right mouse button in the graphics window to accept the selection of the large
cylinder and move the focus to the Subtract Volumes list box.

c) Select the small cylinder and accept the selection.
Selecting the cylinders in this order ensures that the small cylinder is
subtracted from the large cylinder and not vice versa.
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Step 5: Shade and Rotate the Display
, in the middle of the bottom row of
1. Click the RENDER MODEL command button
the Global Control toolpad, to create a shaded view of the volume.
2. Hold down the left mouse button and drag the mouse to rotate the graphics display
and see the cylindrical hole created in the large cylinder (see Figure 4-7).

Figure 4-7: Shaded geometry showing hole in large cylinder
3. To return to the unshaded view, right-click on the RENDER MODEL command button
in the Global Control toolpad and select

4-14

from the resulting list.
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Step 6: Remove Three Quarters of the Cylindrical Volume
In this step, you will create a brick that will be intersected with the cylindrical
volume. Three quarters of the cylindrical volume will be removed, leaving the volume
for the entrance of the burner.
1. Create a brick that will be intersected with the cylindrical volume already created.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Brick form.

a) Enter a value of 21 for the Width of the brick.
The text entry boxes for Depth and Height can be left blank; GAMBIT will set
these values by default to be the same value as the Width, to create a cube.
b) Use a Direction of +X +Y +Z (the default).
c) Click Apply.
Figure 4-8 shows the cylindrical volume and the brick.
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Figure 4-8: Cylindrical volume and brick
2. Intersect the brick and the cylindrical volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R

This command sequence opens the Intersect Real Volumes form.

a) Shift-left-click the brick in the graphics window.
b) Select the cylindrical volume in the graphics window.
c) Click Apply to accept the selection of the volumes.
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The order in which the two volumes are selected is not important to the
outcome of the operation but does affect the numbering of subsequent
geometric entities. The cylindrical volume will be trimmed so that only the
part inside the brick remains, as shown in Figure 4-9.

Figure 4-9: One quarter of the cylindrical volume remains

© Fluent Inc., Sep-04

4-17

Procedure

MODELING A COMBUSTION CHAMBER (3-D)

Step 7: Create the Chamber of the Burner
1. Create a brick for the chamber.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a value of 20 for the Width of the brick, 30 for the Depth, and 40 for the
Height.
b) Change the Direction to +X +Y -Z by selecting this option in the option menu to the
right of Direction.
c) Click Apply.
2. Click the FIT TO WINDOW command button
toolpad to see the brick created.

at the top left of the Global Control

3. Unite the brick and cylindrical volume into a single volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R

This command sequence opens the Unite Real Volumes form.
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a) Shift-left-click the cylindrical volume in the graphics window.
b) Select the brick and click Apply to accept the selection.
The order in which you select the two volumes is not important when you are
uniting them. The brick and the cylindrical volume will be united as shown in
Figure 4-10.

Figure 4-10: Brick and cylindrical volume are united
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Step 8: Blend the Edges of the Chamber
1. Blend (round off) two edges of the chamber geometry to give it a more rounded
shape.
GEOMETRY

→ VOLUME

→ BLEND VOLUMES

This command sequence opens the Blend Volumes form.

a) Click the Edge button under Define Blend Types.
This action opens the Edge Blend Type form.

i. Shift-left-click the two edges to be blended, as shown in Figure 4-11.
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Edges to be
blended

Figure 4-11: Edges to be blended
ii. Select Constant radius round (the default) under Options in the Edge Blend Type
form.
iii. Enter 5 for the Radius.
iv. Click Apply in the Edge Blend Type form and Close the form.
b) Shift-left-click the volume in the graphics window.
c) Click Apply in the Blend Volumes form.
The burner geometry with the blended edges is shown in Figure 4-12.
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Figure 4-12: Burner with blended edges
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Step 9: Decompose the Geometry
For this model, it is not possible to simply pick the geometry and mesh it with a
hexahedral mesh. The Cooper meshing scheme requires that all “source” faces are
topologically parallel, and that all other faces can be meshed using the Map or
Submap meshing scheme. However, the curved faces resulting from the blend
operation do not satisfy the Cooper criteria. Therefore, you will need to decompose
the geometry into portions that are each suitable for the Cooper tool. There are
several ways to decompose geometry in GAMBIT. In this example, you will use a
method whereby portions of the volume around the blend are split off from the main
volume. To do this, you will create a vertex near the junction of the two blended
edges. You will then use this vertex to create straight edges, and use these edges to
create a face. This face will then be swept in two directions to create two volumes.
These two volumes will be used to split the burner volume into three parts. It will then
be possible to mesh each of these parts individually using the Cooper tool.
1. Create a vertex inside the volume.
GEOMETRY

→ VERTEX

→ MOVE/COPY/ALIGN VERTICES

This command sequence opens the Move / Copy Vertices form.
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a) Select the vertex marked A in Figure 4-13.
To zoom in to an area of the graphics window, hold down the Ctrl key and use
the left mouse button to draw a box around the area you want to view.
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A

Figure 4-13: Vertex to copy
b) Select Copy under Vertices in the Move / Copy Vertices form.
c) Select Translate (the default) under Operation.
d) Enter the translation vector (0, 0, -5) under Global.
e) Click Apply.
The vertex will be visible in the graphics window as a white cross near where
the two blended edges meet. See vertex B in Figure 4-14.
2. Create two straight edges using the new vertex.
GEOMETRY

→ EDGE

→ CREATE EDGE

This command sequence opens the Create Straight Edge form.
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a) Shift-left-click the vertex marked A in Figure 4-14.

C

A

B

Figure 4-14: Vertices to be selected to create edges
b) Shift-left-click the vertices marked B and C in Figure 4-14, in order.
c) Click Apply to accept the selected vertices and create two edges.
The edges are shown in Figure 4-15.
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Figure 4-15: Two new straight edges
3. Create a face using the two new edges.
GEOMETRY

→ FACE

→ FORM FACE

This command sequence opens the Create Face From Wireframe form.

a) Shift-left-click the edge marked D in Figure 4-16.
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F
D
E

Figure 4-16: Edges used to create the face
b) Shift-left-click the edges marked E and F in Figure 4-16.
c) Click Apply to accept the selected edges and create a face.
4. Create a volume by selecting the new face and sweeping it along the direction defined
by an edge.
GEOMETRY

→VOLUME

→ FORM VOLUME

R

This command sequence opens the Sweep Faces form.
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a) Select the new face in the graphics window.
Shift-middle-click on a face to unselect it and select the face next to it.
b) Left-click in the list box to the right of Edge to make the Edge list box active.
c) Select the edge marked G in Figure 4-17.
!

A red arrow will appear on the edge, indicating the direction in which the
face will be swept. This arrow should be pointing away from the face you
selected. If it is not, click the Reverse button in the Sweep Faces form to
reverse the direction of the arrow and the sweep.

d) Click Apply to sweep the face.
The volume created by the sweep is shown in Figure 4-18.
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G

Figure 4-17: Edge to be used for sweep face

Figure 4-18: Face swept parallel to an edge to form a volume
Note that the volume created by the Sweep Faces operation extends outside
the boundaries of the burner box.
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5. Sweep the same face in a different direction.
a) Select the face marked H in Figure 4-19.
b) Left-click in the list box to the right of Edge to make the Edge list box active.

Face H

Edge J

Figure 4-19: Face and edge to be used for sweep face
c) Select the edge marked J in Figure 4-19.
d) Click Reverse to reverse the direction of the edge.
!

Again, the arrow on this edge should be pointing away from the selected face.

e) Click Apply.
The volume created by the sweep is shown in Figure 4-20.
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Figure 4-20: Face swept parallel to an edge to form a second volume
6. Split the large burner volume using the two smaller volumes.
If you split one volume with another volume, the following volumes will result:
•

Volumes corresponding to the common region(s) from intersection.

•

Volumes corresponding to the region(s) defined by subtracting the second
volume from the first.

In other words, splitting a volume results in a combination of the intersection and
subtraction Boolean operations. The order of selecting the volumes is important.
For example, Figure 4-21 shows the difference between splitting volume A using
volume B, and vice versa.
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B

A

Split A with B

Intersecting volumes
Split B with A
Figure 4-21: Splitting volumes

GEOMETRY

→ VOLUME

→ SPLIT/MERGE VOLUMES

This command sequence opens the Split Volume form.
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a) Select the large burner geometry in the graphics window.
b) Select Volume (Real) as the Split With option.
c) Left-click in the Volume list box located below the Split With section to make it
active.
d) Select the first volume created using the sweep face method.
e) Unselect the Bidirectional option.
f) Click Apply.
g) Left-click in the Volume list box located above the Split With section to make it
active.
h) Select the large burner geometry in the graphics window.
i) Retain Volume (Real) as the Split With option.
j) Left-click in the Volume list box located below the Split With section to make it
active.
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k) Select the second volume created using the sweep face method.
l) Click Apply.
The complete decomposed burner geometry (see Figure 4-22) is now ready to
be meshed.

Figure 4-22: Decomposed burner geometry
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Step 10: Generate an Unstructured Hexahedral Mesh
In the meshing section of this tutorial you will use:
•

Cooper tool

•

Face meshing schemes

•

Variable global mesh densities

It is possible to use the Cooper tool to automatically mesh the entire model with a
uniform mesh size, but this tutorial will instead demonstrate a few ways of controlling
the mesh density and the meshing schemes used. Typically, the Cooper tool will use the
Pave meshing scheme on all source faces, if certain criteria are not met. See the
GAMBIT Modeling Guide for more information on GAMBIT’s meshing tools.
The two small volumes will be meshed first using the Cooper meshing scheme. For the
remaining volume, you will mesh some faces first. In this case, you will mesh the
small quarter-circle face with a Tri Primitive scheme and a finer mesh size. Similarly,
you will mesh the annular face of the inlet with a fine mapped mesh. However, to
ensure that the face in-between the quarter-circle and the annular faces has a mapped
(or submapped) mesh, which is required for the Cooper tool, you will mesh this face
before meshing the annular face. Finally, you will use the automatic Cooper tool to
mesh the remaining faces and volume.
1. Generate a mesh for one of the small volumes.

MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

4-36

© Fluent Inc., Sep-04

MODELING A COMBUSTION CHAMBER (3-D)

Procedure

a) Select the volume at the top front of the burner geometry.
The volume to be selected is shown in Figure 4-23.

K

L

Figure 4-23: Faces to select for first Cooper meshing operation
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In this case the criteria for the Cooper scheme are not fulfilled. This is because
GAMBIT will not automatically mesh the back face of the volume using the
Map or Submap meshing scheme, because the angle at one of the face corners
is not close enough to 90° for it to be automatically classified with the End
vertex type, which is a requirement for automatic Map meshing on a four-sided
face. However, you can force GAMBIT to use the Cooper scheme on this
volume by selecting it and then manually picking the source faces (the faces
whose surface meshes are to be swept through the volume to form volume
elements). When you click Apply, GAMBIT will automatically enforce the
Submap scheme on all side faces not already set to use the Map or Submap
schemes, and will modify the vertex types to honor the scheme selected. See
the GAMBIT Modeling Guide for more information on using the meshing
schemes.
b) Select Hex from the Elements option menu under Scheme in the Mesh Volumes
form and select Cooper from the Type option menu.
c) Left-click in the Source list box (which will turn yellow), and then select the faces
marked K and L in Figure 4-23 as the Source faces.
The faces are at opposite ends of the volume.
!

If you select the wrong face, and the face you want is the one next to the face
selected, Shift-middle-click on the face to unselect it and select the face next
to it. You can also click Reset in the Mesh Volumes form to reset everything
you set in the form.

d) Retain the default Interval size of 2 under Spacing in the Mesh Volumes form.
Note that this is the interval size for meshing that you set as the default in Step
2 of this tutorial.
e) Click the Apply button at the bottom of the form.
Notice that all faces are meshed before GAMBIT meshes the volume. The
mesh is shown in Figure 4-24.
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Figure 4-24: Mesh generated for the first small volume in the burner geometry
2. Generate a mesh for the other small volume in the burner geometry.
a) Select the volume at the side of the burner geometry.
The volume to be selected is shown in Figure 4-25.
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M

N

Figure 4-25: Faces to select for cooper meshing on the volume
at the side of the burner geometry
b) Select Hex from the Elements option menu under Scheme in the Mesh Volumes
form and select Cooper from the Type option menu.
c) Left-click in the Source list box (which will turn yellow), and select the faces
marked M and N in Figure 4-25 as the Source faces.
The faces are at opposite ends of the volume.
!

If you select the wrong face, and the face you want is the one next to the face
selected, Shift-middle-click on the face to unselect it and select the face next
to it. You can also click Reset in the Mesh Volumes form to unselect all faces,
and then select the correct faces.

d) Retain the default Interval size of 2 under Spacing in the Mesh Volumes form and
click the Apply button at the bottom of the form.
The mesh is shown in Figure 4-26.

4-40

© Fluent Inc., Sep-04

MODELING A COMBUSTION CHAMBER (3-D)

Procedure

Figure 4-26: Mesh generated for the second small volume in the burner geometry
Next, you will mesh the small face where the burner entrance and the burner
chamber meet, and the face at the entrance to the burner. In GAMBIT, you can
“pre-mesh” any source faces on a volume by selecting a meshing scheme and
size, to improve the quality of the final mesh.
3. Mesh the small face where the burner entrance and the burner chamber meet.
MESH

→ FACE

→ MESH FACES

This command sequence opens the Mesh Faces form.

© Fluent Inc., Sep-04

4-41

Procedure

MODELING A COMBUSTION CHAMBER (3-D)

a) Select the face marked P in Figure 4-27.
Notice that GAMBIT automatically selects the Tri Primitive Scheme in the Mesh
Faces form. See the GAMBIT Modeling Guide for more information on the Tri
Primitive scheme.
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P

Q

Figure 4-27: Faces to be meshed in the burner geometry
b) Enter 0.5 for the Interval size under Spacing and click the Apply button at the
bottom of the form.
The face will be meshed as shown in Figure 4-28.
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Figure 4-28: Mesh on small face
4. Mesh the curved face along the entrance to the burner.
a) Select the face marked Q in Figure 4-27.
GAMBIT will automatically select the Map Scheme in the Mesh Faces form.
See the GAMBIT Modeling Guide for more information on the Map meshing
scheme.
b) Retain the default Interval size of 2 under Spacing and click the Apply button at the
bottom of the form.
The face will be meshed as shown in Figure 4-29.
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Figure 4-29: Mesh on curved face along the entrance to the burner
5. Mesh the face at the entrance to the burner.
a) Select the face marked R in Figure 4-27.
GAMBIT will automatically select the Map Scheme in the Mesh Faces form.
b) Enter 1 for the Interval size under Spacing and click the Apply button at the bottom
of the form.
The face will be meshed as shown in Figure 4-30.
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Figure 4-30: Mesh on face at entrance of burner
6. Create a mesh for the rest of the volume of the burner.
MESH

→ VOLUME

→ MESH VOLUMES

a) Select the remaining burner geometry in the graphics window.
GAMBIT will automatically choose the Cooper Scheme as the meshing tool to
be used, and will use an Interval size of 2 (the default) under Spacing. It will
also select the source faces it requires to generate the Cooper mesh. These
faces are marked S through X in Figure 4-31.
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X
W
S
T

Figure 4-31: Source faces to be used for cooper mesh
b) Click Apply at the bottom of the Mesh Volumes form.
This accepts the volume you selected as the one to be meshed and the source
faces GAMBIT has chosen for the Cooper meshing scheme, and starts the
meshing. The complete mesh is shown in Figure 4-32.
Notice that hidden line removal has been turned on in Figure 4-32 to make the
mesh easier to see. To turn on hidden line removal, hold down the right mouse
button on the RENDER MODEL command button
toolpad and select

from the resulting list. To view the mesh

without hidden line removal, reselect the
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Figure 4-32: Volume mesh for the burner geometry
7. You can view a shaded display of the mesh using the RENDER MODEL command
button in the Global Control toolpad
a) Hold down the right mouse button on the RENDER MODEL command button
and select

from the resulting list.

b) Rotate and translate the volume to view the mesh.
c) When you are finished, return to the wireframe view of the model, by selecting the
following command buttons in the Global Control toolpad:
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Step 11: Examine the Quality of the Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

The 3D Element type selected by default at the top of the form is a brick

.

a) Select the Plane option under Display Type.

© Fluent Inc., Sep-04

4-49

Procedure

MODELING A COMBUSTION CHAMBER (3-D)

b) Select or retain EquiAngle Skew from the Quality Type option menu.
c) Hold down the left mouse button on the X slider box and move it to view slices of
the mesh with different x values.
An example is shown in Figure 4-33. The mesh is drawn as a wireframe (by
default) as you drag the slider box, and it is colored by EquiAngle Skew quality
when you release the slider box. As you sweep a plane through the x values,
you will see the way in which the Cooper tool has automatically decomposed
the volume internally to mesh it with hexahedral elements.

Figure 4-33: Slice of the mesh in the x direction
d) Use the Y and Z sliders to view slices in the y and z directions.
e) Select Range under Display Type, and then click with the left mouse button on the
histogram bars that appear at the bottom of the Examine Mesh form to highlight
elements in a particular quality range.
Figure 4-34 shows the view in the graphics window if you click on the fifth bar
from the left on the histogram (representing cells with a skewness value
between 0.4 and 0.5). These low values for the maximum skewness indicate
that the mesh is acceptable. The histogram consists of a bar chart
representing the statistical distribution of mesh elements with respect to the
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specified Quality Type. Each vertical bar on the histogram corresponds to a
unique set of upper and lower quality limits.

Figure 4-34: Elements within a specified quality range
When you select the Display Type:Range option on the Examine Mesh form,
GAMBIT displays the Show worst element option immediately below the
statistics displayed under the histogram. If you select the Show worst element
option, GAMBIT displays only the “worst” element as determined by the
current Quality Type quality metric.
f) Select the Show worst element option.
g) Click the FIT TO WINDOW command button
, at the top left of the Global
Control toolpad, to see where the worst element is located with respect to the
entire geometry.
h) Close the Examine Mesh form by clicking the Close button at the bottom of the
form.
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Step 12: Set Boundary Types
1. Remove the mesh from the display before you set the boundary types.
This makes it easier to see the edges and faces of the geometry. The mesh is not
deleted, just removed from the graphics window.
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

b) Select the Off radio button to the right of Mesh near the bottom of the form.
c) Click Apply and close the form.
2. Set boundary types for the burner.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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a) Define two velocity inlets.
i. Enter the name “inlet1” in the Name text-entry field.
ii. Select VELOCITY_INLET in the Type option menu.
iii. Check that Faces is selected as the Entity.
iv. Shift-left-click the face marked A in Figure 4-35 and click Apply to accept the
selection.
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C

A

B

Figure 4-35: Boundary-type faces for the burner—inlet and outlet
This face will be set as a velocity inlet.
v. Enter the name “inlet2” in the Name text-entry field.
vi. Check that VELOCITY_INLET is still selected in the Type option menu, select
the face marked B in Figure 4-35, and click Apply.
b) Define a pressure outlet.
i. Enter the name “outlet” in the Name text-entry field.
ii. Change the Type to PRESSURE_OUTLET by selecting it in the option menu
below Type.
iii. Select the face marked C in Figure 4-35 and click Apply to accept the
selection.
c) Define symmetry boundary types for the two faces normal to the x axis.
i. Enter the name “symmetryx” in the Name text entry box.
ii. Change the Type to SYMMETRY.
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iii. Select the two faces on the left side of the geometry as you look at it from the
front (the faces marked D and E in Figure 4-36). Accept the selection of the
faces.

E
D

G
F

Figure 4-36: Boundary-type faces for the burner—symmetry
d) Define symmetry boundary types for the two faces normal to the y axis.
i. Enter the name symmetryy in the Name text entry box.
ii. Check that SYMMETRY is still selected in the Type option menu and select the
two faces on the bottom of the geometry (the faces marked F and G in Figure
4-36). Accept the selection of the faces.
The velocity inlet, pressure outlet, and symmetry boundaries for the 3-D
combustion chamber are shown in Figure 4-37. To display the boundarytype labels in the graphics window, select the Show labels option on the
Specify Boundary Types form. To display colors associated with each
boundary-type assignment, select the Show colors option. (NOTE:
GAMBIT automatically shades the faces for the Show colors option.)

© Fluent Inc., Sep-04

4-55

Procedure

MODELING A COMBUSTION CHAMBER (3-D)

Figure 4-37: Boundary types for the combustion chamber
Note that you could also specify the remaining outer faces of the model as
WALL boundaries. This is not necessary, however, because when GAMBIT
saves a mesh, any external faces (in 3-D) for which you have not specified a
boundary type will be written out as WALL boundaries by default.
In addition, when GAMBIT writes a mesh, any volumes (in 3-D) for which
you have not specified a continuum type will be written as FLUID by default.
This means that you do not need to specify a continuum type in the Specify
Continuum Types form for this tutorial.
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Step 13: Export the Mesh and Save the Session
1. Export a mesh file.
File → Export → Mesh…
This command sequence opens the Export Mesh File form. Notice that the File Type
at the top of the form is UNS / RAMPANT / FLUENT 5/6.

a) Enter the File Name for the file to be exported (burner.msh).
b) Click Accept.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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4.5 Summary
In this tutorial, you created the geometry and hexahedral mesh for a 3-D combustion
chamber using a top-down construction approach. The use of Boolean operations for
uniting, subtracting, and intersecting volumes was demonstrated. The blend volumes
command was used to create a rounded shape on the edges of the combustion chamber.
Next, the geometry was decomposed into smaller volumes for which the Cooper meshing
scheme could be used. Several different ways of meshing the source faces needed by the
Cooper scheme were shown.
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5. SEDAN GEOMETRY—VIRTUAL CLEANUP
In this tutorial you will import an IGES file containing the geometry for a sedan automobile, clean up the geometry, and mesh it with triangles and tetrahedra.
In this tutorial you will learn how to:
•

Import an IGES file

•

Specify the way in which the geometry will be colored

•

Connect edges, using a manual and an automatic method

•

Merge faces

•

Create a triangular surface mesh

•

Mesh a volume with a tetrahedral mesh

•

Prepare the mesh to be read into FLUENT 5/6

5.1 Prerequisites
This tutorial assumes you have worked through Tutorial 1 and, therefore, that you are
familiar with the GAMBIT GUI.
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5.2 Problem Description
The problem to be considered is shown schematically in Figure 5-1; it is the external body
of a luxury sedan. You will generate a mesh on the outside of the car body; therefore, you
will create a brick around the sedan to represent the flow domain.

Figure 5-1: Sedan geometry
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5.3 Strategy
In this tutorial, you will create a fully unstructured tetrahedral mesh around a car-body
geometry imported as an IGES file. This tutorial illustrates the steps you would typically
follow to prepare an imported CAD geometry for meshing. The imported geometry is
“dirty”—that is, there are gaps between some of the surfaces that make it unsuitable for
creating a CFD mesh. After examining the raw imported geometry to identify its
problems, such as unconnected edges, you will clean up the geometry using the tools
available in GAMBIT.
Most of the gaps can be fixed automatically either during mesh import or subsequently by
means of the “connect edge” command. The original CAD geometry is not modified
during the fixing process; the modifications required to eliminate the gaps are made using
“virtual” geometry, which lies on top of the “real” geometry. Some edges in the original
geometry are very short and will be eliminated using the “vertex connect” command.
Other edges are not automatically connected, because they are farther apart than the specified tolerance. You will connect such edges manually.
The imported geometry includes a number of small surfaces, the edges of which may
unnecessarily constrain the mesh generation process. Using the “merge faces” command,
GAMBIT allows you to easily combine these surfaces prior to meshing. You can then
have GAMBIT automatically create a triangular mesh on the car body.
Since the imported geometry consists only of the car body, you need to create a suitable
domain around the car in order to conduct a CFD analysis (this is loosely equivalent to
placing the car in a wind tunnel). The remainder of the tutorial shows how to add a real
box around the car body, use virtual geometry to create some missing faces, and finally
stitch all faces together into a single volume. This volume can then be meshed (without
any decomposition) using a tetrahedral meshing scheme.
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5.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/sedan.igs

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). For
some systems, FLUENT 5/6 is the default solver. The solver currently selected is
shown at the top of the GAMBIT GUI.
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Step 2: Import the IGES File As-Is
File → Import → IGES …
This command sequence opens the Import IGES File form.
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1. Click on the Browse... button.
This action opens the Select File form.

a) Select sedan.igs in the Files list.
b) Click Accept in the Select File form.
2. On the Import IGES File form, unselect the Make Tolerant option, and click Accept.
The IGES file for the sedan body will be read into GAMBIT (see Figure 5-2).
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Zoom region

Figure 5-2: Imported sedan body

3. Click the SPECIFY COLOR MODE command button
in the Global Control toolpad
to change to the graphics display to connectivity-based coloring.
The SPECIFY COLOR MODE command button will change to
. When
GAMBIT is in the connectivity display mode, the model is displayed with colors
based on connectivity between entities rather than based on entity types.
In this case, the colors of all edges in the graphics window will change to orange,
indicating that the faces are not connected to each other—that is, that there are
gaps between the edges that bound the faces.
4. Ctrl-drag the mouse in the graphics window to create the zoom-region box shown in
Figure 5-2, above (at the front of the sedan hood). When you release the mouse
button, GAMBIT zooms in on the region.
Figure 5-3 shows the zoomed region, illustrating an example of the gaps that exist
between the faces that comprise the surface of the sedan.
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Gap

Figure 5-3: Zoomed region showing unconnected faces on sedan hood
In addition to gaps such as those shown in Figure 5-3, the geometry imported asis from the IGES file contains a number of small edges that can inhibit meshing of
the model. GAMBIT provides options on the Import IGES File form that allow you
to eliminate many of the gaps and short edges during import. The next step in this
tutorial illustrates the use of one such option—Virtual Cleanup.
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Step 3: Reset and Import the IGES File Using Virtual Cleanup
The Virtual Cleanup option on the Import IGES File form allows you to automatically
eliminate many features, such as short edges and gaps between unconnected faces,
during geometry import. By eliminating many such features during geometry import,
you can greatly simplify the process of creating a meshable model.
1. Reset GAMBIT.
a) On the Command line, type reset, and press Enter.
GAMBIT deletes the current geometry from the graphics window and resets
the GUI.
2. Reselect the FLUENT 5/6 solver from the main menu bar.
Solver → FLUENT 5/6
3. Open the Import IGES File form.
File → Import → IGES …
This command sequence opens the Import IGES File form.
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GAMBIT retains the File Name selected in Step 2—that is, sedan.igs.
4. Under Import Options: Stand-alone Geometry, select the No stand-alone edges check
box.
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This option instructs GAMBIT not to read in any edges that do not belong to
faces or volumes. Such edges can be deleted after the geometry has been read into
GAMBIT, but this option eliminates the extra step.
5. Set the connect tolerance to 10% of the shortest edge by selecting the Virtual Cleanup
toggle and specifying the Shortest Edge % at 10.
This substep invokes an automated sequence of connect operations that attempt to
clean up the imported geometry after it is read into GAMBIT.

in the Global Control toolpad
6. Click the SPECIFY COLOR MODE command button
to change to the graphics display to connectivity-based coloring.
7. On the Import IGES File form, click Accept.
The IGES file for the sedan body will again be read into GAMBIT. This time,
however, GAMBIT will perform virtual clean-up operations to eliminate gaps
and many small edges. As the clean-up operation progresses, edges that are
initially displayed as orange (with the connectivity color mode on) will turn blue.
Figure 5-4 shows the sedan geometry after import and clean-up operations are
complete.

Figure 5-4: Imported sedan body—with Virtual Cleanup option
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Step 4: Eliminate Very Short Edges
Even after the virtual clean-up operations, the imported IGES geometry is still
somewhat “dirty”—that is, there are a few short edges and gaps between the faces
that need to be repaired. In this step, you will eliminate the short edges.
1. Find the shortest edge.
GEOMETRY

→ EDGE

→ CONNECT/DISCONNECT EDGES

This command sequence opens the Connect Edges form.

a) Select All from the option menu to the right of Edges.
b) Select the Real and Virtual (Tolerance) option.
c) Press the Highlight shortest edge button.
GAMBIT will highlight (in white) the shortest edge—along with its label—in
the graphics window.
d) Zoom in near the highlighted edge by pressing the Ctrl key while using the mouse
to drag a box around the edge.
Figure 5-5 shows the general area on the sedan that contains the shortest
edge. Figure 5-6 shows a zoomed view of the edge.
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Zoom region

Figure 5-5: Sedan—showing general area of shortest edge location

Short edge
Figure 5-6: Sedan—showing zoomed area near shortest edge
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2. Remove the shortest edge.
GEOMETRY

→ VERTEX

→ CONNECT/DISCONNECT VERTICES

This command sequence opens the Connect Vertices form.

a) Select the Virtual (Forced) option.
b) Pick the two endpoint vertices on the shortest edge.
c) Click Apply.
When GAMBIT attempts to connect these two vertices, an error message is
generated stating that connecting these two vertices can cause invalid
geometry. The geometry is protected from such operations by means of a
default setting.
d) Open the Edit Defaults form (select Defaults… from the Edit menu on the main
menu bar), and change the value of the GEOMETRY.VERTEX.CONNECT_REMOVE_
SHORT_EDGE variable to 1.
e) Repeat step (c).
This time, GAMBIT connects the vertices.

f) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full sedan in the graphics window.
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g) Select the Virtual (Tolerance) option to activate the Highlight shortest edge button on
the Connect Vertices form.
h) Click the Highlight shortest edge button and repeat steps (a), (b), and (c) to eliminate
the next shortest edge (see Figure 5-7).

Figure 5-7: Sedan—showing location of next shortest edge
By eliminating the two shortest edges in the model, you ensure that all edge
meshing intervals are of reasonable size, thereby reducing the possibility of
creating highly distorted elements during meshing.
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Step 5: Automatically Connect All Remaining “Duplicate” Edges
The imported IGES geometry is still “dirty”—that is, there are a few gaps remaining
between the faces that make it unsuitable for creating a mesh. In this step, you will
“clean up” the geometry automatically using the Connect Edges operation.
1. Connect all edges in the geometry that are less than a specified tolerance apart using
an automatic method.
GEOMETRY

→ EDGE

→ CONNECT/DISCONNECT EDGES

This command sequence opens the Connect Edges form.

a) Select All from the option menu to the right of Edges.
b) Select the Real and Virtual (Tolerance) option.
You want GAMBIT to connect all real and virtual edges that are within a
tolerance distance of each other.
c) Retain the default value of 10 for the Shortest Edge %.
d) Select the T-Junctions option.
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This option ensures that edges that do not match up correctly will be
connected. GAMBIT will perform edge splits and then reconnect the
geometry; an example is shown in Figure 5-8.

Two edges

Three edges

Figure 5-8: Connecting edges
e) Click Apply.
A few more edges turn blue in the graphics window as they are connected.
!

The edges on the symmetry plane will remain orange because they do not
have any other edges with which they can be connected.

2. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the full sedan in the graphics window.
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Step 6: Merge Faces
In many cases, the IGES model contains more detail than you need for meshing. The
imported geometry for the sedan includes a number of small faces, the edges of which
may constrain the mesh generation process unnecessarily. In GAMBIT, you can
merge faces together prior to meshing.
1. Merge some of the faces on the sedan hood.
GEOMETRY

→ FACE

→ SPLIT/MERGE/COLLAPSE/SIMPLIFY FACES

R
This command sequence opens the Merge Faces (Virtual) form.

a) Under Type, select Virtual (Forced).
b) Zoom in to the hood of the sedan by holding down the Ctrl key on the keyboard
while dragging a box around the hood of the car with the left mouse button.
c) Select the three faces on the top of the hood as shown in Figure 5-9.
d) Retain the Merge Edges option to facilitate geometry cleanup during merging.
e) Click Apply to accept the selected faces and merge them into one face, as shown in
Figure 5-10.
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Figure 5-9: Three faces on hood of sedan

Figure 5-10: Three faces merged on hood of sedan
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2. Merge four faces on the trunk of the car (see Figure 5-11) using the method described
above. The merged faces are shown in Figure 5-12.

Figure 5-11: Four faces on trunk of sedan

Figure 5-12: Four faces merged on trunk of sedan
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3. Merge three faces near the rear end of the trunk of the car (see Figure 5-13) using the
method described above. The merged faces are shown in Figure 5-14.

Figure 5-13: Three faces near rear end of trunk

Figure 5-14: Three faces merged near rear end of trunk
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4. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the full sedan in the graphics window.
The top portion of the trunk should now consist of two large faces, as shown in
Figure 5-15.

Figure 5-15: Merged faces on sedan
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Step 7: Mesh Faces on Car Body
1. Create a surface mesh on the faces of the car body.
MESH

→ FACE

→ MESH FACES

a) Select all the faces on the car body by holding down the Shift key and using the
left mouse button to drag a box around the whole geometry in the graphics
window.
!

It may take a while for GAMBIT to select all the faces. GAMBIT analyzes
each face to determine suitable meshing schemes. You should wait until all
the edges turn red before going on to the next step.

b) Select Tri from the Elements option button under Scheme.
GAMBIT automatically selects the Type:Pave option. For more information
on face meshing schemes, see the GAMBIT Modeling Guide.
c) Enter an Interval size of 0.03 under Spacing and click the Apply button at the
bottom of the form.
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GAMBIT will mesh the car body surfaces. A portion of the mesh is shown in
Figure 5-16.

Figure 5-16: Surface mesh on rear of car body
2. Remove the mesh from the display.
!

This will make it easier to see what to do in the next steps. The mesh is not
deleted, just removed from the graphics window.

a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

This action opens the Specify Display Attributes form.
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b) Select the Off radio button to the right of Mesh near the bottom of the form.
GAMBIT will automatically select the Mesh check box.
c) Click Apply and close the form.
The mesh will be removed from the graphics window.
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Step 8: Create a Brick Around the Car Body
1. Create a brick.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a value of 10 for the Width of the brick.
b) Enter 5 for the Depth and 5 for the Height.
c) Select Centered from the option menu to the right of Direction.
d) Click Apply.
at the top left of the Global Control
2. Click the FIT TO WINDOW command button
toolpad to see the full sedan and the brick just created in the graphics window.
3. Move the brick to the desired location relative to the sedan.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.

5-26

© Fluent Inc., Sep-04

SEDAN GEOMETRY—VIRTUAL CLEANUP

Procedure

a) Shift-left-click the brick in the graphics window.
b) Select Move (the default) under Volumes in the Move / Copy Volumes form.
c) Select Translate (the default) under Operation.
d) Enter (0, 2.5, 2.5) under Global to move the brick 2.5 units in the y direction and
2.5 units in the z direction.
Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
e) Click Apply.
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4. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the full sedan and the brick in the graphics window.
The brick and sedan are shown in Figure 5-17.

Figure 5-17: Brick and sedan
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Step 9: Remove Unwanted Geometry
You cannot simply subtract the car from the brick to produce the flow domain around
the car, because you used “virtual geometry” to clean up the car body and GAMBIT
cannot perform Boolean operations on virtual geometry. Instead, you must “stitch
together” a virtual volume from the virtual faces of the car and the real faces of the
brick. To do this you will delete the volume of the brick, leaving the lower geometry
(the faces) behind. In the next steps, you will create virtual edges and faces.
1. Delete the volume of the brick, leaving the faces behind.
GEOMETRY

→ VOLUME

→ DELETE VOLUMES

This command sequence opens the Delete Volumes form.

a) Shift-left-click the brick in the graphics window.
b) Unselect the Lower Geometry option and click Apply.
The brick volume will be deleted, but all its components (faces, edges, and
vertices) will remain in the geometry, because you deselected the Lower
Geometry option.
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Step 10: Create Straight Edges on the Symmetry Plane
In this step, you will create two straight edges that will be used in the next step to
create faces on the symmetry plane.
1. Split the bottom edge of the symmetry plane into three sections.
GEOMETRY

→ EDGE

→ SPLIT/MERGE EDGES

This command sequence opens the Split Edge form.

a) Retain the Type:Real connected option.
b) Select Split With Point (the default).
You will split the edge by creating a point on the edge and then using this
point to split the edge.
c) Use the Ctrl key and the left mouse button to zoom in to the sedan and the line at
the bottom of the symmetry plane, similar to the view shown in Figure 5-18.
d) Select the edge at the bottom of the symmetry plane in the graphics window.
e) Enter a U Value of 0.64 in the Split Edge form and click Apply.
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The vertex needs to be close to the front of the sedan. A U Value of 0.64 will
place the vertex in the correct position, but it is the position relative to the
sedan that is important, not the exact U Value.
The edge is split into two parts and a vertex is created near the front bumper
of the sedan, as shown in Figure 5-18.
f) Select the longer edge of the two edges just created in the graphics window.
g) Enter a U Value of 0.57 in the Split Edge form and click Apply.
Again, the position of the vertex relative to the sedan is more important than
the exact U Value.
The edge will be split and a second vertex created near the rear bumper of the
sedan, as shown in Figure 5-18.

Edges after split

Figure 5-18: Bottom edge of symmetry plane is split into three edges
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2. Create straight edges between the two points just created and two points on the sedan.
GEOMETRY

→ EDGE

→ CREATE EDGE

This command sequence opens the Create Straight Edge form.

a) Select the Virtual option to the right of Type.
You must use Virtual because the vertex to be used on the car body is a virtual
vertex.
b) Zoom in to the front of the sedan, so that you can see the front bumper and the
first vertex created on the edge at the bottom of the symmetry plane, as shown in
Figure 5-19.
c) Shift-left-click the first vertex created on the bottom edge of the symmetry plane.
d) Shift-left-click the vertex on the sedan that is also on the symmetry plane, as
shown in Figure 5-19.
!

Make sure that you select the vertex that is on the symmetry plane as well as
the sedan. The vertex will be on an orange edge if it is on both the symmetry
plane and the sedan geometry.

e) Click Apply to accept the selected vertices and create an edge, as shown in Figure
5-19.
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Created edge

Figure 5-19: Edge from bottom of symmetry plane to front of sedan
3. Create a straight edge from the second vertex created on the bottom edge of the symmetry plane to the rear bumper of the sedan, as shown in Figure 5-20.
!

Again, make sure you select the vertex that is on both the sedan geometry and the
symmetry plane.
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Created edge

Figure 5-20: Edge from bottom of symmetry plane to rear of sedan
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Step 11: Create Faces on the Symmetry Plane
In this step, you will create two new faces on the symmetry plane by stitching edges
together. You will use the existing symmetry plane on the brick as a host. The two
faces you create in this step will be used to create a volume in the next step.
1. Create a new face on the symmetry plane by stitching edges together.
GEOMETRY

→ FACE

→ FORM FACE

This command sequence opens the Create Face From Wireframe form.

a) Select the Type:Virtual option.
You must use Virtual because the edges to be selected on the car body are
virtual edges.
b) Shift-left-click the four edges underneath the sedan, the two small diagonal edges
on the symmetry plane, and the middle edge at the bottom of the symmetry plane.
!

The area under the sedan where the edges to be selected are located is shown
in Figure 5-21, and the edges to be selected are shown in Figure 5-22.
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Region encompassed by first face
created on symmetry plane

Figure 5-21: Area under sedan where edges to be selected are located
!
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You should select seven edges in total. Pay particular attention to any very
small edges. If you select an incorrect edge, Shift-middle-click on the edge to
deselect it and select the edge next to it.
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Figure 5-22: Edges used to create face at bottom of sedan
c) Select the Host check box in the Create Face From Wireframe form.
d) Select Face from the Host option menu.
e) Shift-left-click the back face of the brick (the symmetry plane) in the graphics
window, as shown in Figure 5-23.
If you select the wrong face, Shift-middle-click on the face to deselect it and
select the face next to it.
f) Enter 0.001 in the Tolerance text entry box.
g) Click Apply to accept the selection and create the face.
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Figure 5-23: Symmetry plane of the brick
2. Create a second face on the symmetry plane.
a) Check that the Virtual option is selected next to Type.
b) Left-click in the Edges list box in the Create Face From Wireframe form.
c) Select all the edges shown in Figure 5-24.
!

You should select 25 edges in total.

d) Left-click in the list box to the right of Host in the form.
e) Shift-left-click the back face of the brick (the symmetry plane) in the graphics
window, as shown in Figure 5-23.
f) Click Apply to accept the selection and create the face.
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Figure 5-24: Edges used to create face at top of sedan
3. Verify the creation of the faces.
GEOMETRY

→ FACE

→ SUMMARIZE/QUERY FACES/TOTAL ENTITIES

This command sequence opens the Summarize Faces form.

a) Left-click the black arrow to the right of the Faces list box.
This action opens the Face List form. There are two types of pick-list forms:
Single and Multiple. In a Single pick-list form, only one entity can be selected
at a time. In a Multiple pick-list form, you can select multiple entities.
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i. Select the two faces at the bottom of the Available list in the Face List form.
!

Note that the names of entities in the Available list may be different in
your geometry. In the form shown above, the last two faces in the
Available list are v_face.153 and v_face.154, but you might see faces with
different numbers.

ii. Click the − −> button to pick the two faces.
The two faces will be moved from the Available list to the Picked list, and
they will be highlighted in the graphics window.
iii. Check that the two faces highlighted in the graphics window are the correct
faces that you should have created in the previous steps.
Figure 5-22 and Figure 5-24 show the faces that you should have created.
iv. Close the Face List form.
b) Click Reset in the Summarize Faces form to unselect the two faces in the graphics
window.
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Step 12: Create a Volume
1. Use the faces to create a volume.
GEOMETRY

→ VOLUME

→ FORM VOLUME

This command sequence opens the Stitch Faces form.

a) Select the Number:Single volume option.
b) Select the Type:Virtual option.
c) Select the symmetry-plane face in the graphics window (as shown in Figure 5-23)
and remember the label name (for example, face.147).
d) Left-click the black arrow to the right of the Faces list box.
This action opens the Face List form.

© Fluent Inc., Sep-04

5-41

Procedure

SEDAN GEOMETRY—VIRTUAL CLEANUP

i. Click on the All −> button to move all the faces from the Available list to the
Picked list.
ii. Select the name of the symmetry-plane face in the Picked list.
The symmetry-plane face will be highlighted in the graphics window.
iii. Click the <−−− button to move the symmetry-plane face back into the
Available list.
iv. Close the Face List form.
e) Click Apply in the Stitch Faces form to accept the selection of the faces and create
the volume.
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Step 13: Mesh the Edges
When you created the mesh on the faces of the sedan, you used a fine mesh. For the
volume, you will create a more coarse mesh, so you will need to instruct GAMBIT to
gradually change the mesh density between the coarse and fine meshes. To do this,
you will specify the distribution of nodes along some edges in the geometry.
1. Define the grid density on three edges of the geometry underneath the sedan.
MESH

→ EDGE

→ MESH EDGES

This command sequence opens the Mesh Edges form.

a) Select the edges marked A, B, and C in Figure 5-25 (the two small edges you
created underneath the sedan and the middle section of the edge underneath the
sedan that you split into three sections).
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The edges will change color and an arrow and several circles will appear on
each edge.

A
B

C

Figure 5-25: Edges underneath the sedan to be selected for edge meshing
b) Check that Apply is selected to the right of Grading in the Mesh Edges form and
that Successive Ratio is selected from the Type option menu.
The Successive Ratio option sets the ratio of distances between consecutive
points on the edge equal to the Ratio specified in the Mesh Edges form.
c) Retain the default Ratio of 1.
d) Check that Apply is selected to the right of Spacing. Select Interval size from the
option menu under Spacing and enter a value of 0.03 in the text entry box.
e) Click the Apply button at the bottom of the form.
Figure 5-26 shows the mesh on two of the edges underneath the sedan.
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Figure 5-26: Edge meshing near the front of the sedan
2. Set the default variable that invokes flexible grading of the edges.
a) Select Defaults from the Edit menu on the main menu bar.
b) On the Edit Defaults form, Modify the MESH.EDGE.FLEXIBLE_GRADING default
variable to set it to 1.
The flexible-grading default variable controls the manner in which GAMBIT
meshes any ungraded edges that are connected to meshed or graded edges. If
you set the MESH.EDGE.FLEXIBLE_GRADING default variable to 1,
GAMBIT grades the edge such that its interval lengths adjacent to the
connecting vertex are similar to those on the already meshed or graded
edge(s) to which it is connected. If an ungraded edge is connected to more
than one graded or meshed edges at a single vertex, GAMBIT averages the
lengths on the graded and/or meshed edges to determine the appropriate
interval length on the ungraded edge.
c) Close the Edit Defaults form.
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Step 14: Mesh the Volume
1. Mesh the volume with a coarser mesh than the mesh on the car faces.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select the volume in the graphics window.
b) Select Tet/Hybrid from the Elements option menu under Scheme in the Mesh
Volumes form, and select TGrid from the Type option menu.
See the GAMBIT Modeling Guide for more information on meshing schemes.
c) Retain the default Interval size of 1 under Spacing and click the Apply button at the
bottom of the form.
The surface of the volume mesh is shown in Figure 5-27.
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Figure 5-27: A portion of the volume mesh
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Step 15: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

a) Select Range under Display Type at the top of the form.
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The 3D Element type selected by default at the top of the form is a brick
.
You will not see any mesh elements in the graphics window when you first
open the Examine Mesh form, because there are no hexahedral elements in the
mesh.

b) Left-click on the tetrahedron icon
form.

next to 3D Element near the top of the

The mesh elements will now be visible in the graphics window.
c) Select EquiSize Skew from the Quality Type option menu.
This is the default skewness measure for tetrahedra in TGrid.
d) Left-click the histogram bars that appear at the bottom of the Examine Mesh form
to highlight elements in a particular quality range.
Figure 5-28 shows the view in the graphics window if you click on the fifth bar
from the right on the histogram (representing cells with a skewness value
between 0.7 and 0.8). These low values for the maximum skewness indicate
that the mesh is acceptable.
The histogram consists of a bar chart representing the statistical distribution
of mesh elements with respect to the specified Quality Type. Each vertical bar
on the histogram corresponds to a unique set of upper and lower quality
limits.
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Figure 5-28: Elements within a specified quality range
e) Close the Examine Mesh form by clicking the Close button at the bottom of the
form.
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Step 16: Set Boundary Types
1. Remove the mesh from the display before you set the boundary types.
This makes it easier to see the edges and faces of the geometry. The mesh is not
deleted, just removed from the graphics window.

a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad.

at the bottom of

b) Select the Off radio button to the right of Mesh near the bottom of the form.
c) Click Apply and close the form.
2. Set boundary types for the sedan.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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a) Define the pressure inlet boundary.
i. Select PRESSURE_INLET in the Type option menu.
ii. Check that Faces is selected as the Entity.
iii. Shift-left-click the face on the brick in front of the car in the graphics window
(marked A in Figure 5-29) and click Apply to accept the selection.
This face will be set as a pressure inlet.
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GAMBIT will give the boundary a default name based on what you select
in the Type and Entity lists (pressure_inlet.1 in this example). You can also
specify a name for a boundary by entering a name in the Name text entry
box.

B
A

Figure 5-29: Pressure inlet (A) and pressure outlet (B) for the sedan geometry
b) Define the pressure outlet boundary.
i. Change the Type to PRESSURE_OUTLET by selecting it from the option menu
below Type.
ii. Select the face on the brick behind the car in the graphics window (marked B
in Figure 5-29) and click Apply to accept the selection.
c) Define symmetry boundary types for the two faces on the symmetry plane of the
brick.
i. Enter “symmetry1” in the Name text entry box.
ii. Select SYMMETRY from the Type option menu.
iii. Select the two faces you created on the symmetry plane of the brick (the faces
marked C and D in Figure 5-30) and click Apply to accept the selection.
GAMBIT will merge the two faces into a single symmetry zone.
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C

D

Figure 5-30: Two faces created on the symmetry plane of the brick
d) Define symmetry boundary types for the top face of the brick and the side face
opposite the symmetry plane.
i. Enter “symmetry2” in the Name text entry box.
ii. Check that SYMMETRY is selected in the Type option menu.
iii. Select the faces on the brick that are above and to the side of the sedan (the
faces marked E and F in Figure 5-31) and accept the selection.
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E

F

Figure 5-31: Two symmetry boundaries for the sedan geometry
The pressure inlet, pressure outlet, and symmetry boundaries for the sedan
geometry are shown in Figure 5-32. (NOTE: To display the boundary types in
the graphics window, select the Show labels options on the Specify Boundary
Types form.)
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Figure 5-32: Boundary types for the sedan geometry
Note that you could also specify the remaining outer edges of the sedan
geometry as wall boundaries. This is not necessary, however, because when
GAMBIT saves a mesh, any faces (in 3D) on which you have not specified a
boundary type will be written out as wall boundaries by default.
In addition, when GAMBIT writes a mesh, any volumes (in 3D) on which you
have not specified a continuum type will be written as fluid by default. This
means that you do not need to specify a continuum type in the Specify
Continuum Types form for this tutorial.
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Step 17: Export the Mesh and Save the Session
1. Export a mesh file for the sedan.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

a) Enter the File Name for the file to be exported (sedan.msh).
b) Click Accept in the Export Mesh File form.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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5.5 Summary
This tutorial illustrated how to import geometry from an external CAD package as an
IGES file, and mesh it. Several geometry “cleanup” operations were demonstrated. Additional geometry was created to construct a box around the car-body geometry, and an
unstructured tetrahedral volume mesh was generated.
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6. SEDAN GEOMETRY—TOLERANT IMPORT
In this tutorial you will import an IGES file containing the geometry for a sedan automobile, clean up the geometry, and mesh it with triangles and tetrahedra.
In this tutorial you will learn how to:
•

Import an IGES file using “tolerant modeling”

•

Specify the way in which the geometry will be colored

•

Merge faces to facilitate meshing

•

Apply size functions to control mesh quality

•

Mesh a volume with a tetrahedral mesh

•

Prepare the mesh to be read into FLUENT 5/6

6.1 Prerequisites
This tutorial assumes that you are familiar with the GAMBIT GUI. You should also
familiarize yourself with the previous tutorial, which employs GAMBIT virtual clean-up
operations for importing the sedan geometry.
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6.2 Problem Description
Figure 6-1 shows the sedan geometry used in this tutorial. The external body of the sedan
is represented by a set of connected faces. To model the flow around the sedan body, you
will create a brick volume that represents the flow domain.

Figure 6-1: Sedan geometry
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6.3 Strategy
In this tutorial, you will create a fully unstructured tetrahedral mesh around a car-body
geometry imported as an IGES file. This tutorial illustrates the steps you would typically
follow to prepare an imported CAD geometry for meshing. The IGES-file contains “dirty”
geometry—that is, gaps exist between some of the surfaces that make it unsuitable for
creating a CFD mesh. You will clean up the geometry using the GAMBIT “tolerant
modeling” capability. The tolerant modeling option automatically assigns a tolerance
value to each imported vertex and edge to maintain topological integrity for the imported
model. The original CAD geometry is not modified during the import process.
The imported geometry includes a number of small surfaces, the edges of which may
unnecessarily constrain the mesh generation process. Using the “merge faces” command,
GAMBIT allows you to easily combine these surfaces prior to meshing. You can then
have GAMBIT automatically create a triangular mesh on the car body.
Since the imported geometry consists only of the car body, you need to create a suitable
domain around the car in order to conduct a CFD analysis (this is loosely equivalent to
placing the car in a wind tunnel). The remainder of the tutorial shows how to add a real
box around the car body, use virtual geometry to create some missing faces, and finally
stitch all faces together into a single volume. This volume can then be meshed (without
any decomposition) using a tetrahedral meshing scheme.
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6.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/sedan.igs

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). For
some systems, Fluent 5/6 is the default solver. The solver currently selected is
shown at the top of the GAMBIT GUI.
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Step 2: Import the IGES File
File → Import → IGES …
This command sequence opens the Import IGES File form.

© Fluent Inc., Sep-04

6-5

Procedure

SEDAN GEOMETRY—TOLERANT IMPORT

1. Click on the Browse... button.
This action opens the Select File form.

a) Select sedan.igs in the Files list.
b) Click Accept in the Select File form.
2. On the Import IGES File form, retain the Make Tolerant option.
The Make Tolerant option sets individual tolerances for edges and vertices so that
entities that are not connected to within normal GAMBIT default tolerances are
treated as connected entities.
3. Click Accept.
The IGES file for the sedan body will be read into GAMBIT as real geometry (see
Figure 6-2).
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Figure 6-2: Imported sedan body

4. Click the SPECIFY COLOR MODE command button
in the Global Control toolpad
to change the graphics display to connectivity-based coloring.
The SPECIFY COLOR MODE command button will change to
. When
GAMBIT is in the connectivity display mode, the model is displayed with colors
based on connectivity between entities rather than based on entity types. In this
case, the colors of all edges in the graphics window are blue, indicating that the
faces are connected to each other.
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Step 3: Check for Very Short Edges
To ensure that the model does not contain very short edges that can inhibit meshing,
you will highlight and examine the shortest edge in the model.
1. Find the shortest edge.
GEOMETRY

→ EDGE

→ CONNECT/DISCONNECT EDGES

This command sequence opens the Connect Edges form.

a) Select the Real and Virtual (Tolerance) option.
b) Press the Highlight shortest edge button.
GAMBIT will highlight the shortest edge—along with its label—in the
graphics window.
c) Zoom in near the highlighted edge by pressing the Ctrl key while using the mouse
to drag a box around the edge.
Figure 6-3 shows the general area on the sedan that contains the shortest
edge. Figure 6-4 shows a zoomed view of the edge.
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Zoom region

Figure 6-3: Sedan—showing general area of shortest edge location

B
Short edge

A

Figure 6-4: Sedan—showing zoomed area near shortest edge
In this case, the shortest edge in the model is short enough to possibly cause
meshing problems and should be removed.
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Step 4: Merge Edges to Remove the Shortest Edge
1. Merge the shortest edge with its adjacent edge.
GEOMETRY

→ EDGE

→ SPLIT/MERGE EDGES

R

This command sequence opens the Merge Edges (Virtual) form.

a) In the graphics window, select (pick) the shortest edge and the curved edge to
which it is connected (edges A and B in Figure 6-4, above).
b) Retain the Virtual (Forced) option.
c) Click Apply.
GAMBIT merges the edges, thereby eliminating the shortest edge.

at the top left of the Global
d) Click the FIT TO WINDOW command button
Control toolpad to see the full sedan in the graphics window.
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Step 5: Merge Faces
In many cases, the IGES model contains more detail than you need for meshing. The
imported geometry for the sedan includes a number of small faces, the edges of which
may constrain the mesh generation process unnecessarily. In GAMBIT, you can
merge faces together prior to meshing.
1. Merge some of the faces on the sedan hood.
GEOMETRY

→ FACE

→ SPLIT/MERGE/COLLAPSE/SIMPLIFY FACES

R
This command sequence opens the Merge Faces (Virtual) form.

a) Retain the Type:Virtual (Forced) option.
b) Select (pick) the three faces on the top of the hood as shown in Figure 6-5.
c) Retain the Merge Edges option to facilitate geometry cleanup during merging.
d) Click Apply to merge the faces as shown in Figure 6-6.
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Figure 6-5: Three faces on hood of sedan

Figure 6-6: Three faces merged on hood of sedan
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2. Merge four faces on the trunk of the car (see Figure 6-7) using the method outlined
above. The merged faces are shown in Figure 6-8.

Figure 6-7: Four faces on trunk of sedan

Figure 6-8: Four faces merged on trunk of sedan
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3. Merge three faces near the rear end of the trunk of the car (see Figure 6-9) using the
method outlined above. The merged faces are shown in Figure 6-10.

Figure 6-9: Three faces near rear end of trunk

Figure 6-10: Three faces merged near rear end of trunk
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4. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the full sedan in the graphics window.
The top portion of the trunk should now consist of two large faces, as shown in
Figure 6-11.

Figure 6-11: Merged faces on sedan
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Step 6: Create a Brick Around the Car Body
1. Create a brick.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a value of 10 for the Width of the brick.
b) Enter 5 for the Depth and 5 for the Height.
c) Retain Centered from the option menu to the right of Direction.
d) Click Apply.
at the top left of the Global Control
2. Click the FIT TO WINDOW command button
toolpad to see the full sedan and the brick just created in the graphics window.
3. Move the brick to the desired location relative to the sedan.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.
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a) Select (pick) the brick in the graphics window.
b) Retain Move (the default) under Volumes in the Move / Copy Volumes form.
c) Retain Translate (the default) under Operation.
d) Enter (0, 2.5, 2.5) under Global to move the brick 2.5 units in the y direction and
2.5 units in the z direction.
Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
e) Click Apply.
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4. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the full sedan and the brick in the graphics window.
Figure 6-12 shows the brick and sedan geometry (vertices not shown).

Figure 6-12: Brick and sedan geometry (vertices not shown)
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Step 7: Remove Unwanted Geometry
You cannot simply subtract the car from the brick to produce the flow domain around
the car, because you used “virtual geometry” to clean up the car body and GAMBIT
cannot perform Boolean operations on virtual geometry. Instead, you must “stitch
together” a virtual volume from the virtual faces of the car and the real faces of the
brick. To do this you will delete the volume of the brick, leaving the lower geometry
(the faces) behind. In the next steps, you will create virtual edges and faces.
1. Delete the volume of the brick, leaving the faces behind.
GEOMETRY

→ VOLUME

→ DELETE VOLUMES

This command sequence opens the Delete Volumes form.

a) Select (pick) the brick in the graphics window.
b) Unselect the Lower Geometry option and click Apply.
The brick volume will be deleted, but all its components (faces, edges, and
vertices) will remain in the geometry, because you unselected the Lower
Geometry option.
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Step 8: Create Straight Edges on the Symmetry Plane
In this step, you will create two straight edges that will be used in the next step to
create faces on the symmetry plane.
1. Split the bottom edge of the symmetry plane into three sections.
GEOMETRY

→ EDGE

→ SPLIT/MERGE EDGES

R

This command sequence opens the Split Edge form.

a) Retain the Real connected option (the default) next to Type.
b) Retain Split With Point (the default).
You will split the edge by creating a point on the edge and then using this
point to split the edge.
c) Use the mouse to rotate the model and zoom in on the sedan and the edge at the
bottom of the symmetry plane (see Figure 6-13).
d) Select (pick) the edge at the bottom of the symmetry plane.
e) Enter a U Value of 0.64 in the Split Edge form and click Apply.
6-20
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The vertex needs to be close to the front of the sedan. A U Value of 0.64 will
place the vertex in the correct position, but it is the position relative to the
sedan that is important, not the exact U Value.
The edge is split into two parts and a vertex is created near the front bumper
of the sedan, as shown in Figure 6-13.
f) Select the longer of the two edges at the bottom of the symmetry plane.
g) Enter a U Value of 0.57 in the Split Edge form and click Apply.
Again, the position of the vertex relative to the sedan is more important than
the exact U Value.
The edge will be split and a second vertex created near the rear bumper of the
sedan, as shown in Figure 6-13.

Rear
vertex

Front
vertex

Bottom edge of symmetry plane
after split operations

Figure 6-13: Bottom edge of symmetry plane is split into three edges
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2. Create straight edges between the two points just created and two points on the sedan.
GEOMETRY

→ EDGE

→ CREATE EDGE

This command sequence opens the Create Straight Edge form.

a) Retain the Real option to the right of Type.
b) Zoom in on the front of the sedan so that you can see the front bumper and the
first vertex created by splitting the edge at the bottom of the symmetry plane (see
Figure 6-14).
c) Select (pick) the first vertex created by splitting the edge at the bottom of the
symmetry plane.
d) Select (pick) the closest vertex on the sedan.
!

Make sure to select the sedan vertex that is on the symmetry plane. The vertex
will be on an orange edge if it is on both the symmetry plane and the sedan
geometry.

e) Click Apply to create the edge as shown in Figure 6-14.
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Figure 6-14: Edge from bottom of symmetry plane to front of sedan
3. Create a straight edge from the second vertex created on the bottom edge of the symmetry plane to the rear bumper of the sedan, as shown in Figure 6-15.
!

Again, make sure you select the vertex that is on both the sedan geometry and the
symmetry plane.
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Figure 6-15: Edge from bottom of symmetry plane to rear of sedan
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Step 9: Create Faces on the Symmetry Plane
In this step, you will create two new faces on the symmetry plane by stitching edges
together. You will use the existing symmetry plane on the brick as a host. The two
faces you create in this step will be used to create a volume in the next step.
1. Create a new face on the symmetry plane by stitching edges together.
GEOMETRY

→ FACE

→ FORM FACE

This command sequence opens the Create Face From Wireframe form.

a) Select the Type:Virtual option.
b) Select (pick) the edges underneath the sedan, the two small diagonal edges on the
symmetry plane, and the middle edge at the bottom of the symmetry plane.
!

The area under the sedan where the edges to be selected are located is shown
in Figure 6-16. You should select seven edges in total. Pay particular
attention to any very small edges. If you select an incorrect edge, Shiftmiddle-click on the edge to unselect it and select the edge adjacent to it.
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First face to be created on symmetry plane

Figure 6-16: Region encompassing first face to be created on symmetry plane
c) Select the Host check box in the Create Face From Wireframe form.
d) Select Face from the Host option menu.
e) Select (pick) the symmetry plane of the brick (see Figure 6-17).
If you select the wrong face, Shift-middle-click on the face to unselect it and
select the face adjacent to it.
f) Enter 0.01 in the Tolerance text entry box.
g) Click Apply to accept the selection and create the face.
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Brick symmetry plane

Figure 6-17: Brick symmetry plane
2. Create a second face on the symmetry plane.
a) Check that the Virtual option is selected next to Type.
b) Left-click in the Edges list box in the Create Face From Wireframe form.
c) Select all the edges shown in Figure 6-18.
!

You should select 25 edges in total.

d) Left-click in the list box to the right of Host in the form.
e) Select (pick) the symmetry plane of the brick (see Figure 6-17, above).
f) Click Apply to accept the selection and create the face.
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Edges

Figure 6-18: Edges used to create face at top of sedan
3. Verify the creation of the faces.
GEOMETRY

→ FACE

→ SUMMARIZE/QUERY FACES/TOTAL ENTITIES

This command sequence opens the Summarize Faces form.

a) Left-click the black arrow to the right of the Faces list box.
This action opens the Face List form. There are two types of pick-list forms:
Single and Multiple. In a Single pick-list form, only one entity can be selected
at a time. In a Multiple pick-list form, you can select multiple entities.
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i. Select the two faces at the bottom of the Available list in the Face List form.
!

Note that the names of entities in the Available list may be different in
your geometry. In the form shown above, the last two faces in the
Available list are v_face.91 and v_face.92, but you might see faces with
different numbers.

ii. Click the − −> button to pick the two faces.
The two faces will be moved from the Available list to the Picked list, and
they will be highlighted in the graphics window.
iii. Check that the two faces highlighted in the graphics window are the correct
faces that you should have created in the previous steps.
Figure 6-16 and Figure 6-18, above, show the faces that you should have
created.
iv. Close the Face List form.
b) Click Reset in the Summarize Faces form to unselect the two faces in the graphics
window.
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Step 10: Create a Volume
1. Use the faces to create a volume.
GEOMETRY

→ VOLUME

→ FORM VOLUME

This command sequence opens the Stitch Faces form.

a) Select the Number:Single volume option.
b) Select the Type:Virtual option.
c) Select the symmetry plane in the graphics window (as shown in Figure 6-17) and
remember the label name (for example, face.85).
d) Left-click the black arrow to the right of the Faces list box.
This action opens the Face List form.
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i. Click on the All −> button to move all the faces from the Available list to the
Picked list.
ii. Select the name of the symmetry plane in the Picked list.
The symmetry plane face will be highlighted in the graphics window.
iii. Click the <−−− button to move the symmetry plane face back into the Available
list.
iv. Close the Face List form.
e) Click Apply to create the volume.
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Step 11: Apply Size Functions to Control Mesh Quality
GAMBIT includes several features that allow you to control the mesh quality, one of
which is the application of size functions. For example, size functions can be used to
specify the rate at which volume mesh elements change in size in proximity to a
specified boundary. In this step, you will apply size functions to the faces that
comprise the outer surface of the sedan and to the face you created underneath the
sedan on the symmetry plane.
1. Specify a size function and apply it to four faces of the model.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.

a) Retain the Type:Fixed option.
b) On the Entities:Source option button, select the Faces option, and click in the
Faces list box to make it active.
c) Click the ORIENT MODEL command button
Figure 6-19.
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B

A
Picking box

Figure 6-19: Picking box including all faces to which size functions will apply
d) Shift-drag the mouse from the lower right (point A) to the upper left (point B) to
create a picking box that encompasses all of the faces on the sedan body as well as
the small, symmetry plane face underneath the sedan.
When you Shift-drag the mouse in an upper diagonal direction to create the
picking box, GAMBIT picks only those faces that are completely enclosed by
the box.
e) On the Entities:Attachment option button, retain the Volumes option.
f) In the Volumes list box, select the volume.
g) In the Start size text box, enter the value 0.03.
h) In the Growth rate text box, enter the value, 1.3.
i) In the Size limit text box, enter the value, 1.
j) Click Apply to create the size function.
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When applying the size function, GAMBIT displays a message in the
Transcript window indicating that the use of virtual entities as source entities
in the size-function definition can cause problems when evaluated during
background-grid generation. The message represents a warning only and can
be ignored in this case.
GAMBIT allows you to view the size function by means of the View Size
Function command on the Size Function toolpad.
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Step 12: Mesh the Volume
1. Mesh the volume with a coarser mesh than the mesh on the car faces.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select the volume in the graphics window.
b) Select Tet/Hybrid from the Elements option menu under Scheme in the Mesh
Volumes form, and select TGrid from the Type option menu.
See the GAMBIT Modeling Guide for more information on meshing schemes.
c) Retain the default Interval size of 1 under Spacing and click the Apply button at the
bottom of the form.
A portion of the volume mesh (looking at the sedan from the symmetry plane
side) is shown in Figure 6-20. To achieve this view of the model:
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i)

Right-click the ORIENT MODEL command button
Control toolpad and select the –Z view

on the Global
..

ii) Turn on hidden-line removal by right-clicking the RENDER MODEL
command button

in the Global Control toolpad and selecting

from the resulting list.

Figure 6-20: A portion of the volume mesh
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Step 13: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

a) Select Range under Display Type at the top of the form.
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The 3D Element type selected by default at the top of the form is a brick
.
You will not see any mesh elements in the graphics window when you first
open the Examine Mesh form, because there are no hexahedral elements in the
mesh.

b) Left-click on the tetrahedron icon
form.

next to 3D Element near the top of the

The mesh elements will now be visible in the graphics window.
c) Select or retain EquiAngle Skew from the Quality Type option menu.
This is the default skewness measure for tetrahedra in TGrid.
d) Click with the left mouse button on the histogram bars that appear at the bottom of
the Examine Mesh form to highlight elements in a particular quality range.
Figure 6-21 shows the view in the graphics window if you click on the fourth
bar from the right on the histogram (representing cells with a skewness value
between 0.6 and 0.7). These low values for the maximum skewness indicate
that the mesh is acceptable.
The histogram consists of a bar chart representing the statistical distribution
of mesh elements with respect to the specified Quality Type. Each vertical bar
on the histogram corresponds to a unique set of upper and lower quality
limits.
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Figure 6-21: Elements EquiAngle Skew = 0.6 to 0.7
e) Close the Examine Mesh form by clicking the Close button at the bottom of the
form.
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Step 14: Set Boundary Types
1. Remove the mesh from the display before you set the boundary types.
This makes it easier to see the edges and faces of the geometry. The mesh is not
deleted, just removed from the graphics window.

at the bottom of
a) Click the SPECIFY DISPLAY ATTRIBUTES command button
the Global Control toolpad to open the Specify Display Attributes form.

b) Select the Mesh:Off option near the bottom of the form.
c) Click Apply to turn off the mesh display, then Close the form.
2. Set boundary types for the sedan.
ZONES
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This command sequence opens the Specify Boundary Types form.

a) Define the pressure inlet boundary.
i. Select PRESSURE_INLET in the Type option menu.
ii. Check that Faces is selected as the Entity.
iii. Select (pick) the face on the brick in front of the car in the graphics window
(face A in Figure 6-22) and click Apply to accept the selection.
This face will be set as a pressure inlet.
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GAMBIT will give the boundary a default name based on what you select
in the Type and Entity lists (pressure_inlet.1 in this example). You can also
specify a name for a boundary by entering a name in the Name text entry
box.

B
A

Figure 6-22: Pressure inlet (A) and pressure outlet (B) for the sedan geometry
b) Define the pressure outlet boundary.
i. Change the Type to PRESSURE_OUTLET by selecting it from the option menu
below Type.
ii. Select (pick) the face on the brick behind the car in the graphics window (face
B in Figure 6-22) and click Apply to accept the selection.
c) Define symmetry boundary types for the two faces on the symmetry plane of the
brick.
i. Enter “symmetry1” in the Name text entry box.
ii. Select SYMMETRY from the Type option menu.
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iii. Select (pick) the two faces you created on the symmetry plane of the brick
(faces C and D in Figure 6-23) and click Apply to accept the selection.
GAMBIT will merge the two faces into a single symmetry zone.

C

D
Figure 6-23: Two faces created on the symmetry plane of the brick
d) Define symmetry boundary types for the top face of the brick and the side face
opposite the symmetry plane.
i. Enter “symmetry2” in the Name text entry box.
ii. Check that SYMMETRY is selected in the Type option menu.
iii. Select (pick) the faces on the brick that are above and to the side of the sedan
(faces E and F in Figure 6-24) and accept the selection.
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E

F

Figure 6-24: Two symmetry boundaries for the sedan geometry
The pressure inlet, pressure outlet, and symmetry boundaries for the sedan
geometry are shown in Figure 6-25. (NOTE: To display the boundary types in
the graphics window, select the Show labels options on the Specify Boundary
Types form.)
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Figure 6-25: Boundary types for the sedan geometry
Note that you could also specify the remaining outer edges of the sedan
geometry as wall boundaries. This is not necessary, however, because when
GAMBIT saves a mesh, any faces (in 3D) on which you have not specified a
boundary type will be written out as wall boundaries by default.
In addition, when GAMBIT writes a mesh, any volumes (in 3D) on which you
have not specified a continuum type will be written as fluid by default. This
means that you do not need to specify a continuum type in the Specify
Continuum Types form for this tutorial.

© Fluent Inc., Sep-04

6-45

Procedure

SEDAN GEOMETRY—TOLERANT IMPORT

Step 15: Export the Mesh and Save the Session
1. Export a mesh file for the sedan.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

a) Enter the File Name for the file to be exported (sedan_tolerant.msh).
b) Click Accept in the Export Mesh File form.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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6.5 Summary
This tutorial illustrated how to import geometry from an external CAD package as an
IGES file using GAMBIT tolerant modeling to facilitate the creation of a “clean,” meshable model. In addition, several faces were merged, a box was constructed around the carbody geometry, and an unstructured tetrahedral volume mesh was generated.
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7. MODELING FLOW IN A TANK
In this tutorial you will utilize the techniques illustrated in the previous tutorials to create
a complex pipe junction that represents a real-world example of flow in a process tank.
In this tutorial you will learn how to:
•

Create cylinders and bricks by defining their dimensions

•

Translate and rotate volumes

•

Perform Boolean operations on volumes (unite and subtract)

•

Split a volume using another volume

•

Align two volumes using a vertex pair

•

Specify the distribution of nodes on an edge

•

Add boundary layers to your geometry

•

Generate an unstructured hexahedral mesh

•

Examine the quality of the mesh

•

Prepare the mesh to be read into FIDAP

7.1 Prerequisites
This tutorial assumes that you have worked through Tutorials 1, 2, 3, and 4.
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7.2 Problem Description
The problem to be considered is shown schematically in Figure 7-1. Due to symmetry,
only half of the actual model is shown.
The geometry consists of a large cylindrical tank with an inlet/outlet annular section. This
section is connected to the tank at half the length of the tank and at an offset from the
center of the tank. In the annular section, the inner pipe is the inlet pipe. There is a small
T-junction on the upper end of outer pipe. This is the outlet.
The overall goal is to create a high quality hexahedral mesh including boundary layers and
edge meshing to sufficiently capture gradient in solution variables, such as velocity and
temperature. The solver selected for this tutorial is FIDAP
26

12

12
8
60
84

72
17

80

Figure 7-1: Problem specification
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7.3 Strategy
In this tutorial we will combine several of the previously shown tools and strategies and
apply them on a real industrial problem. The first thing to find out is if the boundary condition and the physics will allow us to model only half of the geometry. This is a very
important step since it immediately reduces the effort of preprocessing and running time.
After confirming the symmetry condition, we start building the geometry using primitives
and Boolean operations. Although we normally recommend to create the model in the
following order:
1. Geometry creation
2. Decomposition
3. Mesh generation
We will illustrate, in this journal, that the order of geometry creation and decomposition is
not strict. Mesh generation, though, should in all cases be left to last.
The overall geometry creation is fairly straightforward and based on cylinder primitives,
Boolean unites, and subtracts. The model cannot be meshed as is, using hexahedral
meshing, since several faces in this model are non-trivial and their normals are facing all
three major directions. Essentially there are two pipe-pipe intersections, which needs to be
decomposed
The first section is the pipe/annulus intersection at the outlet. In this situation, the recommended strategy is to use a block to split of the outlet pipe. The split has to be made with
an angle, such that the unstructured mesh from the pipe will be “projected” to the wall of
the inner pipe. (See the following figure.)
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Unstructured
mesh

Inner
pipe wall

The second section is the main intersection of the inlet/outlet pipes with the tank. Again,
we are using a block to split of the bigger tank section into a center section. We are tilting
the cutting block to optimize mesh quality. This will allow the mesh on all non-trivial
source faces to be “projected” into the bottom of the tank as illustrated in the picture
below

The mesh from the upper
faces will be projected
onto the lower face
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Edge meshing and boundary layers are applied at several areas to ensure appropriate
grading in key areas of the model. The boundary layers are particularly important in areas
where the face is being paved—that is, on most source faces, while edge meshing is used
where the mesh is being mapped. In some cases edge meshing and boundary layer are
combined for full control over the mesh density
Several techniques are used in the face meshing part like; enforce Submap without
meshing and multiple source face meshing, where side faces between source faces are
also meshed
Finally, the Cooper tool is used to mesh all volumes in this model.
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7.4 Procedure
Start GAMBIT using the session identifier “Tank”.

Step 1: Select a Solver
1. Choose the FIDAP solver.
Solver → FIDAP
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). The
solver currently selected is indicated at the top of the GAMBIT GUI.

Step 2: Set the Default Interval Size for Meshing
In this tutorial, you will change the default interval size used for meshing. The
mesh spacing is by default based on the interval size function, which you will
modify in the Edit Defaults form. The value you enter should be the estimated
average size of an element in the model. This value will appear as the default
Interval size on all meshing forms. You will be able to change it on the meshing
forms if required.
Edit → Defaults…
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1. Select the MESH tab at the top of the form.
2. Select the INTERVAL radio button near the top of the form.
3. Select SIZE in the Variable list.
SIZE will appear in the space at the bottom of the list and its default value will

appear in the Value text entry box.
4. Enter a value of 2 in the Value text entry box.
5. Click the Modify button to the left of SIZE.
The Value of the variable SIZE will be updated in the list.
6. Close the Edit Defaults form.
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Step 3: Create Cylinders
1. Create the first pipe for the pipe junction.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Cylinder form.

a) Enter a Height of 60.
b) Enter 40 for Radius 1.
The text entry box for Radius 2 can be left blank; GAMBIT will set this value
by default to be the same value as Radius 1.
c) Retain Positive Z (the default) in the list to the right of Axis Location.
d) Click Apply.
e) Click the FIT TO WINDOW command button
Control toolpad to see the cylinder created.

at the top left of the Global

You can rotate the view by holding down the left mouse button and moving the
mouse. The cylinder is shown in Figure 7-2.
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Figure 7-2: First cylinder for the pipe junction
2. Create a second cylinder, with a Height of 64, a Radius 1 of 13, in the Centered Y
direction.
The two cylinders are shown in Figure 7-3.
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Figure 7-3: Second cylinder for the pipe junction
3. Create a third cylinder, with a Height of 64, a Radius 1 of 6, in the Centered Y
direction.
4. Create a fourth cylinder, with a Height of 64, a Radius 1 of 4, in the Centered Y
direction.
The four cylinders created so far are shown in Figure 7-4.
5. Create a fifth cylinder, with a Height of 16, a Radius 1 of 6, in the Centered X
direction.
The five cylinders are shown in Figure 7-5.
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Figure 7-4: Four cylinders for the pipe junction

Figure 7-5: Five cylinders for the pipe junction
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Step 4: Complete the Geometry Creation
1. Move three of the cylinders to create the geometry of the complex pipe junction.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.

a) Select the second, third, and fourth cylinders created, by either selecting them in
the graphics window or using the Volume query list.
b) Retain Move (the default) under Volume in the Move / Copy Volumes form.
c) Retain Translate (the default) under Operation.
d) Enter a Global translation vector of (-17, 52, 0) and click Apply.
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Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
The three cylinders will be moved as shown in Figure 7-6.

Figure 7-6: Three cylinders moved into position for the complex pipe junction geometry
2. Move the fifth cylinder using a Global translation vector of (-32, 74, 0).
3. Subtract volume.3 from volume.2.
The order of selecting the volumes is important. For example, Figure 7-7 shows
the difference between subtracting volume B from volume A, and vice versa.
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B
A

Subtract B from A

Intersecting volumes
Subtract A from B
Figure 7-7: Subtracting volumes

GEOMETRY

→ VOLUME

→ BOOLEAN OPERATION

R
This command sequence opens the Subtract Real Volumes form.

a) Select volume.2 in the graphics window and accept the selection of the volume.
b) Select volume.3 and accept the selection of the volume.
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The completed geometry is shown in Figure 7-8.

Figure 7-8: Completed geometry
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Step 5: Decompose the Geometry
In this tutorial, we are decomposing the tank before uniting it with all of the pipes. If
we reversed the order, the pipes would have been split through, which is undesirable.
We are also rotating the brick to improve the symmetry of the tank cut. This will
increase the edge-angle of one of the faces, which ultimately leads to better mesh
quality
1. Create a brick to split the large cylinder.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

R

This command sequence opens the Create Real Brick form.

a) Enter a value of 42 for the Width of the brick.
b) Enter a Depth of 82 and a Height of 160.
c) Retain Centered on the Direction option menu and click Apply.
The brick and the pipe junction are shown in Figure 7-9.
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Figure 7-9: Brick and complex pipe junction
2. Rotate the brick relative to the geometry.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.
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a) Select the brick in the graphics window.
b) Retain Move (the default) under Volume at the top of the Move / Copy Volumes
form.
c) Under Operation, select Rotate.
d) Enter an Angle of 30 for the angle of rotation.
You will use the default Active Coord. Sys. Vector. The brick will be rotated
around the z axis.
e) Click Apply.
The brick will be rotated as shown in Figure 7-10.
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Figure 7-10: Rotated brick
3. Split the largest cylinder using the brick.
If you split one volume with another volume, the following volumes will result:
•

Volumes corresponding to the common region(s) from intersection.

•

Volumes corresponding to the region(s) defined by subtracting the second
volume from the first.

In other words, splitting a volume results in a combination of the intersection and
subtraction Boolean operations. The order of selecting the volumes is important.
For example, Figure 7-11 shows the difference between splitting volume A using
volume B, and vice versa.
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Region of
intersection

B

A

Split A with B

Intersecting volumes
Split B with A
Figure 7-11: Splitting volumes

GEOMETRY

→ VOLUME

→ SPLIT/MERGE VOLUMES

This command sequence opens the Split Volume form.
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a) Select the first cylinder you created in the graphics window (the largest cylinder)
and accept the selection of the cylinder.
b) Select Volume (Real) as the Split With option.
c) Left-click in the Volume list box located below the Split With section to make the
Volume list box active.
d) Select the brick in the graphics window.
e) Unselect the Bidirectional option.
f) Click Apply.
The cylinder will be split as shown in Figure 7-12.
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Figure 7-12: Splitting the large cylinder
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Step 6: Unite Some Parts of the Geometry
1. Unite two of the volumes into one volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R

This command sequence opens the Unite Real Volumes form.

C

A

B

Figure 7-13: Volumes to be united
a) Select the cylinder that you created by subtracting one cylinder from another in
Step 2 (the volume marked A in Figure 7-13).
b) Select the middle section of the largest pipe which was created by splitting the
pipe with the brick (the volume marked B in Figure 7-13).
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c) Click Apply.
The two volumes will be united as shown in Figure 7-14. The order in which
you select the two volumes is not important when you are uniting them.

Figure 7-14: Two volumes united into one
2. Unite two more volumes.
a) Select the volume you created in the previous step.
b) Select the middle cylinder of the three concentric cylinders (the volume marked C
in Figure 7-13).
c) Click Apply.
The united volumes are shown in Figure 7-15.
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Figure 7-15: United volumes
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Step 7: Subtract the Remaining Parts of the Symmetry Plane
1. Create a brick, which will be used to remove some parts of the geometry to create a
symmetry plane in the geometry.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a Width of 50, a Depth of 100, and a Height of 20.
b) Select -X +Y -Z from the Direction option menu.
c) Click Apply to create the brick.
The brick and the pipe junction are shown in Figure 7-16.
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Figure 7-16: Brick and pipe junction
2. Subtract the brick from the complex pipe volume.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R

This command sequence opens the Subtract Real Volumes form.

a) Select the volume that contains most of the pipe sections in the geometry (the
volume marked A in Figure 7-17). Accept the selection of the volume.
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A

Figure 7-17: Volume to use in subtraction
b) Select the brick in the graphics window.
c) In the Subtract Real Volumes form, select the Retain check box below Subtract
Volumes.
This option instructs GAMBIT to subtract the brick from the pipe geometry,
but retain the brick to be used again in the next step.
d) Click Apply.
The brick will be subtracted from the pipe geometry as shown in Figure 7-18.
Notice that the brick is still displayed in this figure, this is because the Retain
check box is selected in the Subtract Real Volumes form.
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Figure 7-18: Brick subtracted from the pipe geometry
3. Subtract the brick from the small pipe.
a) Select the smallest cylinder in the graphics window, and accept the selection.
b) Select the brick in the graphics window.
c) Unselect the Retain check box.
d) Click Apply.
Figure 7-19 shows the geometry after the subtraction.
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Figure 7-19: Brick subtracted from the small pipe to create a symmetry plane
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Step 8: Split off Annulus Pipe to Make the Volumes Meshable
1. Create a brick to split off part of the geometry.
Again the decomposition of the cylinder is done before the full geometry has been
created. In this example, we are using Align instead of Move/Copy to position the
tool to the appropriate position before the splitting
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a value of 20 for the Width of the brick. Delete the values in the Depth and
Height text entry boxes.
GAMBIT will set the Depth and Height by default to be the same value as the
Width, to create a cube.
b) Select -X +Y +Z from the Direction option menu and click Apply.
2. Rotate the brick relative to the geometry.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.
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a) Select the brick in the graphics window.
b) Retain Move (the default) under Volume at the top of the Move / Copy Volumes
form.
c) Under Operation, retain Rotate.
d) Retain the Angle of 30 for the angle of rotation.
You will now redefine the Active Coord. Sys. Vector so that GAMBIT rotates
the brick about the y axis.
e) Click the Define button to the right of Axis.
This action opens the Vector Definition form.
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i. Select Y Positive under Direction and click Apply.
f) Click Apply in the Move / Copy Volumes form.
3. Create a vertex on the brick.
You will create a vertex on the brick and use it to align the brick correctly relative
to the geometry. This is an alternative method to moving the splitting tool (the
brick) to the right position in the geometry using coordinates.
GEOMETRY

→ EDGE

→ SPLIT/MERGE EDGE

This command sequence opens the Split Edge form.

© Fluent Inc., Sep-04

7-33

Procedure

MODELING FLOW IN A TANK

a) Select the edge on the brick marked A in Figure 7-20.

A

Figure 7-20: Edge to be split on the brick
b) Enter a U Value of 0.3 in the Split Edge form and click Apply.
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4. Align the brick with the part of the geometry to be split.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

R
This command sequence opens the Align Volumes form.

a) Select the brick in the graphics window and accept the selection.
The Translation Vertex Pair list box in the Align Volumes form will be
highlighted. You will now select the vertex on the object you want to move and
then the vertex with which you want to align the object.
b) Select the vertex you just created on the brick.
c) Select the vertex marked A in Figure 7-21. The vertex is on the end of the long
thin pipes near the smallest cylinder.

© Fluent Inc., Sep-04

7-35

Procedure

MODELING FLOW IN A TANK

A

Figure 7-21: Vertex to be selected to align the brick
d) Click Apply.
The brick will be aligned with the pipe volume as shown in Figure 7-22.
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Figure 7-22: Brick aligned with pipe geometry
5. Use the brick to split the volume that contains most of the pipe sections.
GEOMETRY

→ VOLUME

→ SPLIT/MERGE VOLUMES

This command sequence opens the Split Volume form.
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a) Select the volume that contains most of the pipe sections in the geometry (the
volume marked A in Figure 7-23) and accept the selection.
B
A

Figure 7-23: Volumes to be used in the split
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b) Retain Volume (Real) as the Split With option.
c) Left-click in the Volume list box located below the Split With section to make the
Volume list box active.
d) Select the brick (marked B in Figure 7-23) in the graphics window.
e) Click Apply.
The geometry will be split as shown in Figure 7-24.

Figure 7-24: Decomposed geometry
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Step 9: Unite the Side Pipe
This is the final unite operation to complete the construction of the geometry
1. Unite two more volumes.
GEOMETRY

→ VOLUME

→ BOOLEAN OPERATIONS

R
This command sequence opens the Unite Real Volumes form.

A

B

Figure 7-25: Volume to be united
a) Select the volume you created in the previous step (marked A in Figure 7-25).
b) Select the small half-cylinder (the volume marked B in Figure 7-25).
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c) Click Apply.
The united volumes are shown in Figure 7-26.

Figure 7-26: United volumes

© Fluent Inc., Sep-04

7-41

Procedure

MODELING FLOW IN A TANK

Step 10: Mesh the Edges
In this step, you will define the grid density on some edges of the geometry. You will
accomplish this by selecting an edge, assigning the number of nodes, and specifying
the distribution of nodes along the edge.
1. Define the grid density on four edges of the geometry.
MESH

→ EDGE

→ MESH EDGES

This command sequence opens the Mesh Edges form.

a) Select the edges marked A, B, C, and D in Figure 7-27.
The edges will change color and an arrow and several circles will appear on
each edge. The arrow is small and you may have to zoom into the edge to see
it. It is located near the center of the edge.
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C
E

D

A
B
F

Figure 7-27: Edges to be selected for edge meshing
b) Ensure that Apply is selected to the right of Grading in the Mesh Edges form and
select Last First Ratio from the Type option menu.
The Last First Ratio is defined as the size ratio between the first element (or grid
distance) on the edge, and the last, based on the direction (sense) of the edge.
For double sided grading, the last first ratio is the ratio between the central
element and the element at the end of the edge
c) Enter a value of 3.6 for Ratio.
d) Select the Double sided check box
If you specify a Double sided grading on an edge, the element intervals are
graded in two directions from a starting point on the edge. GAMBIT
determines the starting point such that the intervals on either side of the point
are approximately the same length. Ratio 2 is automatically given the value of
Ratio 1 (which is equal to the specified value of Ratio).
e) Ensure that the Apply check box is selected to the right of Spacing. Select Interval
size from the option menu under Spacing and enter a value of 2.5 in the text entry
box.
f) Click Apply.
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2. Define the grid density on two edges of the geometry.
a) Select the edges marked E and F in Figure 7-27.
b) Ensure that Apply is selected to the right of Grading in the Mesh Edges form and
select Successive Ratio from the Type option menu.
The Successive Ratio option sets the ratio of distances between consecutive
points on the edge equal to the Ratio specified in the Mesh Edges form.
c) Retain the default Ratio of 1.
d) Ensure that the Apply check box is selected to the right of Spacing. Enter 5 next to
Interval size.
e) Click Apply.
The edge meshing for the six edges is shown in Figure 7-28.

Figure 7-28: Edge meshing on the complex pipe junction geometry
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Step 11: Apply Boundary Layers
Boundary layers are layers of elements growing out from a boundary into the
domain. They are used to locally refine the mesh in the direction normal to a face or
an edge. Boundary layers are used in this example to improve mesh density close to
walls on faces that will be paved
1. Create boundary layers on one edge.
MESH

→ BOUNDARY LAYER

→ CREATE BOUNDARY LAYER

This command sequence opens the Create Boundary Layer form.

© Fluent Inc., Sep-04

7-45

Procedure

MODELING FLOW IN A TANK

a) Under Definition, retain the default Algorithm (Uniform).
b) Enter 7 in the First row text box.
This defines the height of the first row of elements normal to the edge.
c) Enter 0.88 in the Growth factor text box.
This sets the ratio of distances between consecutive rows of elements.
d) Move the slider box below Rows until the number of rows is equal to 8.
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This defines the total number of element rows. Notice that GAMBIT updates
the Depth automatically. The depth is the total height of the boundary layer.
e) Retain the default Transition pattern (1:1).
f) Select the edge shown in Figure 7-29 with the boundary layer on it. The boundary
layer should appear in the direction shown in Figure 7-29. If it does not, Shiftmiddle-click the edge to change the direction of the boundary layer.

Figure 7-29: Edge on which to apply the boundary layer, showing the direction in which
the boundary layer should point
g) Click Apply to apply the boundary layer to the edge.
2. Create boundary layers on the edges shown in Figure 7-30.
a) Under Definition, retain the default Algorithm (Uniform).
b) Enter 0.5 in the First row text box.
c) Enter 1.5 in the Growth factor text box.
d) Move the slider box below Rows until the number of rows is equal to 2.
e) Retain the default Transition pattern (1:1).
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f) Select the edges shown in Figure 7-30 with boundary layers on them. The
boundary layers should appear in the directions shown in Figure 7-30. If they do
not, Shift-middle-click an edge to change the direction of the boundary layer.

Figure 7-30: Edges on which to apply the boundary layers, showing the directions in
which the boundary layers should point
g) Click Apply to apply the boundary layers to the edges.
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3. Create boundary layers on the edges shown in Figure 7-31.
a) Enter 1 in the First row text box.
b) Retain 1.5 in the Growth factor text box.
c) Retain the Rows value (2).
d) Retain the default Transition pattern (1:1).
e) Select the edges shown in Figure 7-31 with boundary layers on them. The
boundary layers should appear in the directions shown in Figure 7-31. If they do
not, Shift-middle-click an edge to change the direction of the boundary layer.

Figure 7-31: Edges on which to apply the boundary layers, showing the directions in
which the boundary layers should point
f) Click Apply to apply the boundary layers to the edges.
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Step 12: Mesh One of the Volumes
1. Mesh the volume marked C in Figure 7-32.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select the volume marked C in Figure 7-32 in the graphics window.
GAMBIT will automatically select the Cooper Scheme in the Mesh Volumes
form. See the GAMBIT Modeling Guide for more information on the Cooper
meshing scheme.
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C

Figure 7-32: Volume to be meshed
b) Under Spacing, enter a value of 1 for the Interval size and click the Apply button at
the bottom of the Mesh Volumes form.
This accepts the volume you selected as the one to be meshed. It also accepts
the source faces (the faces whose surface mesh is to be swept through the
volume to form volume elements) GAMBIT has chosen for the Cooper meshing
scheme and starts the meshing. If you need to modify or confirm the source
faces, either pick faces from the graphics window or modify the selection of
source faces by means of the Sources face text box. The mesh for the volume is
shown in Figure 7-33.
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Figure 7-33: Mesh for volume C
It may be useful to remove the mesh from the display before you mesh the faces in
the next exercise; it is then easier to see the faces of the geometry. The mesh is not
deleted, just removed from the graphics window. To remove the mesh from the
display, click the SPECIFY DISPLAY ATTRIBUTES command button
at the
bottom of the Global Control toolpad. Select the Off radio button to the right of
Mesh near the bottom of the form and click Apply.
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Step 13: Mesh Some Faces
These faces are meshed to ensure a good mesh density around the pipes and mapped
meshes on some of the source faces. Some side faces also need to be meshed to assure
mesh matching between different source faces
1. Mesh the face marked A in Figure 7-34.
MESH

→ FACE

→ MESH FACES

This command sequence opens the Mesh Faces form.

a) Select the curved face marked A in Figure 7-34.
GAMBIT will automatically select the Submap Scheme in the Mesh Faces
form. See the GAMBIT Modeling Guide for more information on the Submap
meshing scheme.
b) Change the Interval size to 3 under Spacing and click the Apply button.
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A
C
D

Figure 7-34: Faces to be meshed
The face will be meshed as shown in Figure 7-35.

Figure 7-35: Mesh on face A
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2. Mesh the face marked B in Figure 7-34
a) Select the face marked B in Figure 7-34 in the graphics window.
On most platforms, GAMBIT will automatically select the Map meshing
scheme on the Mesh Faces form. If GAMBIT does not automatically select the
Map scheme, select it manually by means of the Scheme:Type option button.
b) Enter 1 as the Interval size, and click the Apply button at the bottom of the form.
The face will be meshed as shown in Figure 7-36.

Figure 7-36: Mesh on faces A and B
3. Mesh the face marked C in Figure 7-34
a) Select the face marked C in Figure 7-34 in the graphics window.
GAMBIT will automatically select the Submap Scheme in the Mesh Faces
form.
b) Enter an Interval size of 2.5, and click the Apply button at the bottom of the form.
The face will be meshed as shown in Figure 7-37.
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Figure 7-37: Mesh on faces A, B, and C
4. Mesh the face marked D in Figure 7-34.
a) Select the face marked D in Figure 7-34 in the graphics window.
GAMBIT will automatically select the Map Scheme in the Mesh Faces form.
b) Enter 1 as the Interval size, and click the Apply button at the bottom of the form.
The face will be meshed as shown in Figure 7-38.
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Figure 7-38: Mesh on faces A, B, C, and D
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Step 14: Modify Mesh Settings on Some Faces
”Modifying mesh settings” is the same as “applying without meshing”. This step
illustrates two different applications to this technique:
•

First, you will modify the scheme setting on two faces from Pave to Submap.
This is one way of making the main volume ready for Cooper meshing

•

Second, you will modify the default size of one of the source faces. In this case,
you allow the Cooper meshing scheme to make sure the mesh is matching with
other source faces.

1. Set the meshing scheme to be Submap for the faces marked F and G in Figure 7-39.

a) Select the faces marked F and G in Figure 7-39 in the graphics window.
b) Select Submap from the Scheme:Type option menu.
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F

Figure 7-39: Faces to be modified
c) Retain the default Interval size of 2 under Spacing.
d) Unselect the Mesh check box under Options.
You deselected the Mesh check box because at this point you do not want to
mesh the faces; you only want to apply the Scheme to the faces. GAMBIT will
mesh the faces using the Scheme you specified when it creates a volume mesh.
e) Click the Apply button at the bottom of the form.
2. Set the meshing size on the face marked H in Figure 7-40.
a) Select the face marked H in Figure 7-40 in the graphics window (the face at the
end of the pipe).
GAMBIT will automatically select the Pave Scheme in the Mesh Faces form.
See the GAMBIT Modeling Guide for more information on the Pave meshing
scheme.
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H

Figure 7-40: Face to be modified
b) Enter 1 as the Interval size under Spacing.
c) Ensure that Mesh is not selected under Options and click the Apply button at the
bottom of the form.
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Step 15: Mesh the Volumes
1. Mesh the volumes marked J and K in Figure 7-41.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select the volumes marked J and K in Figure 7-41 in the graphics window.
GAMBIT will automatically select the Cooper Scheme in the Mesh Volumes
form. See the GAMBIT Modeling Guide for more information on the Cooper
meshing scheme.
b) Enter 4 as the Interval size under Spacing in the Mesh Volumes form and click the
Apply button at the bottom of the form.
The volumes will be meshed as shown in Figure 7-42.
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K
L
J

Figure 7-41: Volumes to be meshed

Figure 7-42: Mesh on volumes J and K
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2. Mesh the volume marked L in Figure 7-41.
a) Select the volume marked L in Figure 7-41 in the graphics window.
GAMBIT will automatically select the Cooper Scheme in the Mesh Volumes
form.
b) Check that the Remove lower mesh and Remove old mesh check boxes are not
selected at the bottom of the form.
c) Click the Apply button again.
To view the final mesh, click the SPECIFY DISPLAY ATTRIBUTES command button
at the bottom of the Global Control toolpad. Select the Mesh:On and
Render:Hidden options near the bottom of the form, and click Apply. The final
volume mesh is shown in Figure 7-43.

Figure 7-43: Final volume mesh
(NOTE: The Hidden rendering option has been turned on in Figure 7-43 to
make the mesh easier to see.)
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3. You can view the mesh by shading it using the RENDER MODEL command button in
the Global Control toolpad
a) Hold down the right mouse button on the RENDER MODEL command button
and select

from the resulting list.

b) Rotate and translate the volume to view the mesh.
c) When you are finished, return to the wireframe view of the model, by selecting the
following command buttons in the Global Control toolpad:
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Step 16: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

a) Select Range under Display Type.
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When you select the Display Type:Range option on the Examine Mesh form,
GAMBIT displays the Show worst element option immediately below the
statistics displayed under the histogram. If you select the Show worst element
option, GAMBIT displays only the “worst” element as determined by the
current Quality Type quality metric.
b) Select the Show worst element option.
c) Click the FIT TO WINDOW command button
, at the top left of the Global
Control toolpad, to see where the worst element is located with respect to the
entire geometry.
d) Close the Examine Mesh form by clicking the Close button at the bottom of the
form.
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Step 17: Set Zone Types and Export the Mesh
1. Set boundary types for the complex pipe junction.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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It may be useful to remove the mesh from the display before you set the boundary
types; it is then easier to see the faces of the geometry. The mesh is not deleted,
just removed from the graphics window. To remove the mesh from the display,
click the SPECIFY DISPLAY ATTRIBUTES command button
at the bottom of
the Global Control toolpad. Select the Off radio button the right of Mesh near the
bottom of the form and click Apply.

a) Define an inlet.
i. Enter the name “inlet” in the Name text entry box.
ii. Select PLOT in the Type option menu.
iii. Check that Faces is selected as the Entity.
iv. Shift-left-click the face marked A in Figure 7-44 and accept the selection.

A

B

Figure 7-44: Faces to set as inlet, outlet, and wall boundaries
b) Define an outlet.
i. Enter the name “outlet” in the Name text entry box.
ii. Check that PLOT is still selected in the Type option menu.
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iii. Select the face marked B in Figure 7-44 and accept the selection.
c) Define symmetry boundary types for faces on the x-y plane.
You will pick the faces for this step using a GAMBIT picking procedure that
allows you to pick only entities that are completely within the picking box in
the graphics window.
i. Enter the name “symmetry” in the Name text entry box.
ii. Select PLOT in the Type option menu.
iii. Right-click the ORIENT MODEL command button at the lower left corner of the
Global Control pad and select the -X
in Figure 7-45.

option to orient the model as shown

Direction of
mouse drag

Graphics window
picking box

Figure 7-45: Model and picking box, -X view
iv. Shift-left-drag the mouse toward the upper right of the graphics window to
create the picking box shown in Figure 7-45.
Note that GAMBIT selects only the faces completely contained in the
picking box. If you Shift-left-drag the mouse toward the lower left of the
graphics window, GAMBIT selects all faces touched by the picking box.
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v. Accept the selection of the faces.
Note that you could also specify the remaining external faces of the tank
geometry as WALL boundaries. This is not necessary, however, because
when GAMBIT saves a mesh, any external faces (in 3-D) for which you
have not specified a boundary type will be written out as WALL boundaries
by default.
In addition, when GAMBIT writes a mesh, any volumes (in 3-D) for which
you have not specified a continuum type will be written as FLUID by
default. This means that you do not need to specify a continuum type in the
Specify Continuum Types form for this tutorial.
d) Select the Show colors option on the Specify Boundary Types form and manipulate
the model in the graphics window to display the manner in which GAMBIT
assigns colors to boundary types.
2. Export a mesh file.
a) Open the Export Mesh File form
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

i. Enter the File Name for the file to be exported (Tank.FDNEUT).
ii. Click Accept.
The grid file will be written to your working directory.
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3. Save the GAMBIT session and exit GAMBIT
a) Select Exit from the File menu.
File → Exit.

b) Click Yes to save the current session and exit GAMBIT.
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7.5 Summary
In this tutorial multiple primitive creations and Boolean operations were used to create the
full geometry. Decomposition was embedded in the creation. Edge meshing, boundary
layers and face meshing were used to control the mesh density, and type of mesh, in different areas of the model. The Cooper meshing scheme was used for all volumes.

7-72

© Fluent Inc., Sep-04

BASIC TURBO MODEL WITH UNSTRUCTURED MESH

8. BASIC TURBO MODEL WITH UNSTRUCTURED MESH
This tutorial employs a simple turbine blade configuration to illustrate the basic turbo
modeling functionality available in GAMBIT. It illustrates the steps and procedures
required for importing data that describes the turbo blade, creating a geometric model that
describes the flow region surrounding the blade, meshing the model, and exporting the
mesh. The example presented here uses 3-D boundary layers to control the shape of the
mesh in the regions immediately adjacent to the blade and employs an unstructured hexahedral mesh.
In this tutorial, you will learn how to:
•

Import a turbo data file

•

Create a turbo profile

•

Modify a turbo profile to affect the shape of a turbo volume

•

Create a turbo volume

•

Define turbo zones

•

Apply 3-D boundary layers to a turbo volume

•

Mesh a turbo volume

•

View a turbo volume mesh using both 3-D and 2-D perspectives

•

Export a turbo volume mesh

8.1 Prerequisites
Prior to reading and performing the steps outlined in this tutorial, you should familiarize
yourself with the steps, principles, and procedures described in Tutorials 1, 2, 3, and 4.
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8.2 Problem Description
Figure 8-1 shows the turbomachinery configuration to be modeled and meshed in this
tutorial. The configuration consists of a turbine rotor on which are affixed 60 identical
blades, each of which is spaced equidistant from the others on the rotor hub. Each blade
includes a concave (pressure) side and a convex (suction) side, and the rotor rotates
counterclockwise about the x-axis, extracting work from the fluid (air) as it flows between
the blades (see Figure 8-2).

Figure 8-1: 60-blade turbine rotor
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Outlet flow

Inlet flow

Figure 8-2: Turbine rotor blade configurations
The overall goal of this tutorial is to create a geometric model of the flow region immediately surrounding one of the turbo blades and to mesh the model using an unstructured
hexahedral mesh.
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8.3 Strategy
In general, the GAMBIT turbo modeling procedure includes seven basic steps:
1) Creating or importing edge data that describes the turbo profile
2) Creating the turbo profile
3) Creating the turbo volume
4) Assigning zone types to regions of the turbo volume
5) Decomposing the turbo volume
6) Meshing the turbo volume
7) Viewing the turbo volume
This tutorial illustrates six of the seven steps listed above. The tutorial excludes the turbo
decomposition step, because the turbo volume is to be meshed using unstructured hexahedral mesh elements. Turbo volume decomposition is primarily used to facilitate the creation of structured meshes (see Tutorial 9 in this guide).
NOTE: In this tutorial, the turbo-volume viewing operation (Step 7, above) is illustrated
in conjunction with the mesh examination step (see “Step 11:Examine the Mesh,” below).
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8.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/turbo_basic.tur

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “Basic_Turbo”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of solver affects the types of options available in the Specify Boundary
Types form (see “Step 12:Specify Zone Types,” below). For some systems,
FLUENT 5/6 is the default solver. The currently selected solver is shown at the top
of the GAMBIT GUI.
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Step 2: Import a Turbo Data File
Turbo data files contain information that GAMBIT uses to define the turbo profile
(see “Step 3:Create the Turbo Profile,” below). Such information includes: point data
that describes the shapes of the profile edges, edge-continuity data, and specification
of the rotational axis for the turbo volume.
1. Select the Import Turbo File option from the main menu bar.
File → Import → Turbo...
This command sequence opens the Import Turbo File form.

2. Click the Browse... button.
This action opens the Select File form.

8-6

© Fluent Inc., Sep-04

BASIC TURBO MODEL WITH UNSTRUCTURED MESH

Procedure

a) In the Files list, select turbo_basic.tur.
b) On the Select File form, click Accept.
3. On the Import Turbo File form, click Accept.
GAMBIT reads the information contained in the data file and constructs the set
of edges shown in Figure 8-3. The two straight edges shown in the figure describe
the hub and casing for the turbo volume. The two sets of curved edges constitute
cross sections of a single turbo blade.

Casing edge
Blade cross sections

Hub edge

Figure 8-3: Imported turbo geometry
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Step 3: Create the Turbo Profile
The turbo profile defines the basic characteristics of the turbo volume, including the
shapes of the hub, casing, and periodic (side) surfaces. In GAMBIT, the edges that
describe the hub, casing, and blade cross sections are defined by means of their inlet
endpoint vertices.
1. Specify the hub, casing, and blade-cross-section edges of the turbo profile.
TOOLS

→ TURBO

→ CREATE PROFILE

This command sequence opens the Create Turbo Profile form.

In this step, you will specify vertices that define the hub, casing, and blade crosssections. In addition, you will specify the axis of revolution for the turbo configuration. All instructions listed in this step refer to the vertex labels shown in Figure
8-4.
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D
Casing Inlet
B

Blade Tips

C
Hub Inlet
A

Figure 8-4: Vertices used to specify the turbo profile
a) Activate the Hub Inlet list box on the Create Turbo Profile form.
To activate an input field, such as a list box, on any GAMBIT specification
form, left-click in the input box located adjacent to the field label—in this
case, “Hub Inlet”. (By default, GAMBIT activates the Hub Inlet field when you
open the Create Turbo Profile form.)
b) Select vertex A.
c) Activate the Casing Inlet list box.
d) Select vertex B.
e) Specify the x axis as the axis of revolution for the turbo configuration.
i. Click the Axis:Define pushbutton.
This action opens the Vector Definition form.
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ii. Select the Direction:X-Positive option.
iii. On the Vector Definition form, click Apply.
f) Activate the Blade Tips list box.
g) Select vertex C.
h) Select vertex D.
!

The order in which the Blade Tips vertices are selected is important to the
definition of a turbo profile. Specifically, the Blade Tips vertices must be
selected in order from the hub cross section to the casing cross section.

i) Click Apply to accept the vertex selections and create the turbo profile.
GAMBIT creates the turbo profile shown in Figure 8-5.
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B

A
Rail edges
Rail edges

Medial edges

Figure 8-5: Turbo profile
The profile includes six new edges, four of which are real edges and two of which
are virtual edges. The four real edges are circular arc (“rail”) edges that are
formed by revolving the hub and casing endpoint vertices about the axis of revolution for the profile. The two virtual edges are “medial” edges, the centermost
shapes of which represent the mean shapes of the blade cross sections. The endpoint vertices of the medial edges are hosted by the rail edges, and the medial
edges are defined such that they pass through the leading and trailing vertices of
the blade cross sections. The medial edges define the shapes of the periodic surfaces on the turbo volume (see “Step 5:Create the Turbo Volume,” below).
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Step 4: Modify the Inlet and Outlet Vertex Locations
It is often useful to control the shape of the turbo volume such that its inlet and outlet
surfaces represent smooth flow transitions to and from the inlet and outlet ends,
respectively, of the turbo blade. In GAMBIT, you can control the shape of the turbo
volume by adjusting the positions of the medial-edge endpoint vertices prior to constructing the volume.
1. Open the Slide Virtual Vertex form.
TOOLS

→ TURBO

→ SLIDE VIRTUAL VERTEX

This command sequence opens the Slide Virtual Vertex form.

a) Select the inlet endpoint vertex of the medial edge for the casing blade cross
section (vertex A in Figure 8-5, above).
b) In the U Value field, enter the value 0.999.
As an alternative to entering a value in the U Value field, you can select the
vertex in the graphics window and drag it along its host rail edge until the U
Value field value is 0.999.
c) Retain the Move With Links (default) option.
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The Move With Links option specifies that GAMBIT is to apply the current Slide
Virtual Vertex specifications to all medial-edge inlet endpoint vertices in addition to the selected vertex.
d) Click Apply to accept the new position of the medial-edge inlet endpoint vertices.
e) Select the outlet endpoint vertex of the medial edge for the casing blade cross
section (vertex B).
f) In the U Value field, enter the value 0.019.
g) Retain the Move With Links (default) option.
h) Click Apply to accept the new position of the medial-edge outlet endpoint vertices.
The modified turbo profile appears as shown in Figure 8-6.

Figure 8-6: Turbo profile with modified inlet and outlet vertex locations
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Step 5: Create the Turbo Volume
A “turbo volume” is a 3-D region—which is defined by a set of one or more geometric volumes—that represents the flow environment surrounding the turbo blade. The
turbo volume characteristics are determined by the turbo profile and by specification
of the number of blades on the rotor (or angle between blades), the tip clearance, and
the number of spanwise sections. This example does not include a tip clearance but
does include spanwise sectioning.
1. Specify the pitch and number of spanwise sections for the turbo volume.
TOOLS

→ TURBO

→ CREATE TURBO VOLUME

This command sequence opens the Create Turbo Volume form.

a) In the Pitch text box, enter 60.
b) On the Pitch option button (located to the right of the Pitch text box), select the
Blade count option.
c) In the Spanwise Sections text box, enter 2.
d) Click Apply.
GAMBIT creates the turbo volume shown in Figure 8-7.

8-14

© Fluent Inc., Sep-04

BASIC TURBO MODEL WITH UNSTRUCTURED MESH

Procedure

Casing face

Outlet
faces

Inlet
faces

Hub face

Figure 8-7: Turbo volume—consisting of two geometric volumes
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Step 6: Define the Turbo Zones
This step standard zone types to surfaces of the turbo volume. The zone-type specifications determine which faces are linked for meshing. In addition, GAMBIT automatically associates turbo zone types to boundary zone definitions for some solvers.
1. Specify the faces that constitute the hub, casing, inlet, outlet of the turbo volume, as
well as the pressure and suction sides of the turbo blade.
TOOLS

→ TURBO

→ DEFINE TURBO ZONES

This command sequence opens the Define Turbo Zones form.

a) Activate the Hub list box.
b) Select the bottom (hub) face of the turbo volume (see Figure 8-7, above).
c) Activate the Casing list box.
d) Select the top (casing) face of the turbo volume.
e) Activate the Inlet list box.
f) Select the two inlet faces.
g) Activate the Outlet list box.
h) Select the two outlet faces.
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i) Activate the Pressure list box.
j) Select the six faces on the inner-curve (pressure side) of the turbo blade.
k) Activate the Suction list box.
l) Select the six faces on the outer-curve (suction side) of the turbo blade.
m) Click Apply to assign the turbo zone types.
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Step 7: Apply 3-D Boundary Layers
For turbo models, 3-D boundary layers allow you to ensure the creation of highquality mesh elements in regions adjacent to the turbo blade surfaces. Such boundary
layers are particularly useful when the turbo volume is to be meshed using an
unstructured meshing scheme.
1. Specify the hub, casing, and blade-cross-section edges of the turbo profile.
TOOLS

→ TURBO

→ CREATE/MODIFY BOUNDARY LAYERS

This command sequence opens the Create Boundary Layer form.
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a) In the First row text box, enter a value of 1.
b) In the Growth factor text box, enter a value of 1.2.
c) In the Rows text box, specify a value of 5, either by direct input of the value or by
sliding the Rows slider bar.
GAMBIT automatically calculates a Depth value of 7.4416, based on the First
row, Growth factor, and Rows specifications.
d) Select the Internal continuity option.
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e) In the Attachment input field, select the Faces option.
f) Activate the Faces list box, and select the 12 faces that comprise the pressure and
suction sides of the turbo blade.
g) Click Apply.
Figure 8-8 shows the 3-D boundary layers projected onto the three spanwise
surfaces of the turbo volume.

Figure 8-8: Turbo volume with 3-D boundary layers
By default, GAMBIT displays the boundary layers in the graphics window
unless they are made invisible by direct user action. The boundary layer display can make it difficult to view the model during subsequent steps in the
modeling process; therefore, it is advisable to render the boundary layers
invisible before continuing the tutorial.
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command button on the Global

This action opens the Specify Display Attributes form.

a) Select the B. Layers check box.
b) Select the Visible:Off option.
c) Click Apply.
GAMBIT turns off the display of the boundary layers.
d) Close the Specify Display Attributes form.
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Step 8: Mesh the Blade Cross-Section Edges
In this step, you will pre-mesh the edges that represent the blade cross sections,
thereby ensuring a finer mesh in proximity to the turbo blade surfaces than is created
in the bulk of the turbo volume.
1. Mesh the centermost pressure-side edges of the turbo blade.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

This command sequence opens the Mesh Edges form.

a) Activate the Edges list box, and select the three centermost edges on the pressure
side of the blade cross sections.
b) On the Grading:Type option button, retain Successive Ratio.
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c) In the Ratio input field, enter a value of 1.02.
d) Select the Double sided option.
When you select the Double sided option, GAMBIT changes the Ratio input
field to Ratio 1 and displays a field named Ratio 2 that contains a ratio specification identical to that of Ratio 1 (that is, 1.02).
e) On the Spacing option button, select Interval count.
f) In the Spacing text box, enter a value of 100.
g) Click Apply.
GAMBIT meshes the selected edges as shown in Figure 8-9. The Double sided
option with a ratio of 1.02 grades the edges such that mesh nodes are bunched
near the endpoint vertices of the edges.

Figure 8-9: Meshed centermost pressure-side edges of the turbo blade
2. Mesh the suction-side edges of the turbo blade.
a) Activate the Edges list box, and select the three centermost edges on the suction
side of the blade cross sections.
b) On the Grading:Type option button, retain Successive Ratio.
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c) In the Ratio input field, enter a value of 1.02.
d) Select the Double sided option.
e) On the Spacing option button, retain Interval count.
f) In the Spacing text box, enter a value of 110.
g) Click Apply.
3. Mesh the leading edges of the turbo blade.
a) Activate the Edges list box.
b) Select the six edges (two edges on each cross section) on either side of the leading
vertices for the top, middle, and bottom blade cross sections.
!

When selecting the edges, modify the edge senses, as necessary, such that
they point away from the leading vertices of the cross sections. When you
select an edge in the graphics window, GAMBIT automatically displays an
arrowhead in the middle of the edge to indicate the sense of the edge. To
change the sense of any selected edge, middle-click the edge. (NOTE: If the
sense-direction arrowhead is obscured by mesh nodes displayed on the edge,
set the Interval count to 1 while selecting edges for meshing.)

c) On the Grading:Type option button, retain Successive Ratio.
d) In the Ratio input field, enter a value of 1.05.
The single-sided meshing option with a ratio of 1.05 grades the edges such
that mesh nodes are bunched near the leading vertices of the edges—that is, in
the regions of highest curvature for the edges.
e) On the Spacing option button, retain Interval count.
f) In the Spacing text box, enter a value of 15.
g) Click Apply.
4. Mesh the trailing edges of the turbo blade.
a) Activate the Edges list box.
b) Select the six edges (two edges on each cross section) on either side of the trailing
vertices for the three blade cross sections.
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c) On the Grading:Type option button, retain Successive Ratio.
d) In the Ratio input field, enter a value of 1.
e) On the Spacing option button, retain Interval count.
f) In the Spacing text box, enter a value of 3.
g) Click Apply.
Figure 8-10 shows the final edge-mesh configuration for the turbo blade cross
sections.

Figure 8-10: Meshed edges of turbo blade cross sections
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Step 9: Mesh the Center Spanwise Face
To create an unstructured mesh for this example, it is best to pre-mesh the middle
spanwise face and to employ the middle face as a source face for a Cooper meshing
scheme applied to the two geometric volumes. The use of the middle face as a source
face ensures that the Cooper scheme produces a mesh with minimal distortion
throughout the turbo volume.
1. Mesh the center spanwise face of the turbo volume.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

R
This command sequence opens the Mesh Faces form.

a) Activate the Faces list box, and select the middle spanwise face.
GAMBIT automatically selects the Quad and Pave Scheme options based on
the face characteristics.
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b) On the Scheme:Elements option button, retain the Quad option.
c) On the Scheme:Type option button, retain the Pave option.
d) On the Spacing option button, select the Interval size option.
e) In the Spacing text box, enter a value of 5.
f) Click Apply.
GAMBIT meshes the middle spanwise face as shown in Figure 8-11.

Figure 8-11: Meshed center spanwise face
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Step 10: Mesh the Volumes
In this step, you will apply a Cooper meshing scheme to the two geometric volumes
that comprise the turbo volume.
1. Mesh the turbo volume.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

R
This command sequence opens the Mesh Volumes form.

a) Activate the Volumes list box, and select the both of the geometric volumes that
comprise the turbo volume.
GAMBIT automatically selects the Scheme:Elements:Hex/Wedge and Scheme:
Type:Cooper options for the selected volumes.
b) Retain the automatically selected Scheme options.
c) On the Spacing option button, select Interval size.
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d) In the Spacing text box, enter a value of 10.
e) Click Apply.
GAMBIT meshes the volumes as shown in Figure 8-12.

Figure 8-12: Meshed volumes
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Step 11: Examine the Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

The Examine Mesh form allows you to view various mesh characteristics for the
3-D mesh. For example, Figure 8-13 displays volume mesh elements for which the
EquiAngle Skew parameter is between 0.4 and 0.5 for this example.
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Figure 8-13: Hexahedral mesh elements—EquiAngle Skew = 0.4–0.5
The Examine Mesh command and options can be used in conjunction with the View
Turbo Volume command to view 2-D characteristics of the mesh on the hub,
casing, and spanwise surfaces. Such views are particularly useful when examining
the mesh on highly twisted blades.
2. Display the middle spanwise surface in a cascade turbo view.
TOOLS

→ TURBO

→ VIEW TURBO VOLUME

This command sequence opens the View Turbo Volume form.
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a) Select the Cascade surface:Spanwise option.
b) In the Spanwise text box, enter a value of 1.
The Cascade surface specifications described above specify a flattened, 2-D
display of the middle spanwise surface of the turbo volume.
c) Click Apply.
Figure 8-14 displays face mesh elements for which the EquiAngle Skew parameter
is between 0.1 and 0.3 for this example. (NOTE: To view the 2-D face elements
shown in Figure 8-14, select the Display Type: 2D Element option on the Examine
Mesh form, and specify the display of quadrilateral (

) elements.)

Figure 8-14: Quadrilateral mesh elements—EquiAngle Skew = 0.1–0.3
Figure 8-15 displays a zoomed view of the mesh in the region surrounding the
blade tip.
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Figure 8-15: Quadrilateral mesh elements—zoomed view near blade tip
d) Select the Off option and click Apply to turn off the cascade turbo view before
specifying zone types.
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Step 12: Specify Zone Types
You can use the Specify Boundary Types command to apply solver-specific boundary
zone specifications to surfaces of the turbo volume. For some solver options, including Fluent 5/6, GAMBIT automatically assigns such boundary zone specifications.
1. Check the automatically applied boundary zone types.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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Step 13: Export the Mesh and Exit GAMBIT
1. Export a mesh file.
a) Open the Export Mesh File form.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

i. Enter the File Name for the file to be exported—for example, the file name
“basic_turbo.msh”.
ii. Click Accept.
GAMBIT writes the mesh file to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
a) Select Exit from the File menu.
File → Exit
This action opens the Exit form.

b) Click Yes to save the current session and exit GAMBIT.
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8.5 Summary
This tutorial demonstrates the use of the basic turbo modeling operations available in
GAMBIT. The edge data that describes the geometry of the turbo profile was imported
from a turbo data file, and the completed turbo profile was adjusted to affect the shape of
the turbo volume. The turbo volume was divided into two spanwise sections, each of
which was meshed by means of a Cooper scheme that employed the common face between
them as a source face. Three-dimensional boundary layers were applied to the surfaces of
the turbo blade to ensure a high-quality mesh in proximity to the turbo blade. Finally, the
mesh examining capabilities in GAMBIT were used in conjunction with the turbo
viewing capability to examine the 2-D mesh on the middle spanwise face.
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9. LOW-SPEED CENTRIFUGAL COMPRESSOR
This tutorial employs the configuration of a low-speed, centrifugal compressor blade to
demonstrate the use of imported geometry and the turbo volume decomposition operation.
It illustrates how to adjust decomposition split points and employs a structured hexahedral
mesh.
In this tutorial, you will learn how to:
•

Create a turbo volume based on imported ACIS geometry

•

Decompose a turbo volume

9.1 Prerequisites
To understand this tutorial, you should review and understand the steps, principles, and
procedures outlined in Tutorials 1, 2, 3, 4, and 8.
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9.2 Problem Description
Figure 9-1 shows the turbomachinery configuration to be modeled and meshed in this
tutorial. The configuration represents the rotor of a low-speed centrifugal compressor
containing 20 identical, highly skewed blades, each of which is spaced equidistant from
the others on the rotor hub. The configuration is designed such that the angles of the inlet
and outlet flow directions are offset from each other by 90º.

Outlet flow

Inlet flow

Figure 9-1: Low-speed centrifugal compressor rotor

9-2

© Fluent Inc., Sep-04

LOW-SPEED CENTRIFUGAL COMPRESSOR

Strategy

9.3 Strategy
The GAMBIT turbo modeling procedure includes seven basic steps:
1) Creating or importing edge data that describes the turbo profile
2) Creating the turbo profile
3) Creating the turbo volume
4) Assigning zone types to regions of the turbo volume
5) Decomposing the turbo volume
6) Meshing the turbo volume
7) Viewing the turbo volume
This tutorial illustrates all of the steps listed above. In this example, the edge data that
describes the turbo profile is imported from an ACIS file, and edges of the turbo volume
are pre-split in the zone-type assignment step (Step 4) to facilitate decomposition (Step 5).
NOTE: In this tutorial, the turbo-volume viewing operation (Step 7, above) is illustrated
in conjunction with the mesh examination step (see “Step 10:Examine the Mesh,” below).
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9.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/lscc-smooth.sat

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “LS_Centrifugal_Comp”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of solver affects the types of options available in the Specify Boundary
Types form (see below). For some systems, FLUENT 5/6 is the default solver. The
currently selected solver is shown at the top of the GAMBIT GUI.
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Step 2: Import ACIS Geometry
To create a turbo model, GAMBIT requires the specification of a set of edges that
define the shapes of the turbo hub and casing and the cross-sectional shapes of the
turbo blade(s). In this tutorial, the edge specification data is imported from an ACIS
file.
1. Select the Import ACIS File option from the main menu bar.
File → Import → ACIS
This command sequence opens the Import ACIS File form.

2. Click the Browse... button.
This action opens the Select File form.

© Fluent Inc., Sep-04

9-5

Procedure

LOW-SPEED CENTRIFUGAL COMPRESSOR

a) In the Files list, select lscc-smooth.sat.
b) On the Select File form, click Accept.
3. On the Import ACIS File form, click Accept.
GAMBIT reads the information contained in the ACIS file and constructs the
geometry shown in Figure 9-2.
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Blade cross sections

Hub edge

Casing edge

Figure 9-2: Imported ACIS geometry for low-speed centrifugal compressor
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Step 3: Create the Turbo Profile
The turbo profile defines the basic characteristics of the turbo volume. In GAMBIT,
the edges that describe the hub, casing, and blade cross sections are defined by
means of their inlet endpoint vertices.
1. Specify the hub, casing, and blade-cross-section edges of the turbo profile.
TOOLS

→ TURBO

→ CREATE PROFILE

This command sequence opens the Create Turbo Profile form.

In this step, you will specify vertices that define the hub, casing, and blade crosssections. In addition, you will specify the axis of revolution for the turbo configuration. All instructions listed in this step refer to the vertex labels shown in Figure
9-3.
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C
Hub Inlet
A

D
Blade Tips

E

Casing Inlet
B

Figure 9-3: Vertices used to specify the turbo profile
a) Activate the Hub Inlet list box on the Create Turbo Profile form.
b) Select vertex A.
c) Activate the Casing Inlet list box.
d) Select vertex B.
e) Activate the Blade Tips list box.
f) Select (in order) vertices C, D, and E.
!

The order in which the Blade Tips vertices are selected is important to the
definition of a turbo profile. Specifically, the Blade Tips vertices must be
selected in order from hub to casing.

g) Click Apply to accept the vertex selections and create the turbo profile.
GAMBIT creates the turbo profile shown in Figure 9-4.
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B

A

Figure 9-4: Turbo profile for low-speed centrifugal compressor blade
The turbo profile for this tutorial includes six (real) rail edges and three (virtual)
medial edges, each of which corresponds to one of the turbo blade cross sections.
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Step 4: Modify the Inlet and Outlet Vertex Locations
It is often useful to control the shape of the turbo volume such that its inlet and outlet
surfaces represent smooth flow transitions to and from the inlet and outlet ends,
respectively, of the turbo blade. In GAMBIT, you can control the shape of the turbo
volume by adjusting the positions of the medial-edge endpoint vertices prior to constructing the volume.
1. Open the Slide Virtual Vertex form.
TOOLS

→ TURBO

→ SLIDE VIRTUAL VERTEX

This command sequence opens the Slide Virtual Vertex form.

a) Select the inlet endpoint vertex of the medial edge for the hub blade cross section
(vertex A in Figure 9-4, above).
b) In the U Value field, enter the value 0.962.
As an alternative to entering a value in the U Value field, you can select the
vertex in the graphics window and drag it along its host rail edge until the U
Value field value is 0.962.
c) Retain the (default) Move with links option.
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The Move with links option specifies that GAMBIT is to apply the current Slide
Virtual Vertex specifications to all medial-edge inlet endpoint vertices in addition to the selected vertex.
d) Click Apply to accept the new position of the medial-edge inlet endpoint vertices.
e) Select the outlet endpoint vertex of the medial edge for the casing blade cross
section (vertex B).
f) In the U Value field, enter the value 0.981.
g) Retain the Move with links option.
h) Click Apply to accept the new position of the medial-edge outlet endpoint vertices.
The modified turbo profile appears as shown in Figure 9-5.

Figure 9-5: Turbo profile with modified inlet and outlet vertex locations
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Step 5: Create the Turbo Volume
The turbo volume characteristics are determined by the turbo profile and by specification of the number of blades on the rotor (or angle between blades), the tip clearance, and the number of spanwise sections. This example does not include either a tip
clearance or spanwise sectioning.
1. Specify the pitch for the turbo volume.
TOOLS

→ TURBO

→ CREATE TURBO VOLUME

This command sequence opens the Create Turbo Volume form.

a) In the Pitch text box, enter 20.
b) On the Pitch option button (located to the right of the Pitch text box), select the
Blade count option.
c) In the Spanwise Sections text box, enter 1.
d) Click Apply.
Figure 9-6 shows the resulting turbo volume.
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suction side
Blade
pressure
side
Hub face

Inlet face

Casing face

Figure 9-6: Turbo volume for low-speed centrifugal compressor blade
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Step 6: Define the Turbo Zones
This step assigns standard zone types to surfaces of the turbo volume. The zone-type
specifications determine which faces are linked for meshing. In addition to assigning
zone types, this step employs pre-decomposition options that presplit periodic
surfaces in order to facilitate turbo volume decomposition (see “Step 8:Decompose
the Turbo Volume,” below).
1. Specify the faces that constitute the hub, casing, inlet, and outlet of the turbo volume,
as well as the pressure and suction sides of the turbo blade.
TOOLS

→ TURBO

→ DEFINE TURBO ZONES

This command sequence opens the Define Turbo Zones form.

a) Activate the Hub list box, and select the bottom (hub) face of the turbo volume.
b) Activate the Casing list box, and select the top (casing) face of the turbo volume.
c) Activate the Inlet list box, and select the inlet face of the turbo volume.
d) Activate the Outlet list box, and select the outlet face of the turbo volume.
e) Activate the Pressure list box, and select the front two faces (excluding the flat,
trailing-tip face) on the inner-curve (pressure side) of the turbo blade.
f) Activate the Suction list box, and select the front two faces (excluding the flat,
trailing-tip face) on the outer-curve (suction side) of the turbo blade.
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The flat edges on the trailing tips of the blade cross sections are not included
in the definitions of the pressure and suction surfaces; therefore, they will not
be merged into their respective surfaces in the decomposition step.
g) In the Pre-decompose section, select both the Link spanwise and Split edges options.
The Pre-decompose options specify that GAMBIT is to merge the pressure
and suction surfaces of the blade, link the spanwise (hub and casing) faces of
the turbo volume, and split the periodic edges of the hub and casing faces to
facilitate decomposition of the turbo volume. The split locations for the periodic faces are determined by a set of default variables that can be modified by
means of the Edit Defaults form (see Section 4.2.4 in the GAMBIT User’s
Guide).
h) Click Apply.
GAMBIT assigns the zone types and splits the blade and periodic edges as shown
in Figure 9-7.

F
E
A

D
B
C

Figure 9-7: Turbo volume with pre-decomposition splits
Because the flat trailing edges are not included in the pressure and suction
surface definitions, the sharp edges at the trailing tip of the edge are maintained
and are used for the turbo decomposition.
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Step 7: Adjust Edge Split Points
It is often useful to modify the default split-point locations prior to decomposing the
turbo volume. Such adjustments can facilitate success of the decomposition operation
and the creation of spanwise faces that can be meshed with high-quality elements.
You can adjust the split-point locations either before or after decomposition, but the
adjustment process is less time-consuming if it is performed prior to decomposition,
because it does not involve updating the face and volume configurations associated
with each adjustment.
In this step, you will adjust the turbo blade split points such that they are close to, but
not coincident with, the leading edge vertex.
1. Open the Slide Virtual Vertex form.
TOOLS

→ TURBO

→ SLIDE VIRTUAL VERTEX

This command sequence opens the Slide Virtual Vertex form.

a) Select the suction-side, upstream split-point vertex on the casing face turbo blade
cross section (vertex A in Figure 9-7, above).
b) In the U Value field, enter the value 0.003.
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As an alternative to entering a value in the U Value field, you can select the
vertex in the graphics window and drag it along its host rail edge until the U
Value field value is 0.003.
c) Retain the Move with links option.
The Move with links option specifies that GAMBIT is to apply the current Slide
Virtual Vertex specifications to all linked vertices in addition to the selected
vertex. In this case, the suction-side split-point vertex on the casing face turbo
blade cross section is linked to a corresponding vertex on the hub face turbo
blade cross section.
d) Click Apply to accept the new split-point location.
e) Select the pressure-side, upstream split-point vertex on the casing face turbo blade
cross section (vertex B).
f) In the U Value field, enter the value 0.997.
g) Click Apply to accept the new split-point location.
h) Select the pressure-side, upstream split-point vertex on the casing face periodic
edge (vertex C).
i) Unselect the Move with links option.
Because the leading edge of the blade is swept backwards from hub to casing,
it is appropriate to move this vertex independently of the corresponding hub
vertex (vertex D). This independent movement is accomplished by unselecting
the Move with links option. (NOTE: In all subsequent Slide Virtual Vertex
operations, the Move with links option will remain unselected.)
j) In the U Value field, enter the value 0.238.
k) Click Apply to accept the new split-point location.
l) Select the pressure-side, upstream split-point vertex on the hub face periodic edge
(vertex D).
m) In the U Value field, enter the value 0.812.
n) Click Apply to accept the new split-point location.
o) Select the pressure-side, downstream split-point vertex on the casing face periodic
edge (vertex E).
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p) In the U Value field, enter the value 0.812.
q) Click Apply to accept the new split-point location.
r) Select the pressure-side, downstream split-point vertex on the hub face periodic
edge (vertex F).
s) In the U Value field, enter the value 0.156.
t) Click Apply to accept the new split-point location.
Figure 9-8 shows the turbo volume configuration with the adjusted split points.

Figure 9-8: Turbo volume with adjusted split points
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Step 8: Decompose the Turbo Volume
The decomposition step splits the turbo volume into four geometric volumes the
topologies of which are suitable for the creation of structured hexahedral meshes.
1. Decompose the turbo volume.
TOOLS

→ TURBO

→ DECOMPOSE TURBO VOLUME

This command sequence opens the Decompose Turbo Volume form.

a) Retain the (default) Type:H option, and click Apply.
GAMBIT decomposes the volume as shown in Figure 9-9.

Figure 9-9: Decomposed turbo volume for low-speed centrifugal compressor
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Step 9: Mesh the Volumes
The decomposition step (above) automatically sets the interval count and grading on
the edges according to the turbo decomposition defaults. In addition, the decomposition sets face vertex types so that the volume is ready to mesh.
1. Mesh all of the volumes.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

R
This command sequence opens the Mesh Volumes form.

a) Activate the Volumes list box.
b) Select all four volumes.
GAMBIT automatically selects the Scheme:Elements:Hex and Scheme:Type:
Map options.
c) Retain the automatically selected Scheme options.
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d) On the Spacing option button, select Interval size.
e) In the Spacing text box, enter a value of 10.
f) Click Apply.
Figure 9-10 shows the final meshed turbo volume.

Figure 9-10: Meshed turbo volume for low-speed centrifugal compressor
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Step 10: Examine the Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.
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The Examine Mesh form allows you to view various mesh characteristics for the
3-D mesh. For example, Figure 9-11 displays hexahedral volume mesh elements
for which the EquiAngle Skew parameter is between 0.2 and 0.3 for this example.

Figure 9-11: Hexahedral mesh elements—EquiAngle Skew = 0.2–0.3
2. Display the casing surface in a cascade turbo view.
TOOLS

→ TURBO

→ VIEW TURBO VOLUME

This command sequence opens the View Turbo Volume form.
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a) Select the Cascade surface:Casing option.
The Cascade surface specifications described above specify a flattened, 2-D
display of the casing surface.
b) Click Apply.
Figure 9-12 displays an enlarged view of the quadrilateral face mesh elements
near the blade tip on the casing surface for this example. In this case, the mesh
elements are colored to represent the value of the EquiAngle Skew parameter.
(NOTE: To view the 2-D face elements shown in Figure 9-12, select the Display
Type: 2D Element option on the Examine Mesh form, and specify the display of
quadrilateral (

) elements.)

Figure 9-12: Quadrilateral mesh elements near blade tip—EquiAngle Skew = 0–1
c) Select the Off option and click Apply to turn off the cascade turbo view before
specifying zone types.
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Step 11: Specify Zone Types
You can use the Specify Boundary Types command to apply solver-specific boundary
zone specifications to surfaces of the turbo volume. For some solver options, including Fluent 5/6, GAMBIT automatically assigns such boundary zone specifications.
1. Check the automatically applied boundary zone types.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.
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Step 12: Export the Mesh and Exit GAMBIT
1. Export a mesh file.
a) Open the Export Mesh File form
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

i. Enter the File Name for the file to be exported—for example, “ls_cc.msh”.
ii. Click Accept.
GAMBIT writes the mesh file to your working directory.
2. Save the GAMBIT session and exit GAMBIT
a) Select Exit from the File menu.
File → Exit
This action opens the Exit form.

b) Click Yes to save the current session and exit GAMBIT.
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9.5 Summary
This tutorial demonstrates the use of ACIS geometry import and turbo decomposition
operations in GAMBIT turbo modeling. In this example, edge data imported from an
ACIS file were used to define a turbo profile, which, in turn, was used to create a turbo
volume representing the flow region surrounding one blade of a low-speed centrifugal
compressor. The turbo zones were assigned, the turbo volume was pre-split, and the splitpoint locations on the blade and periodic edges were adjusted to facilitate decomposition
and meshing. The final, decomposed turbo volume consisted of four volumes, each of
which could be meshed using a structured, hexahedral meshing scheme.
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10. MIXED-FLOW PUMP IMPELLER
This tutorial employs the configuration of a mixed-flow pump impeller to demonstrate the
use of hybrid hexahedral/tetrahedral meshing capabilities in conjunction with GAMBIT
turbo modeling. Such capabilities are particularly useful for meshing turbo models that
involve highly twisted blades.

10.1 Prerequisites
Prior to reading and performing the steps outlined in this tutorial, you should familiarize
yourself with the steps, principles, and procedures described in Tutorials 1, 2, 3, 4, and 8.
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10.2 Problem Description
Figure 10-1 shows the turbomachinery configuration to be modeled and meshed in this
tutorial. The configuration consists of an impeller rotor on which are affixed five identical
blades, each of which is spaced equidistant from the others on the rotor hub.

Figure 10-1: Mixed-flow impeller rotor
The overall goal of this tutorial is to create a geometric model of the flow region immediately surrounding one of the impeller blades and to mesh the model using hybrid hexahedral/tetrahedral mesh.
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10.3 Strategy
In general, the GAMBIT turbo modeling procedure includes seven basic steps:
1) Creating or importing edge data that describes the turbo profile
2) Creating the turbo profile
3) Creating the turbo volume
4) Assigning zone types to regions of the turbo volume
5) Decomposing the turbo volume
6) Meshing the turbo volume
7) Viewing the turbo volume
This tutorial illustrates six of the seven steps listed above. The tutorial excludes the turbo
decomposition step, because the bulk of the turbo volume is to be meshed using unstructured tetrahedral mesh elements. Turbo volume decomposition is primarily used to facilitate the creation of structured meshes (see Tutorial 9 in this guide).
NOTE: In this tutorial, the turbo-volume viewing operation (Step 7, above) is illustrated
in conjunction with the mesh examination step (see “Step 10:Examine the Mesh,” below).
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10.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/rotor-cyl-mod.tur

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “Pump_Impeller”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of solver affects the types of options available in the Specify
Boundary Types form (see below). For some systems, FLUENT 5/6 is the default
solver. The currently selected solver is shown at the top of the GAMBIT GUI.
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Step 2: Import a Turbo Data File
Turbo data files contain information that GAMBIT uses to define the turbo profile
(see “Step 3:Create the Turbo Profile,” below). Such information includes: point data
that describes the shapes of the profile edges, edge-continuity data, and specification
of the rotational axis for the turbo volume.
1. Select the Import Turbo File option from the main menu bar.
File → Import → Turbo...
This command sequence opens the Import Turbo File form.

2. Click the Browse... button.
This action opens the Select File form.
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a) In the Files list, select rotor-cyl-mod.tur.
b) On the Select File form, click Accept.
3. On the Import Turbo File form, click Accept.
GAMBIT reads the information contained in the data file and constructs the set
of edges shown in Figure 10-2. The two straight edges shown in the figure
describe the hub and casing for the turbo volume. The five sets of curved edges
constitute cross sections of a single impeller blade.
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Hub edge

Figure 10-2: Imported impeller geometry
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Step 3: Create the Turbo Profile
The turbo profile defines the basic characteristics of the turbo volume, including the
shapes of the hub, casing, and periodic (side) surfaces. In GAMBIT, the edges that
describe the hub, casing, and blade cross sections are defined by means of their inlet
endpoint vertices.
1. Specify the hub, casing, and blade-cross-section edges of the turbo profile.
TOOLS

→ TURBO

→ CREATE PROFILE

This command sequence opens the Create Turbo Profile form.

In this step, you will specify vertices that define the hub, casing, and blade crosssections. All instructions listed in this step refer to the vertex designations shown
in Figure 10-3.
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Figure 10-3: Vertices used to specify the turbo profile
a) Activate the Hub Inlet list box on the Create Turbo Profile form.
To activate an input field, such as a list box, on any GAMBIT specification
form, left-click in the input box located adjacent to the field label—in this
case, “Hub Inlet”. (By default, GAMBIT activates the Hub Inlet field when you
open the Create Turbo Profile form.)
b) Select vertex A.
c) Activate the Casing Inlet list box.
d) Select vertex B.
e) Activate the Blade Tips list box.
f) Select (in order) the following vertices: C, D, E, F, and G.
!

The order in which the Blade Tips vertices are selected is important to the
definition of a turbo profile. Specifically, the Blade Tips vertices must be
selected in order from the hub to the casing.

g) Click Apply to accept the vertex selections and create the turbo profile.
GAMBIT creates the turbo profile shown in Figure 10-4.
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B

A

Figure 10-4: Turbo profile
The turbo profile for this tutorial includes 10 (real) rail edges and five
(virtual) medial edges, each of which corresponds to one of the blade cross
sections.
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Step 4: Modify the Inlet and Outlet Vertex Locations
It is often useful to control the shape of the turbo volume such that its inlet and outlet
surfaces represent smooth flow transitions to and from the inlet and outlet ends,
respectively, of the turbo blade. In GAMBIT, you can control the shape of the turbo
volume by adjusting the positions of the medial-edge endpoint vertices prior to constructing the volume.
1. Open the Slide Virtual Vertex form.
TOOLS

→ TURBO

→ SLIDE VIRTUAL VERTEX

This command sequence opens the Slide Virtual Vertex form.

a) Select the inlet endpoint vertex of the medial edge for the upper blade cross
section (vertex A in Figure 10-4, above).
b) In the U Value field, enter the value 0.021.
As an alternative to entering a value in the U Value field, you can select the
vertex in the graphics window and drag it along its host rail edge until the U
Value field value is 0.021.
c) Retain the (default) Move with links option.
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The Move with links specifies that GAMBIT is to apply the current Slide Virtual
Vertex specifications to all medial-edge inlet endpoint vertices in addition to
the selected vertex.
d) Click Apply to accept the new position of the medial-edge inlet endpoint vertices.
e) Select the outlet endpoint vertex of the medial edge for the upper blade cross
section (vertex B).
f) In the U Value field, enter the value 0.703.
g) Retain the Move with links option.
h) Click Apply to accept the new position of the medial-edge outlet endpoint vertices.
The modified turbo profile appears as shown in Figure 10-5.

Figure 10-5: Turbo profile with modified inlet and outlet vertex locations
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Step 5: Create the Turbo Volume
The turbo volume characteristics are determined by the turbo profile and by specification of the number of blades on the rotor (or angle between blades), the tip clearance, and the number of spanwise sections. This example does not include either a tip
clearance or spanwise sectioning.
1. Specify the pitch for the turbo volume.
TOOLS

→ TURBO

→ CREATE TURBO VOLUME

This command sequence opens the Create Turbo Volume form.

a) In the Pitch text box, enter 5.
b) On the Pitch option button (located to the right of the Pitch text box), select the
Blade count option.
c) In the Spanwise Sections text box, enter 1.
d) Click Apply.
GAMBIT creates the turbo volume shown in Figure 10-6.
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Casing face

Outlet face

Hub face

Inlet face
Figure 10-6: Turbo volume for mixed-flow impeller blade
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Step 6: Define the Turbo Zones
This step standard zone types to surfaces of the turbo volume. The zone-type definitions determine which faces are linked for meshing. In addition, GAMBIT automatically associates turbo zone types to boundary zone definitions for some solvers.
1. Specify the faces that constitute the hub, casing, inlet, outlet of the turbo volume, as
well as the pressure and suction sides of the turbo blade.
TOOLS

→ TURBO

→ DEFINE TURBO ZONES

This command sequence opens the Define Turbo Zones form.

a) Activate the Hub list box, and select the bottom (hub) face of the turbo volume.
b) Activate the Casing list box, and select the top (casing) face of the turbo volume.
c) Activate the Inlet list box, and select the inlet face.
d) Activate the Outlet list box, and select the outlet face.
e) Activate the Pressure list box, and select the inner-curve (pressure side) face of
the turbo blade.
f) Activate the Suction list box, and select the outer-curve (suction side) face of the
turbo blade.
g) Click Apply to assign the turbo zone types.
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Step 7: Apply 3-D Boundary Layers
For turbo models, 3-D boundary layers allow you to ensure the creation of highquality mesh elements in regions adjacent to the turbo blade surfaces. Such boundary
layers are particularly useful when the turbo volume is to be meshed using an
unstructured meshing scheme.
1. Apply boundary layers to the faces of the turbo blade.
TOOLS

→ TURBO

→ CREATE/MODIFY BOUNDARY LAYERS

This command sequence opens the Create Boundary Layer form.
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a) In the First row text box, enter a value of 1.
b) In the Growth factor text box, enter a value of 1.2.
c) In the Rows text box, specify a value of 5, either by direct input of the value or by
sliding the Rows slider bar.
GAMBIT automatically calculates a Depth value of 7.4416, based on the First
row, Growth factor, and Rows specifications.
d) Select the Internal continuity option.
e) In the Attachment input field, select the Faces option.
f) Activate the Faces list box, and select the pressure and suction faces on the turbo
blade.
g) Click Apply.
Figure 10-7 shows the 3-D boundary layers projected onto the hub and casing
surfaces of the turbo volume.

Figure 10-7: Turbo volume with 3-D boundary layers
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By default, GAMBIT displays the boundary layers in the graphics window unless
they are made invisible by direct user action. The boundary layer display can
make it difficult to view the model during subsequent steps in the modeling
process; therefore, it is advisable to render the boundary layers invisible before
continuing the tutorial.
2. Select the SPECIFY DISPLAY ATTRIBUTES
Control toolpad.

command button on the Global

This action opens the Specify Display Attributes form.

a) Select the B. Layers check box.
b) Select the Visible:Off option.
c) Click Apply.
d) Click Close to close the Specify Display Attributes form.
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Step 8: Mesh the Pressure and Suction Faces
To grow hexahedral cells from the blade surfaces, it is necessary to pre-mesh them
using a Quad Map scheme.
1. Mesh the pressure and suction surfaces of the turbo blade.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

R
This command sequence opens the Mesh Faces form.

a) Activate the Faces list box, and select the pressure and suction faces on the turbo
blade.
GAMBIT automatically selects the Quad and Map Scheme options based on
the face characteristics.
b) Retain the automatically selected Scheme options.
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c) On the Spacing option button, select the Interval size option.
d) In the Spacing text box, enter a value of 5.
e) Click Apply.
GAMBIT meshes the pressure and suction faces as shown in Figure 10-8.

Figure 10-8: Meshed faces of the impeller blade
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Step 9: Mesh the Volume
In this step, you will mesh the turbo volume using a hybrid scheme that employs
hexahedral elements near the blade surface and tetrahedral elements in the bulk of
the volume.
1. Mesh the turbo volume.
TOOLS

→ TURBO

→ MESH EDGES/FACES/VOLUMES

R
This command sequence opens the Mesh Volumes form.

a) Activate the Volumes list box, and select the geometric volume that comprises the
turbo volume.
b) On the Scheme:Elements option button, select Tet/Hybrid.
c) On the Scheme:Type option button, select Tgrid.
d) On the Spacing option button, select Interval size.
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e) In the Spacing text box, enter a value of 6.
f) Click Apply.
GAMBIT meshes the volume as shown in Figure 10-9.

Figure 10-9: Meshed turbo volume for mixed-flow impeller blade
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Step 10: Examine the Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.
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The Examine Mesh form allows you to view various mesh characteristics for the 3D mesh. For example, Figure 10-10, Figure 10-11, and Figure 10-12 display
hexahedral, pyramidal, and tetrahedral volume mesh elements, respectively, for
which the EquiAngle Skew parameter is between 0.2 and 0.3. In this case, the
hexahedral elements (Figure 10-10) result from the imposition of the 3-D
boundary layer and are confined to the region immediately adjacent to the
impeller blade. The pyramidal elements (Figure 10-11) constitute a single
transition layer between the hexahedral and tetrahedral (Figure 10-12) elements.

Figure 10-10: Hexahedral mesh elements—EquiAngle Skew = 0.2–0.3
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Figure 10-11: Pyramidal mesh elements—EquiAngle Skew = 0.2–0.3

Figure 10-12: Tetrahedral mesh elements—EquiAngle Skew = 0.2–0.3

© Fluent Inc., Sep-04

10-25

Procedure

MIXED-FLOW PUMP IMPELLER

The Examine Mesh command and options can be used in conjunction with the View
Turbo Volume command to view 2-D characteristics of the mesh on the hub and
casing surfaces. Such views are particularly useful when examining the mesh on
highly twisted blades.
2. Display the casing surface in a cascade turbo view.
TOOLS

→ TURBO

→ VIEW TURBO VOLUME

This command sequence opens the View Turbo Volume form.

a) Select the Cascade surface:Spanwise option.
The Cascade surface specifications described above specify a flattened, 2-D
display of the middle spanwise surface of the turbo volume.
b) Click Apply.
Figure 10-13 displays an enlarged view of casing-surface face mesh elements for
which the EquiAngle Skew parameter is between 0.1 and 0.6 in the region surrounding the impeller outlet tip. (NOTE: To view the 2-D face elements shown in
Figure 10-13, select the Display Type: 2D Element option on the Examine Mesh
form, and specify the display of both quadrilateral (
elements.)
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Figure 10-13: Casing-surface face mesh elements—EquiAngle Skew = 0.1–0.6
c) Select the Off option and click Apply to turn off the cascade turbo view before
specifying zone types.
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Step 11: Specify or Check Zone Types
For some Solver options, including the Fluent 5/6 option used in this tutorial,
GAMBIT automatically assigns boundary zone specifications to the turbo volume
faces when you define the turbo zones (see Step 6: Define the Turbo Zones). You can
check such specifications and/or apply solver-specific boundary specifications (for
cases in which they are not automatically applied) by means of the Specify Boundary
Types form. It is useful to turn off the mesh display before checking and/or applying
the boundary zone specifications.

1. Select the SPECIFY DISPLAY ATTRIBUTES
Control toolpad.

command button on the Global

This action opens the Specify Display Attributes form.

a) Select the Mesh:Off option.
b) Click Apply.
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c) Click Close to close the Specify Display Attributes form.
2. Check the automatically applied boundary zone types.
ZONES

→ SPECIFY BOUNDARY TYPES

This command sequence opens the Specify Boundary Types form.

If you select the Show labels option, GAMBIT displays labels in the graphics
window for all of the assigned boundary zones. If you select the Show colors
option, GAMBIT shades and colors the faces for which boundary zones have
been defined.
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Step 12: Export the Mesh and Exit GAMBIT
1. Export a mesh file.
a) Open the Export Mesh File form
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

i. Enter the File Name for the file to be exported—for example, the file name
“pump_impeller.msh”.
ii. Click Accept.
GAMBIT writes the mesh file to your working directory.
2. Save the GAMBIT session and exit GAMBIT
a) Select Exit from the File menu.
File → Exit
This action opens the Exit form.

b) Click Yes to save the current session and exit GAMBIT.
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10.5 Summary
This tutorial demonstrates the use of the GAMBIT turbo modeling operations as applied
to a mixed-flow pump impeller. In this case, 3-D boundary layers were applied to the
impeller faces, and the bulk of the turbo volume was meshed using tetrahedral elements.
As a result, the meshed turbo volume contained three volume element types: hexahedral
(in the region adjacent to the impeller blade), pyramidal (a single transition layer), and
tetrahedral (in the bulk of the turbo volume).
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11. INDUSTRIAL DRILL BIT—STEP GEOMETRY
This tutorial employs a model of an industrial drill bit to illustrate GAMBIT operations
that allow you to import and clean up STEP geometry, modify the model to suppress features that can adversely affect meshing, and control mesh quality. The STEP data file that
describes the drill-bit geometry used in this tutorial was created by means of an external
CAD package.
In this tutorial, you will learn how to:
•

Import STEP geometry

•

Employ GAMBIT cleanup operations to clean up imported geometry and suppress
model features that inhibit meshing

•

Create and apply size functions to control mesh quality

NOTE: You can reproduce the perspectives of the figures in this tutorial by means of
window matrix commands available in a journal file named “tg11_figures.jou,”
which is included in the “help/tutfiles” online help directory. To exactly reproduce
the perspective of any figure, you can open the journal file and execute the window
matrix command associated with the figure. For example, the following command reproduces the perspective of the model shown in Figure 11-3.
window matrix 1 entries \
0.8298196196556
0.1376460045576
-0.98521900177
-0.3953186273575
-0.3955990076065 -0.0812062472105
0.5420601963997
0.742325425148
-12.15634346008
12.11377906799
15.50736236572
-22.28459358215

-0.5407903790474
0.828989803791
0.3938567638397
-3.794617891312
-4.06431388855
22.28459358215

\
\
\
\
\

11.1 Prerequisites
Prior to reading and performing the steps outlined in this tutorial, you should familiarize
yourself with the steps, principles, and procedures described in Tutorials 1, 2, 3, and 4.
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11.2 Problem Description
Figure 11-1 and Figure 11-2 show the drill-bit configuration to be modeled and meshed in
this tutorial. Figure 11-1 shows the full model, including the outer face that circumscribes
the internal components. Figure 11-2 shows the internal components, themselves.

Figure 11-1: Industrial drill bit configuration—full model
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Figure 11-2: Industrial drill bit configuration—internal components
The goals of this tutorial are:
•

To import the model by means of a STEP data file

•

To use the GAMBIT cleanup tools to identify and eliminate short edges and small
faces that can adversely affect meshing

•

To mesh the model using unstructured, tetrahedral mesh elements the quality of
which is controlled by means of size functions

This tutorial, in conjunction with Tutorial 12, also illustrates the differences between geometry import by means of STEP data files and direct CAD geometry import. Specifically,
Tutorial 12 employs a model identical to that shown above but imports the data directly,
as a “part” file, from the CAD program that was used to create the drill-bit geometry.
(NOTE: The geometry for this example was created by means of the Pro/ENGINEER
CAD program.)
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11.3 Strategy
The general strategy employed in this tutorial is as follows:
1) Import a STEP file that describes the drill-bit geometry.
2) Use the GAMBIT cleanup tools to identify and eliminate very short edges and
small faces that can adversely affect meshing.
3) Apply size functions to control mesh quality.
4) Mesh the model.
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11.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/drill_bit.stp

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “Drill_Bit_STEP”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of solver affects the types of options available in the Specify
Boundary Types form. For some systems, FLUENT 5/6 is the default solver. The
currently selected solver is shown at the top of the GAMBIT GUI.
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Step 2: Import a STEP File
STEP data files contain geometry data formatted according to a set of industry
standards. For this tutorial, the STEP data file was created using the Pro/ENGINEER
CAD program.
1. Select the Import STEP File option from the main menu bar.
File → Import → STEP...
This command sequence opens the Import STEP File form.

2. Click the Browse... button.
This action opens the Select File form.
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a) In the Files list, select drill_bit.stp.
b) On the Select File form, click Accept.
3. On the Import STEP File form, click Accept.
GAMBIT reads the information contained in the data file and constructs the
geometry shown in Figure 11-3.
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Figure 11-3: Industrial drill bit—imported STEP geometry
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Step 3: Merge Faces and Edges to Suppress Model Features
It is often useful to use the face and edge merging operations available in GAMBIT
to suppress model features that would otherwise inhibit the meshing. In this step, you
will use a global face-merge operation to suppress such features.
1. Perform a global face-merge operation.
GEOMETRY

→ FACE

→ SPLIT/MERGE/COLLAPSE/SIMPLIFY FACES

R
This command sequence opens the Merge Faces (Virtual) form.

a) On the Type option subset, select the Virtual (Tolerance) option.
b) On the Faces pick-list option button, select All.
c) In the Min. Angle text box, input 160.
d) Retain the Merge edges option.
e) Click Apply to merge the faces.
GAMBIT merges the faces to create the model as shown in Figure 11-4.
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Figure 11-4: Model with merged faces
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Step 4: Use Cleanup Tools to Check and Clean Up Geometry
GAMBIT cleanup tools allow you to easily identify and eliminate individual model
features that can inhibit meshing. In this step, you will use the cleanup tools to check
for the existence of “holes” and “cracks” in the model and to eliminate small faces.
1. Check for the existence of holes in the model.
“Holes” in the model are internal edge loops that do not constitute face
boundaries.
TOOLS

→ CLEANUP

→ CLEAN UP HOLES

This command sequence opens the Clean Up Holes form.

a) Click the Update pushbutton located on the right side of the Items list heading.
In this case, GAMBIT does not populate the Items list, because no holes exist
in the model.
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2. Check for the existence of cracks in the model.
For the purposes of the geometry cleanup operations, a “crack” is defined as a
geometry consisting of an edge pair that meets the following criteria:

TOOLS

•

Each edge in the pair serves as a boundary edge for a separate face.

•

The edges share common endpoint vertices at one or both ends.

•

The edges are separated along their lengths by a small gap.

→ CLEANUP

→ CLEAN UP CRACKS

This command sequence opens the Clean Up Cracks form.

a) Click the Default pushbutton located on the right side of the Maximum angle text
box.
GAMBIT displays the default Maximum angle criterion and automatically
populates the Items list with all cracks existing in the model. In this case,
GAMBIT does not populate the Items list, because no cracks exist in the
model.
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3. Clean up small faces in the model.
In this substep, you will use the Clean Up Small Faces form to identify and
eliminate individual small faces that can adversely affect meshing operations.
TOOLS

→ CLEANUP

→ CLEAN UP SMALL FACES

This command sequence opens the Clean Up Small Faces form.

a) Click the Default pushbutton located on the right side of the Maximum area text
box.
When you click the Default pushbutton, GAMBIT displays the Maximum area of
faces to be included in the Items list and populates the Items list with all faces
in the Cleanup domain that meet the Maximum area criterion. By default, the
Maximum area value is 100 times greater than the area of the smallest face in
the Cleanup Domain.
Figure 11-5 shows the three smallest faces in the model, all of which lie at the
base of the main drill-bit shaft. These three faces correspond to the first three
faces listed in the Items list.
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A

C

B

Figure 11-5: Three smallest faces in the model
b) Select the first face in the Items list.
GAMBIT displays the area of the selected face in the Current area field
located below the Items list and highlights the selected face (face A in Figure
11-5) in the graphics window.
The Clean Up Small Faces form provides two Method options for eliminating
faces—Collapse face and Merge face. In this case, GAMBIT automatically
selects the Merge face option and populates the Faces to merge pick list with
suggested faces to merge.
c) Click the A/N pushbutton in the vertical array of pushbuttons located to the right of
the Items list.
The A/N (“Apply/Next”) pushbutton removes the currently selected face from
the model then updates the Items list and automatically selects the next
smallest face in the Cleanup domain. In this case, GAMBIT eliminates the
selected face and automatically selects the next smallest face (face B in Figure
11-5).
d) Click A/N again to eliminate the next smallest face in the Cleanup domain.
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GAMBIT eliminates the selected face and automatically highlights the next
smallest face (face C in Figure 11-5).
e) Click Apply to eliminate the third smallest face in the Cleanup domain.
Figure 11-6 shows the geometry in the region of the three smallest faces after
their removal from the model.

Figure 11-6: Base of main shaft with three smallest faces cleaned up
Having eliminated the three small, ovoid faces at the base of the main shaft,
you will now remove four small, rectangular faces that serve as lips to other,
larger faces (see Figure 11-7).
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D

G

F

E
Figure 11-7: Small, rectangular lip faces
f) Select the first face in the Items list.
GAMBIT highlights and zooms in on the smallest of the rectangular lip faces
(face D in Figure 11-7) and automatically selects the Merge faces option and
populates the Faces to merge pick list with suggested faces to merge.
g) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face E in Figure 11-7).
h) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face F in Figure 11-7).
i) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face G in Figure 11-7).
j) Click Apply to eliminate the last of the lip faces.
After cleanup of the last lip face, the Items list still contains a list of small
faces; however, the remaining faces are not small enough to adversely affect
meshing operations.
Figure 11-8 shows the final, cleaned-up geometry for the drill-bit model.
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Figure 11-8: Final, cleaned-up model geometry
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Step 5: Apply Size Functions to Control Mesh Quality
Highly skewed elements adversely affect numerical computations for which the mesh
is created. GAMBIT includes several features that allow you to control the mesh, one
of which is the application of size functions. For example, size functions can be used
to specify the rate at which volume mesh elements change in size in proximity to a
specified boundary. In this step, you will apply size functions to four faces of the drillbit geometry and, thereby, control the size of the nearby mesh elements to eliminate
the skewed elements.
1. Specify a size function and apply it to four faces of the model.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.

a) Retain the Type:Fixed option.
(NOTE: In addition to the “fixed” size function illustrated in this tutorial,
GAMBIT provides “curvature,” “proximity,” and “meshed” size functions.
Curvature and proximity size functions are useful for controlling the mesh in
regions of high curvature and small gaps, respectively. Meshed size functions
use existing meshes to determine the size-function start size. See Section 5.2.2
of the GAMBIT Modeling Guide.)
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b) On the Entities:Source option button, select the Faces option.
c) In the Faces list box, select the four faces shown (shaded) in Figure 11-9.

Figure 11-9: Faces on which to apply size functions
d) On the Entities:Attachment option button, select the Volumes option.
e) In the Volumes list box, select the volume.
f) In the Start size text box, enter the value 0.035.
g) In the Growth rate text box, enter the value, 1.2.
h) In the Size limit text box, enter the value, 0.4.
i) Click Apply to create the size function.
When applying the size function, GAMBIT displays a message in the
Transcript window indicating that the use of virtual entities as source entities
in the size-function definition can cause problems when evaluated during
background-grid generation. The message represents a warning only and can
be ignored in this case. GAMBIT allows you to view the size function by
means of the View Size Function command on the Size Function toolpad.
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Step 6: Mesh the Volume
After the imported geometry is cleaned up and the size-function is created and
attached, you can mesh the geometry using an unstructured, tetrahedral mesh.
1. Mesh the drill-bit volume.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Activate the Volumes list box.
b) Select the volume.
GAMBIT automatically selects the Scheme:Elements:Tet/Hybrid and Scheme:
Type:TGrid options.
c) Retain the automatically selected Scheme options.
d) On the Spacing option button, retain the Interval size option.
e) In the Spacing text box, retain the default value of 1.
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The size function you attached to the volume in the previous step will override
the Spacing specifications.
f) Click Apply.
Figure 11-10 shows the final meshed volume.

Figure 11-10: Meshed drill-bit volume
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Step 7: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

11-22

© Fluent Inc., Sep-04

INDUSTRIAL DRILL BIT—STEP GEOMETRY

Procedure

a) Select Range under Display Type at the top of the form.
The 3D Element type selected by default at the top of the form is a brick
.
You will not see any mesh elements in the graphics window when you first
open the Examine Mesh form, because there are no hexahedral elements in the
mesh.
b) Left-click the tetrahedron icon

next to 3D Element near the top of the form.

The tetrahedral mesh elements will now be visible in the graphics window.
c) Select or retain EquiAngle Skew from the Quality Type option menu.
d) Left-click the histogram bars that appear at the bottom of the Examine Mesh form
to highlight elements in any given quality range.
Figure 11-11 shows the graphics window that results for elements with
EquiAngle Skew values between 0.5 and 0.6.

Figure 11-11: Elements with EquiAngle Skew values between 0.5 and 0.6
e) On the Examine Mesh form, click Close to close the form.
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Step 8: Export the Mesh and Exit GAMBIT
1. Export a mesh file.
a) Open the Export Mesh File form
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

i. Enter the File Name for the file to be exported—for example, the file name
“drill_bit_step.msh”.
ii. Click Accept.
GAMBIT writes the mesh file to your working directory.
2. Save the GAMBIT session and exit GAMBIT
a) Select Exit from the File menu.
File → Exit
This command sequence opens the Exit form.

b) Click Yes to save the current session and exit GAMBIT.
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11.5 Summary
This tutorial demonstrates the importation of CAD geometry by means of a STEP data file
and the operations that are sometimes required to clean up such geometry and render it
suitable to GAMBIT meshing operations. In this case, the application of size functions
prevented the creation of skewed elements during meshing.
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12. INDUSTRIAL DRILL BIT—DIRECT CAD IMPORT
This tutorial employs the industrial drill-bit model described in Tutorial 12 to illustrate the
advantages of importing geometry directly from a CAD program rather than importing the
geometry by means of an intermediate (STEP) file. The directly imported geometry does
not include the very short edges that required elimination in Tutorial 12, however, it does
include some small faces that must be merged to facilitate meshing.
In this tutorial, you will learn how to:
•

Import geometry directly from the Pro/ENGINEER CAD program

•

Use the GAMBIT cleanup tools to identify and eliminate geometry features that
can adversely affect meshing operations

NOTE (1): The capability of direct geometry import from the Pro/ENGINEER program
requires a special GAMBIT license. Without the license, GAMBIT cannot open a database that includes directly imported CAD geometry.
NOTE (2): You can reproduce the perspectives of the figures in this tutorial by means of
window matrix commands available in a journal file named “tg12_figures.jou,”
which is included in the “help/tutfiles” online help directory. To exactly reproduce

the perspective of any figure, you must open the journal file and execute the window
matrix command associated with the figure. For example, the following command reproduces the perspective of the model shown in Figure 12-3.
window matrix 1 entries \
0.8298196196556
0.1376460045576
-0.98521900177
-0.3953186273575
-0.3955990076065 -0.0812062472105
0.5420601963997
0.742325425148
-12.15634346008
12.11377906799
15.50736236572
-22.28459358215

-0.5407903790474
0.828989803791
0.3938567638397
-3.794617891312
-4.06431388855
22.28459358215

\
\
\
\
\

12.1 Prerequisites
Prior to reading and performing the steps outlined in this tutorial, you should familiarize
yourself with the steps, principles, and procedures described in Tutorials 1, 2, 3, 4, 8, and
11.
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12.2 Problem Description
Figure 12-1 and Figure 12-2 show the drill-bit configuration to be modeled and meshed in
this tutorial. Figure 12-1 shows the full model, including the outer face that circumscribes
the internal components. Figure 12-2 shows the internal components, themselves. The
model shown in these figures is identical to that described in Tutorial 11.

Figure 12-1: Industrial drill bit configuration—full model
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Figure 12-2: Industrial drill bit configuration—internal components
The goals of this tutorial are:
•

To directly import the drill-bit geometry from the Pro/ENGINEER CAD program

•

To use GAMBIT cleanup operations to render the model suitable for meshing

•

To mesh the model using unstructured, tetrahedral mesh elements the quality of
which is controlled by means of size functions

This tutorial, in conjunction with Tutorial 11, also illustrates the differences between
direct CAD geometry import and geometry import by means of STEP data files.
Specifically, this tutorial imports the data directly from the Pro/ENGINEER program as a
“part” file. Consequently, the imported geometry does not include the very short edges
that otherwise complicate meshing (see Tutorial 11).
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12.3 Strategy
The general strategy employed in this tutorial is as follows:
1) Start the Pro/ENGINEER program.
2) Launch GAMBIT from within Pro/ENGINEER.
3) Import to GAMBIT a Pro/ENGINEER part file that describes the drill-bit
geometry.
4) Use GAMBIT cleanup operations to eliminate a few small faces that would
otherwise complicate meshing.
5) Apply size functions to control mesh quality.
6) Mesh the model.
The operations involved in items 4–6, above, are nearly identical to those described in
Steps 4–6 of Tutorial 11.
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12.4 Procedure
Step 1: Start Pro/ENGINEER
1. In a terminal window, enter
gambit -id Drill_Bit_ProE –proe proe_startup_command

where proe_startup_command is the system-specific command to start Pro/ENGINEER.
This command starts Pro/ENGINEER and displays the Pro/ENGINEER user
interface.
!

GAMBIT is available only in a 32-bit version; therefore, the Pro/ENGINEER
version used for direct CAD import must also be 32-bit.
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Step 2: Start GAMBIT from within Pro/ENGINEER
1. Start GAMBIT and make it available as an option on the Pro/ENGINEER main menu.
a) Open the Pro/ENGINEER Auxiliary Applications form.
Tools → Auxiliary Applications…
This command sequence opens the Pro/ENGINEER Auxiliary Applications form.

i. In the list of available auxiliary applications, select gambit, and click Start.
Pro/ENGINEER starts GAMBIT and displays a new option—titled,
Gambit—on the Pro/ENGINEER main menu. Pro/ENGINEER also
displays the message, “Application ‘gambit’ started successfully,” to
indicate the successful launch of the GAMBIT program.
ii. Click Close to close the Auxiliary Applications form.
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Step 3: Open the Part File
1. Open the Pro/ENGINEER part file.
a) Open the Pro/ENGINEER part file that describes the drill bit geometry.
File → Open…
This command sequence opens the Pro/ENGINEER File Open form.

i. In the file list, select drill_bit.prt, and click Open.
Pro/ENGINEER opens the part file and displays it in the Pro/ENGINEER
GUI graphics window.
!

You cannot operate on parts or assemblies from within Pro/ENGINEER while GAMBIT is running.
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Step 4: Display the GAMBIT User Interface
1. Display the GAMBIT graphical user interface.
a) On the Pro/ENGINEER main menu, start the GAMBIT interface.
Gambit → Start
Pro/ENGINEER replaces its foreground user interface with that of GAMBIT
and remains operational in the background.
It is possible to switch between Pro/ENGINEER and GAMBIT operation
while GAMBIT is running.
•

To switch from GAMBIT to Pro/ENGINEER, you must exit GAMBIT
by means of the File/Close option on the GAMBIT main menu bar.
When you exit GAMBIT in this manner, the GAMBIT window is
iconized, and GAMBIT continues to run until you end its execution
from within Pro/ENGINEER.

•

To switch from Pro/ENGINEER to GAMBIT, select the Gambit→Start
option on the Pro/ENGINEER main menu bar.

To ensure that any GAMBIT operations are preserved when switching back
and forth between GAMBIT and Pro/ENGINEER, it is advisable to save the
GAMBIT database before switching from GAMBIT to Pro/ENGINEER
operation.
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Step 5: Select the Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of solver affects the types of options available in the Specify
Boundary Types form. For some systems, FLUENT 5/6 is the default solver. The
currently selected solver is shown at the top of the GAMBIT GUI.
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Step 6: Import the CAD Geometry
In this step, you will directly import the drill-bit geometry from Pro/ENGINEER.
GAMBIT designates the imported geometry as “CAD” geometry, and assigns its
components a “c_” prefix—for example, c_face.123.
!

To import geometry directly from Pro/ENGINEER to GAMBIT, you must have a
special GAMBIT license. Without the license, GAMBIT cannot open a database
that includes directly-imported CAD geometry.

1. Select the Import CAD Geometry option from the GAMBIT main menu bar.
File → Import → CAD...
This command sequence opens the Import CAD Geometry form.

a) On the CAD Option option button, select the Pro/ENGINEER (DIRECT) option.
b) On the Component option button, select the DRILL_BIT.PRT option.
The Component option button includes all part files that are currently open in
Pro/ENGINEER.
2. On the Import CAD Geometry form, click Accept.
GAMBIT imports the part file and displays the geometry shown in Figure 12-3.
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Figure 12-3: Industrial drill bit—directly imported Pro/ENGINEER part file
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Step 7: Merge Faces and Edges to Suppress Model Features
As a first step in improving the meshing characteristics of the model, you will perform
global face and edge merge operations to eliminate many faces that could otherwise
adversely affect meshing.
1. Perform a global face-merge operation.
GEOMETRY

→ FACE

→ SPLIT/MERGE/COLLAPSE/SIMPLIFY FACES

R
This command sequence opens the Merge Faces (Virtual) form.

a) On the Type option subset, select the Virtual (Tolerance) option.
b) On the Faces pick-list option button, select All.
c) In the Min. Angle text box, input 160.
d) Retain the Merge edges option.
e) Click Apply to merge the faces.
GAMBIT merges the faces as shown in Figure 12-4.
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Figure 12-4: Model after face-merge operation
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Step 8: Use Cleanup Tools to Check and Clean Up Geometry
GAMBIT cleanup tools allow you to identify and eliminate individual model features
that can inhibit meshing. In this step, you will use the cleanup tools to check for the
existence of very short edges, “holes,” “cracks,” and small faces in the model and to
eliminate some of the small faces.
1. Identify any short edges in the model that might cause meshing problems.
TOOLS

→ CLEANUP

→ CLEAN UP SHORT EDGES

This command sequence opens the Clean Up Short Edges form.

When you open any of the cleanup forms, such as the Clean Up Short Edges form,
GAMBIT automatically sets the graphics window color mode to display colors
based on connectivity rather than topology. In addition, GAMBIT automatically
sets the graphics window pivot function to the user-specified pivot mode.
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a) Click the Default pushbutton located on the right side of the Maximum length text
box.
GAMBIT displays the Maximum length of edges to be included in the Items list
and populates the Items list with all edges in the Cleanup domain that meet the
Maximum length criterion. (In this case, the entire model constitutes the
Cleanup domain.) By default, the Maximum length value is 10 times greater
than the arc length of the shortest edge in the Cleanup domain.
b) Select the first edge in the Items list.
GAMBIT displays the arc length of the selected edge in the Current length
field located below the Items list and highlights and zooms in on the selected
edge in the graphics window (see Figure 12-5).

Figure 12-5: Automatic graphics-window display of the first listed edge
In this case, the shortest edge in the model is not short enough to adversely
affect meshing.
2. Check for the existence of holes in the model.
“Holes” in the model are internal edge loops that do not constitute face
boundaries.

© Fluent Inc., Sep-04

12-15

Procedure

INDUSTRIAL DRILL BIT—DIRECT CAD IMPORT

→ CLEANUP

TOOLS

→ CLEAN UP HOLES

This command sequence opens the Clean Up Holes form.

a) Click the Update pushbutton located on the right side of the Items list heading.
In this case, GAMBIT does not populate the Items list, because no holes exist
in the model.
3. Check for the existence of cracks in the model.
For the purposes of the geometry cleanup operations, a “crack” is defined as a
geometry consisting of an edge pair that meets the following criteria:

TOOLS

•

Each edge in the pair serves as a boundary edge for a separate face.

•

The edges share common endpoint vertices at one or both ends.

•

The edges are separated along their lengths by a small gap.

→ CLEANUP

→ CLEAN UP CRACKS

This command sequence opens the Clean Up Cracks form.
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a) Click the Default pushbutton located on the right side of the Maximum angle text
box.
GAMBIT displays the default Maximum angle criterion and automatically
populates the Items list with all cracks existing in the model. In this case,
GAMBIT does not populate the Items list, because no cracks exist in the
model.
4. Clean up one sharp angle in the model.
In this substep, you will use the Clean Up Sharp Angles form to identify and
eliminate an edge pair that constitutes a “sharp angle.” For the purposes of the
geometry cleanup operations, a sharp angle is defined as an edge pair that meets
the following criteria:
•

The edge pair shares a common endpoint vertex and serves as part of the
boundary for an existing face.

•

One of the edges in the sharp-angle edge pair serves as a common
boundary edge between its bounded face and an adjacent face.

•

The angle between the edges in the pair (computed at their common
endpoint vertex) is less than a specified angle.
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→ CLEANUP

→ CLEAN UP SHARP ANGLES

This command sequence opens the Clean Up Sharp Angles form.

a) Click the Default pushbutton located on the right side of the Maximum angle text
box.
GAMBIT displays the Maximum angle of angles to be included in the Items list
and populates the Items list with all face-vertex pairs in the Cleanup domain
that meet the Maximum angle criterion. By default, the Maximum angle value is
20.
b) Select the first face-vertex pair in the Items list.
GAMBIT highlights and zooms in on the geometry that constitutes the sharp
angle (see Figure 12-6).
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Sharp angle
Figure 12-6: Geometry constituting a sharp angle
The Clean Up Sharp Angles operation uses a Merge faces procedure to
eliminate any sharp angle. In this case, GAMBIT automatically populates the
Faces to merge pick list with suggested faces to merge and selects the Chop
option. (For a complete description of the Clean Up Sharp Angles form, see
“Clean Up Sharp Angles” in Section 5.4.2 of the GAMBIT Modeling Guide.)
c) Click the Apply pushbutton in the vertical array of pushbuttons located to the right
of the Items list.
GAMBIT merges the highly angular region of one face with the adjacent face
to eliminate the sharp angle (see Figure 12-7).
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Merged region
Figure 12-7: Geometry after sharp-angle cleanup operation
5. Clean up small faces in the model.
In this substep, you will use the Clean Up Small Faces form to identify and
eliminate individual small faces that can adversely affect meshing operations.
TOOLS

→ CLEANUP

→ CLEAN UP SMALL FACES

This command sequence opens the Clean Up Small Faces form.
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a) Click the Default pushbutton located on the right side of the Maximum area text
box.
GAMBIT displays the Maximum area of faces to be included in the Items list
and populates the Items list with all faces in the Cleanup domain that meet the
Maximum area criterion. By default, the Maximum area value is 100 times
greater than the area of the smallest face in the Cleanup Domain.
Figure 12-6 shows the three smallest faces in the model, all of which lie at the
base of the main drill-bit shaft. These three faces correspond to the first three
labels listed in the Items list.
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B

Figure 12-8: Three smallest faces in the model
b) Select the first face in the Items list.
GAMBIT displays the area of the selected face in the Current area field
located below the Items list and highlights the selected face (face A in Figure
12-8) in the graphics window.
The Clean Up Small Faces form provides two Method options for eliminating
faces—Collapse face and Merge face. In this case, GAMBIT automatically
selects the Merge face option and populates the Faces to merge pick list with
suggested faces to merge.
c) Click the A/N pushbutton in the vertical array of pushbuttons located to the right of
the Items list.
The A/N (“Apply/Next”) pushbutton removes the currently selected face from
the model, then updates the Items list and automatically selects the next
smallest face in the Cleanup domain. In this case, GAMBIT eliminates the
selected face and automatically selects the next smallest face (face B in Figure
12-8).
d) Click A/N again to eliminate the next smallest face in the Cleanup domain.
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GAMBIT eliminates the selected face and automatically highlights the next
smallest face (face C in Figure 12-8).
e) Click Apply to eliminate the third smallest face in the Cleanup domain.
Figure 12-9 shows the geometry in the region of the three smallest faces after
their removal from the model.

Figure 12-9: Geometry with three smallest faces cleaned up
Having eliminated the three small, ovoid faces at the base of the main shaft,
you will now remove four small, rectangular faces that serve as lips to other,
larger faces (see Figure 12-10).
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Figure 12-10: Small, rectangular lip faces
f) Select the first face in the Items list.
GAMBIT highlights and zooms in on the smallest of the rectangular lip faces
(face D in Figure 12-10) and automatically selects the Merge faces option and
populates the Faces to merge pick list with suggested faces to merge.
g) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face E in Figure 12-10).
h) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face F in Figure 12-10).
i) Click the A/N pushbutton to eliminate the selected face and automatically select the
next smallest face (face G in Figure 12-10).
j) Click Apply to eliminate the last of the lip faces.
After cleanup of the last lip face, the Items list still contains a list of small
faces; however, the remaining faces are not small enough to adversely affect
meshing operations.
Figure 12-11 shows the final, cleaned-up geometry.
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Figure 12-11: Final, cleaned-up model geometry
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Step 9: Apply Size Functions to Control Mesh Quality
Highly skewed elements adversely affect numerical computations for which the mesh
is created. GAMBIT includes several features that allow you to control the mesh, one
of which is the application of size functions. For example, size functions can be used
to specify the rate at which volume mesh elements change in size in proximity to a
specified boundary. In this step, you will apply size functions to four faces of the drillbit geometry and, thereby, control the size of the nearby mesh elements to eliminate
the skewed elements.
1. Specify a size function and apply it to four faces of the model.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.

a) Retain the Type:Fixed option.
(NOTE: In addition to the “fixed” size function illustrated in this tutorial,
GAMBIT provides “curvature,” “proximity,” and “meshed” size functions.
Curvature and proximity size functions are useful for controlling the mesh in
regions of high curvature and small gaps, respectively. Meshed size functions
use existing meshes to determine the size-function start size. See Section 5.2.2
of the GAMBIT Modeling Guide.)
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b) On the Entities:Source option button, select the Faces option.
c) In the Faces list box, select the four faces shown (shaded) in Figure 12-12.

Figure 12-12: Faces on which to apply size functions
d) On the Entities:Attachment option button, select the Volumes option.
e) In the Volumes list box, select the volume.
f) In the Start size text box, enter the value 0.035.
g) In the Growth rate text box, enter the value, 1.2.
h) In the Size limit text box, enter the value, 0.4.
i) Click Apply to create the size function.
When applying the size function, GAMBIT displays a message in the
Transcript window indicating that the use of virtual entities as source entities
in the size-function definition can cause problems when evaluated during
background-grid generation. The message represents a warning only and can
be ignored in this case. GAMBIT allows you to view the size function by
means of the View Size Function command on the Size Function toolpad.
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Step 10: Mesh the Volume
After the imported geometry is cleaned up and the size-function is created and
attached, you can mesh the geometry using an unstructured, tetrahedral mesh.
1. Mesh the drill-bit volume.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Activate the Volumes list box.
b) Select the volume.
GAMBIT automatically selects the Scheme:Elements:Tet/Hybrid and Scheme:
Type:TGrid options.
c) Retain the automatically selected Scheme options.
d) On the Spacing option button, retain the Interval size option.
e) In the Spacing text box, retain the default value of 1.
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The size function you attached to the volume in the previous step will override
the Spacing specifications.
f) Click Apply.
Figure 12-13 shows the final meshed volume.

Figure 12-13: Meshed drill-bit volume
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Step 11: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.
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a) Select Range under Display Type at the top of the form.
The 3D Element type selected by default at the top of the form is a brick
.
You will not see any mesh elements in the graphics window when you first
open the Examine Mesh form, because there are no hexahedral elements in the
mesh.
b) Left-click the tetrahedron icon

next to 3D Element near the top of the form.

The tetrahedral mesh elements will now be visible in the graphics window.
c) Select or retain EquiAngle Skew from the Quality Type option menu.
d) Left-click the histogram bars that appear at the bottom of the Examine Mesh form
to highlight elements in any given quality range.
Figure 12-14 shows the graphics window that results for elements with
EquiAngle Skew values between 0.5 and 0.6.

Figure 12-14: Elements with EquiAngle Skew values between 0.5 and 0.6
e) On the Examine Mesh form, click Close to close the form.
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Step 12: Export the Mesh and Close GAMBIT
1. Export a mesh file.
a) Open the Export Mesh File form
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

ii. Enter the File Name for the file to be exported—for example, the file name
“drill_bit_proe.msh”.
iii. Click Accept.
GAMBIT writes the mesh file to your working directory.
2. Save the GAMBIT session and close GAMBIT
a) Select Close from the File menu.
File → Close
This command sequence opens the Close form.
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The Close option is available only when GAMBIT is launched from within the
Pro/ENGINEER program.
b) Click Yes to save the current session and return to Pro/ENGINEER.
The Pro/ENGINEER user interface redisplays in the foreground, and
GAMBIT continues to run in the background.
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Step 13: Exit Pro/ENGINEER and GAMBIT
1. Exit the Pro/ENGINEER program.
File → Exit…
This command sequence opens the Pro/ENGINEER CONFIRMATION form.

a) Click Yes to exit Pro/ENGINEER.
When you exit Pro/ENGINEER, GAMBIT is still running, and the Close form
is still open.
b) On the GAMBIT Close form, click No to exit GAMBIT.
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12.5 Summary
This tutorial demonstrates the direct import of CAD geometry into GAMBIT and the
operations that are sometimes required to render such geometry amenable to GAMBIT
meshing operations. A comparison of the procedures described here with those of Tutorial
11 illustrates the advantages of direct CAD import versus import of CAD geometry by
means of intermediate files—for example, STEP files. Specifically, the directly imported
geometry does not include the very short edges that result from geometry import by means
of the STEP file.

© Fluent Inc., Sep-04

12-35

CATALYIC CONVERTER

13. CATALYTIC CONVERTER
In this tutorial you will import an IGES file describing the geometry of an automotive
catalytic converter. You will clean up the geometry using GAMBIT clean-up tools and
mesh the geometry using a hex-core meshing scheme.
In this tutorial you will learn how to:
•

Import an IGES file

•

Use a heal-geometry operation to repair the imported geometry

•

Use several clean-up operations to clean up the geometry

•

Apply size functions to control mesh quality

•

Mesh a volume with a hex-core mesh

•

Prepare the mesh to be read into FLUENT 5/6

NOTE: You can reproduce the perspectives of the figures in this tutorial by means of
window matrix commands available in a journal file named “tg13_figures.jou,”
which is included in the “help/tutfiles” online help directory. To exactly reproduce
the perspective of any figure, you can open the journal file and execute the window
matrix command associated with the figure. For example, the following command reproduces the perspective of the model shown in Figure 13-2.
window matrix 1 entries \
-0.8254742026329
-0.5580788850784
-0.08449375629425
35.9133605957
-0.03749995678663 -0.09513910114765
0.9947574734688 -52.56211853027
-0.563191473484
0.8243152499199
0.05760711431503 16.31116676331
-69.85343933105
93.40626525879
-87.0938949585
44.18941116333
-189.0608520508
189.0608520508

\
\
\
\
\

13.1 Prerequisites
This tutorial assumes you have worked through Tutorials 1 and 6 and are familiar with
use of the GAMBIT GUI and general clean-up operations.
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13.2 Problem Description
Figure 13-1 shows the geometry to be imported and meshed in this tutorial. This geometry
represents a complex portion of a catalytic converter, including four circular ports through
which exhaust gases flow. The imported geometry consists of many edges and faces that
you will eliminate before generating the volume mesh. The mesh itself will consist of a
core of hexahedral elements surrounded by layers of pyramidal and tetrahedral elements.

Figure 13-1: Catalytic-converter geometry
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13.3 Strategy
In this tutorial, you will create a “hex-core” mesh in a catalytic-converter geometry
imported as an IGES file. This tutorial illustrates many of the steps you can take in
GAMBIT to prepare imported CAD geometry for meshing. In this case, the imported
geometry contains many faces and edges that can complicate meshing by unnecessarily
constraining the mesh-generation process. In addition, the imported geometry contains a
“bad” face (with convoluted geometry) and an overlapping face. After using a GAMBIT
heal-geometry operation to simplify the imported geometry, you will clean up the
geometry using the clean-up tools available in GAMBIT. You will then pave four large,
circular faces on the geometry and generate a mesh consisting of a core of hexahedral
elements surrounded by pyramidal and tetrahedral elements.
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13.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/catalytic_conv.igs

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “Catalytic_Converter”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). For
some systems, FLUENT 5/6 is the default solver. The solver currently selected is
shown at the top of the GAMBIT GUI.

13-4

© Fluent Inc., Sep-04

CATALYTIC CONVERTER

Procedure

Step 2: Import the IGES File
File → Import → IGES …
This command sequence opens the Import IGES File form.
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1. Click on the Browse... button.
This action opens the Select File form.

a) Select catalytic_conv.igs in the Files list.
b) Click Accept in the Select File form.
2. On the Import IGES File form, under Stand-alone Geometry, select the No stand-alone
vertices and No stand-alone edges options.
3. Unselect the Make Tolerant option.
4. Click Accept.
The IGES file for the catalytic converter will be read into GAMBIT (see Figure
13-2).
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Figure 13-2: Imported catalytic-converter geometry
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Step 3: Attempt to Heal the Geometry
The imported geometry is somewhat “dirty”—that is, it contains gaps between face
boundaries that can prevent the creation of a meshable volume. In this step, you will
attempt to “heal” the geometry to eliminate the gaps.
1. View entity connectivity in the model.
in the Global Control
a) Click the SPECIFY COLOR MODE command button
toolpad to change to the graphics display to connectivity-based coloring.
. When
The SPECIFY COLOR MODE command button will change to
GAMBIT is in the connectivity display mode, the model is displayed with
colors based on connectivity between entities rather than based on entity
types. In this case, all edges are displayed as orange, indicating that the faces
they bound are not connected to each other.
2. Attempt the geometry healing operation.
GEOMETRY

→ FACE

→ SMOOTH/HEAL REAL FACES

This command sequence opens the Smooth/Heal Real Faces form.
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a) Select All from the option menu to the right of Faces.
b) Unselect the Smooth faces option.
c) Select the Heal geometry option.
d) Select the Simplify geometry option.
This option specifies whether or not GAMBIT converts NURBS data to analytic data, where possible, to within a specified tolerance.
e) Retain the Stitch faces option.
This option specifies that GAMBIT stitches faces to create a volume during
the healing operation.
f) Select the Repair geometry option.
This option specifies that GAMBIT attempts to repair the model geometry by
recomputing and/or extending surface and curve definitions so that the model
“fits together” properly.
g) Click Apply.
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Most of the edges turn blue, indicating that the healing operation is successful
at connecting most faces; however, several edges remain orange. Three sets of
orange edges represent circular holes in the model that will be cleaned up in
Step 7. The others indicate the existence of one “bad” face and one overlapping face in the model (see Figure 13-3). Before you can successfully heal the
geometry, you must eliminate the bad face and the overlapping face.

Region with
bad geometry

Figure 13-3: Region of the model containing bad and overlapping faces
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Step 4: Eliminate the Bad and Overlapping Faces
The imported IGES geometry contains two faces that inhibit the geometry healing
operation. In this step, you will identify and eliminate both faces.
1. Ctrl-left-drag the mouse to zoom in on the region containing the bad and overlapping
faces (shown as shaded faces in Figure 13-4).

Overlapping face
Bad face

Figure 13-4: Zoomed view of bad and overlapping faces
The shaded faces shown in Figure 13-4 must be deleted, rather than “cleaned
up,” before the geometry can be correctly healed.

2. Click the UNDO command button
healing operation.

on the Global Control toolpad to undo the

All edges will turn orange again, indicating that the connections made during the
first healing attempt are undone.
3. Delete the bad and overlapping faces.
GEOMETRY

→ FACE

→ DELETE FACES

This command sequence opens the Delete Faces form.
© Fluent Inc., Sep-04
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a) Select the bad and overlapping faces shown in Figure 13-4, above.
b) Click Apply.
GAMBIT removes the faces from the model, leaving the local geometry shown
in Figure 13-5.

A

B

Figure 13-5: Local geometry after face deletion
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Step 5: Smooth the Discontinuous Edge
Before you can again attempt to heal the geometry, you must create a new face to
replace the deleted overlapping face. However, one of the edges remaining after the
face-delete operation in Step 4 possesses “G1” discontinuity, which is usually
associated with sharp kinks in the curve that defines the edge. Such discontinuities
can sometimes complicate operations that employ the edge as a boundary edge of a
skin-surface face (see Step 6). In this step, you will remove any discontinuities from
the edge.
1. Remove discontinuities from one of the edges shown in Figure 13-5.
GEOMETRY

→ EDGE

→ SMOOTH REAL EDGES

This command sequence opens the Smooth Real Edges form.

a) In the graphics window, select (pick) edge B shown in Figure 13-5, above.
b) Retain the Replace bad geometry option.
c) Click Apply.
GAMBIT removes G1 discontinuities from the edge.
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Step 6: Replace the Overlapping Face
After the edge discontinuities are removed, you can create a new face to replace the
face deleted in Step 4. The new face will be created using a skin-surface face creation
procedure.
1. Create a skin-surface face.
GEOMETRY

→ FACE

→ FORM FACE

R

This command sequence opens the Create Real Skin Surface Face form.

a) In the graphics window, select (pick) edge A shown in Figure 13-5, above.
b) Select (pick) edge B shown in Figure 13-5.
The skin-surface face-creation operation requires that the “sense” directions
of all edges used to create a face point in the same direction. In this case, the
default senses of edges A and B point in opposite directions. To correctly
specify these edges for the procedure, you must reverse the sense direction of
one of the two edges.
c) Shift-middle-click edge B to reverse its sense direction.
GAMBIT indicates the change in the sense direction of edge B by reversing
the arrow displayed in the middle of the edge.
d) Click Apply.
GAMBIT creates a new face to replace the deleted overlapping face (see
Figure 13-6).
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Figure 13-6: New skin-surface face (shaded)

e) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full catalytic converter in the graphics window.
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Step 7: Attempt Again to Heal the Geometry
Now that the bad and overlapping faces have been removed from the model, you can
attempt again to heal the geometry.
1. Attempt the geometry healing operation on the modified geometry.
GEOMETRY

→ FACE

→ SMOOTH/HEAL REAL FACES

This command sequence reopens the Smooth/Heal Real Faces form.

a) Retain all options specified on the previous healing attempt.
b) Click Apply.
This time, GAMBIT successfully heals the geometry to create the geometry
shown in Figure 13-7. The only remaining unconnected edges are those that
define the three circular holes in the model (see Step 8: Clean Up Holes in the
Model).
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Figure 13-7: Healed catalytic-converter geometry
Although the healing operation has successfully connected the faces, the healed
geometry still contains many features that can inhibit meshing—such as short
edges and sharp angles. To facilitate meshing, you can remove such features
using the GAMBIT clean-up tools.
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Step 8: Clean Up Holes in the Model
In this step, you will clean up “holes” in the model (see Figure 13-8) to create
circular faces that can be stitched together with other faces in the cleaned-up model
to create an enclosed, meshable volume.

Holes

Figure 13-8: Circular holes in catalytic-converter geometry
1. Clean up holes that constitute the catalytic converter inlet and outlet ports.
TOOLS

→ CLEANUP

→ CLEAN UP HOLES

This command sequence opens the Clean Up Holes form.
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When you open any of the clean-up forms, such as the Clean Up Holes form,
GAMBIT automatically sets the graphics window color mode to display colors
based on connectivity rather than topology. In addition, GAMBIT automatically
sets the graphics window pivot function to the user-specified pivot mode.
GAMBIT automatically populates the Items list with the edge sets that constitute
holes in the model.
a) Select the first item (edge set) in the Items list.
GAMBIT automatically highlights the set of edges shown in Figure 13-9.
(NOTE: Due to slight differences in entity numbering between computer
platforms, the entity numbers shown in Figure 13-9, and in all subsequent
figures that include entity labels, might differ from those displayed in the
GAMBIT graphics window.)
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Figure 13-9: Set of edges comprising the first hole listed in the Items list
The Clean Up Holes form provides only one method for eliminating holes—
Create face from wireframe.
b) Click the A/N pushbutton in the vertical array of pushbuttons located to the right of
the Items list.
The A/N (“Apply/Next”) pushbutton applies the Create face from wireframe
method to remove the hole from the model then updates the Items list and
automatically selects the next hole in the Cleanup domain.
c) Click A/N again to eliminate the next hole in the Cleanup domain.
GAMBIT eliminates the selected face and automatically highlights the next
hole in the Cleanup domain.
d) Click Apply to eliminate the last remaining hole in the Cleanup domain.
e) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full catalytic converter in the graphics window.
Figure 13-10 shows a shaded view of the full geometry, illustrating that the
holes have been converted to faces.
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Figure 13-10: Geometry after hole clean-up operations
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Step 9: Clean Up Short Edges
In this step, you will use manual and automatic clean-up procedures to eliminate
short edges in the model.
1. Manually eliminate the shortest edge in the model.
TOOLS

→ CLEANUP

→ CLEAN UP SHORT EDGES

This command sequence opens the Clean Up Short Edges form.

a) Click the Default pushbutton located on the right side of the Maximum length text
box.
When you click the Default pushbutton, GAMBIT displays the Maximum length
of edges to be included in the Items list and populates the Items list with all
edges in the Cleanup domain that meet the Maximum length criterion. By
default, the Maximum length value is 10 times greater than the arc length of
the shortest edge in the Cleanup domain.
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b) Select the edge displayed in the Items list.
GAMBIT highlights and displays the edge in the graphics window as shown
(in a manually-zoomed view) in Figure 13-11.

Faces to merge

Figure 13-11: Shortest edge in the model
GAMBIT provides three methods for eliminating short edges—Vertex connect,
Edge merge, and Face merge. In this case, GAMBIT automatically selects the
Face merge option and populates the Faces to merge pick list with two
candidate faces for the merge operation.
c) Click Apply in the vertical array of pushbuttons located to the right of the Items list.
GAMBIT merges the specified faces to create the configuration shown in
Figure 13-12, thereby eliminating the shortest edge in the model.
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Figure 13-12: Cleaned-up local geometry after the Face merge operation
Now that you have removed the shortest edge in the model, you will use an
automatic operation to clean up the remaining short edges.
2. Automatically clean up the remaining shortest edges.
a) Click the Default pushbutton located next to the Maximum length text box.
GAMBIT updates the Maximum length value based on the current set of edges
in the Cleanup domain and updates the Items list.
b) Unselect the Zoom:Auto option.
By default, GAMBIT automatically zooms in on any edge currently selected
for clean-up and displays the labels of the edge and its endpoint vertices in the
graphics window. If you retain the Zoom:Auto option in this case, GAMBIT
will zoom in on every edge as it is automatically removed from the model,
thereby making it difficult to follow the clean-up operation in the graphics
window.

c) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full catalytic converter in the graphics window.
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d) On the Clean Up Short Edges form, click Auto in the vertical array of pushbuttons
located to the right of the Items list.
GAMBIT uses edge- and face-merge operations to automatically remove
edges from the model. Figure 13-13 shows the full geometry after removing
the short edges.

Figure 13-13: Geometry after cleaning up shortest edges
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Step 10: Clean Up Sharp Angles
In this step, you will us a clean-up procedures to eliminate a “sharp angle” in the
model. For the purposes of the geometry cleanup operations, a “sharp angle” is
defined as an edge pair that meets the following criteria:
•

The edge pair shares a common endpoint vertex and serves as part of the
boundary for an existing face.

•

One of the edges in the sharp-angle edge pair serves as a common boundary
edge between its bounded face and an adjacent face.

•

The angle between the edges in the pair (computed at their common endpoint
vertex) is less than a specified angle.

1. Identify and eliminate a sharp angle in the model.
TOOLS

→ CLEANUP

→ CLEAN UP SHARP ANGLES

This command sequence opens the Clean Up Sharp Angles form.
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a) In the Maximum angle text box, enter the value 30.
b) Click the Items:Update pushbutton.
GAMBIT populates the Items list with one face-vertex pair in the Cleanup
domain that meets the Maximum angle criterion.
c) Unselect the Zoom:Auto option.
d) Select the face-vertex pair displayed in the Items list.
GAMBIT highlights the geometry that constitutes the specified sharp angle
(see Figure 13-14).

Figure 13-14: Geometry associated with sharp angle to be cleaned up
The Clean Up Sharp Angles operation uses a Merge faces procedure to
eliminate any sharp angle. In this case, GAMBIT automatically populates the
Faces to merge pick list with suggested faces to merge. (For a complete
description of the Clean Up Sharp Angles form, see “Clean Up Sharp Angles”
in Section 5.4.2 of the GAMBIT Modeling Guide.)
e) Click the Apply pushbutton in the vertical array of pushbuttons located to the right
of the Items list.
GAMBIT merges the faces as shown in Figure 13-15.
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Figure 13-15: Model geometry after sharp-angle clean-up operation
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Step 11: Clean Up Large Angles
In this step, you will clean-up procedures to eliminate “large angles” in the model.
For the purposes of the geometry cleanup operations, a “large angle” is defined by a
set of faces that meet the following criteria:
•

All faces in the set are connected to each other.

•

The angle between the outward-pointing normals for adjacent faces in the set
is less than a specified angle.

1. Identify and eliminate large angles in the model.
TOOLS

→ CLEANUP

→ CLEAN UP LARGE ANGLES

This command sequence opens the Clean Up Large Angles form.

a) Click the Default pushbutton located on the right side of the Maximum angle text
box.
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GAMBIT displays the Maximum angle of angles to be included in the Items list
and populates the Items list with all face-face sets in the Cleanup domain that
meet the Maximum angle criterion. By default, the Maximum angle value is 5.
b) Unselect the Zoom:Auto option.
c) Select the first item in the Items list.
GAMBIT highlights the geometry that constitutes the item to be cleaned up
(see Figure 13-16). In this case, the item consists of a set of faces, each of
which is connected to the others and forms at least one large angle with others
in the set. The Clean Up Large Angles operation uses a Merge faces procedure
to eliminate any large angle.

Figure 13-16: Geometry involved in large-angle cleanup operation
d) Click in the Faces to merge pick-list field to make it active.
e) Manually select the face shown as shaded in Figure 13-16, above, to include it in
the Faces to merge list.
f) Click the Apply pushbutton in the vertical array of pushbuttons located to the right
of the Items list.
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GAMBIT merges the specified faces, thereby creating a continuous surface
for the catalytic converter model. Figure 13-17 shows a shaded view of the
final, cleaned-up geometry.

Figure 13-17: Final cleaned-up geometry (shaded view)
g) Click Close to close the Clean Up Large Angles form.
h) Click the SPECIFY COLOR MODE command button
in the Global Control
toolpad to change to the graphics display to entity-based coloring.
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Step 12: Stitch the Faces to Create a Volume
1. Stitch the faces in the cleaned-up model to create a volume.
GEOMETRY

→ VOLUME

→ FORM VOLUME

This command sequence opens the Stitch Faces form.

a) Retain the Number:Single volume option.
b) Select the Type:Virtual option.
c) Select (pick) all remaining faces (eight total) in the model.
d) Click Apply to create the volume.
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Step 13: Mesh the Large Circular Faces
In this step, you will facilitate subsequent volume meshing by paving the four large,
circular faces of the model.
1. Create a pave mesh on the four large, circular faces of the catalytic converter.
MESH

→ FACE

→ MESH FACES

a) Select the four large, circular faces (A, B, C, and D) shown in Figure 13-18.

© Fluent Inc., Sep-04

13-33

Procedure

CATALYTIC CONVERTER

B

C

A

D

Figure 13-18: Four large, circular faces to be meshed
GAMBIT automatically selects the Elements:Quad and Type:Pave options. For
more information on face meshing schemes, see the GAMBIT Modeling
Guide.
b) Enter an Interval size of 3 under Spacing and click the Apply button at the bottom of
the form.
GAMBIT meshes the faces as shown in Figure 13-19.

13-34

© Fluent Inc., Sep-04

CATALYTIC CONVERTER

Procedure

Figure 13-19: Paved meshes on the large, circular faces
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Step 14: Apply Size Functions to Control Mesh Quality
Size functions allow you to control mesh quality and prevent the creation of highly
skewed elements. For example, size functions can be used to specify the rate at which
volume mesh elements change in size in proximity to a specified boundary. In this
step, you will apply size functions to all the faces in the model.
1. Specify a size function and apply it to all faces in the model.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.

a) Retain the Type:Fixed option.
In addition to the “fixed” size function illustrated in this tutorial, GAMBIT
provides “curvature” and “proximity” size functions. Curvature and
proximity size functions are useful for controlling the mesh in regions of high
curvature and small gaps, respectively. See Section 5.2.2 of the GAMBIT
Modeling Guide.
b) On the Source option button, select the Faces option.
c) Click in the Faces list box to make it active and select (pick) all faces in the model.
d) On the Attachment option button, retain the Volumes option.
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e) Click in the Volumes list box to make it active, and select the volume.
f) In the Start size text box, enter the value 3.
g) In the Growth rate text box, enter the value, 1.2.
h) In the Size limit text box, enter the value, 10.
i) Click Apply to create the size function.
When applying the size function, GAMBIT displays a message in the
Transcript window indicating that the use of virtual entities as source entities
in the size-function definition can cause problems when evaluated during
background-grid generation. The message represents a warning only and can
be ignored in this case.
GAMBIT allows you to view the size function by means of the View Size
Function command on the Size Function toolpad.
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Step 15: Mesh the Volume
1. Mesh the volume using a hex-core meshing scheme.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select (pick) the volume in the graphics window.
GAMBIT automatically selects the Elements:Tet/Hybrid and Type:TGrid
options.
b) Retain the Elements:Tet/Hybrid option.
c) Select the Type:Hex Core option.
d) Retain the default Interval size of 1 under Spacing and click the Apply button at the
bottom of the form.
GAMBIT meshes the volume as shown in Figure 13-20.
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Figure 13-20: Meshed catalytic converter volume
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Step 16: Examine the Volume Mesh
1. Select the EXAMINE MESH
Control toolpad.

command button at the bottom right of the Global

This action opens the Examine Mesh form.

a) Select the Display Type:Range option at the top of the form.
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By default, GAMBIT selects the 3D Element brick
for display in the
graphics window. In this case, the resulting display shows the core of
hexahedral elements created by means of the Hex Core volume meshing
scheme (see Figure 13-21).

Figure 13-21: Central core of hexahedral mesh elements
b) Select the Display Type:Plane option at the top of the form.
The Examine Mesh form allows you to view various mesh characteristics for the
3-D mesh. For example, Figure 13-22 and Figure 13-23 display tetrahedral and
pyramidal volume mesh elements, respectively, for an intersecting cutting plane
aligned with the x-z coordinate plane. You can generate these views of the model
and
buttons, respectively, at the top of the Examine
by selecting the
Mesh form and clicking on the Y slider bar near the bottom of the form.
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Figure 13-22: Cutting plane showing only tetrahedral mesh elements

Figure 13-23: Cutting plane showing only pyramidal mesh elements
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To view the worst element (as defined by the current quality metric and selected
element type(s)), select the Display Type:Range option, and click the Show worst
element check box near the bottom of the Examine Mesh form.
c) Close the Examine Mesh form by clicking the Close button at the bottom of the
form.
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Step 17: Export the Mesh and Save the Session
1. Export a mesh file for the catalytic converter.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

a) Enter the File Name for the file to be exported (Catalytic_Converter.msh).
b) Click Accept in the Export Mesh File form.
The file will be written to your working directory.
2. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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13.5 Summary
This tutorial illustrated how to import geometry from an external CAD package as an
IGES file, use GAMBIT healing and clean-up tools to make the geometry suitable for
meshing, and mesh the geometry.
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14. AIRPLANE GEOMETRY
In this tutorial you will import a STEP file that describes the geometry of an airplane
body, including the wing and nacelle that houses the engine. You will clean up the
geometry using GAMBIT smooth/heal and cleanup tools, apply three different types of
size functions, and mesh the geometry using a tetrahedral meshing scheme.
In this tutorial you will learn how to:
•

Import a STEP file

•

Use a smooth-heal operation to repair the imported geometry

•

Use several clean-up operations to clean up the geometry

•

Construct a flow volume around the airplane geometry

•

Apply size functions to control mesh quality

•

Mesh faces using a triangular pave meshing scheme

•

Mesh a volume using a tetrahedral meshing scheme

•

Prepare the mesh to be read into FLUENT 5/6

14.1 Prerequisites
This tutorial assumes you have worked through Tutorials 1, 6, and 13 and are familiar
with use of the GAMBIT GUI and general clean-up operations.
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14.2 Problem Description
Figure 14-1 shows the geometry to be imported and meshed in this tutorial. This geometry
represents one half of an airplane body, including the wing, strut, and nacelle that houses
the engine but does not include the empennage. The imported geometry consists of many
edges and faces that you will eliminate before generating the volume mesh. The mesh
itself will consist entirely of tetrahedral elements.

Figure 14-1: Airplane geometry

14-2

© Fluent Inc., Sep-04

AIRPLANE GEOMETRY

Strategy

14.3 Strategy
In this tutorial, you will create a tetrahedral mesh in a flow volume surrounding one half
of an airplane body, including the wing, strut, and nacelle housing the engine but
excluding the empennage. The geometry will be imported as a STEP file containing many
faces and edges that will need to be eliminated before meshing. After creating a flow
volume around the imported geometry and using a GAMBIT smooth/heal operation to
simplify the geometry, you will clean up the geometry using the cleanup tools available in
GAMBIT. You will then create triangular face meshes on the airplane body surfaces and
flow-volume symmetry plane and mesh the flow volume with tetrahedral elements.
NOTE: This tutorial employs a relatively course mesh so that the mesh characteristics can
be easily examined. In actual practice, the model described in this tutorial would employ a
much finer mesh than is used here, especially in the regions adjacent to the airplane body.
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14.4 Procedure
1. Copy the file
path/Fluent.Inc/gambit2.x/help/tutfiles/nacelle-9.stp

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in
the directory path to your working directory.
2. Start GAMBIT using the session identifier “Airplane”.

Step 1: Select a Solver
1. Choose the solver from the main menu bar:
Solver → FLUENT 5/6
The choice of a solver dictates the options available in various forms (for
example, the boundary types available in the Specify Boundary Types form). For
some systems, FLUENT 5/6 is the default solver. The solver currently selected is
shown at the top of the GAMBIT GUI.
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Step 2: Import the STEP File
File → Import → STEP …
This command sequence opens the Import STEP File form.

1. Click on the Browse... button.
This action opens the Select File form.
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a) Select nacelle-9.stp in the Files list.
b) Click Accept on the Select File form.
2. On the Import STEP File form, under Stand-alone Geometry, select the No stand-alone
edges option.
3. Unselect the Make Tolerant option.
The Make tolerant option improves geometric connectivity and can be invoked
either during geometry import or after geometry import—as part of a healing
operation. In this tutorial, you will invoke the Make tolerant option during a
healing operation after examining and addressing duplicate-geometry issues (see
Steps 3 and 4, below).
4. Click Accept.
The STEP file for the airplane body will be read into GAMBIT (see Figure 14-2).
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Figure 14-2: Imported airplane geometry
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Step 3: Clean Up Duplicate Faces
The imported geometry is “dirty” in that it contains duplicate faces and edges. In this
step, you will use a GAMBIT cleanup operation to eliminate the duplicate faces.
1. Clean up duplicate faces in the imported geometry.
TOOLS

→ CLEANUP

→ CLEAN UP DUPLICATE GEOMETRY

R
This command sequence opens the Clean Up Duplicate Faces form.

When you open any of the cleanup forms, such as the Clean Up Duplicate Faces
form, GAMBIT automatically sets the graphics window color mode to display
colors based on connectivity rather than topology. GAMBIT also automatically
sets the graphics window pivot function to the user-specified pivot mode.
a) Retain the Topology-based search option.
b) Click the Default pushbutton located on the right side of the Tolerance text box.
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When you click the Default pushbutton, GAMBIT displays the Tolerance
default value and populates the Items list with two sets of faces that meet the
tolerance criterion. For the Topology-based search option, the Items list
contains sets of faces that are topologically identical to each other and the
corresponding boundary edges of which are close to each other to within the
Tolerance value.
c) Select the first duplicate-face set displayed in the Items list.
GAMBIT zooms in on and highlights the faces shown in Figure 14-3. (NOTE:
Due to slight differences in entity numbering between computer platforms, the
entity numbers shown in Figure 14-3 and in all subsequent figures that
include entity labels might differ from those actually displayed in the
GAMBIT graphics window.)

Figure 14-3: Set of faces comprising the first duplicate-face set in the Items list
GAMBIT automatically selects the Method:Connect faces option and populates
the Options:Faces pick list with the faces to be connected in performing the
cleanup operation.
d) Click the A/N pushbutton in the vertical array of pushbuttons located to the right of
the Items list.
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The A/N (“Apply/Next”) pushbutton applies the Connect faces method to clean
up the duplicate faces and automatically selects the remaining duplicate-face
set in the Items list.
e) Click Apply to clean up the remaining set of duplicate faces.
f) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full model geometry in the graphics window.
The removal of the duplicate faces does not significantly affect the appearance
of the airplane geometry.
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Step 4: View List of Duplicate Edges
In addition to the duplicate faces cleaned up in the previous step, the imported
geometry contains many duplicate edges. In this step, you will use a GAMBIT
cleanup operation to view the list the duplicate edges.
1. List all duplicate edges in the imported geometry.
TOOLS

→ CLEANUP

→ CLEAN UP DUPLICATE GEOMETRY

R
This command sequence opens the Clean Up Duplicate Edges form.

a) Click the Default pushbutton located on the right side of the Tolerance text box.
When you click the Default pushbutton, GAMBIT displays the default
Tolerance value and populates the Items list with duplicate-edge sets—that is,
pairs of edges the maximum distances between which are less than the
Tolerance value. In this tutorial, you will eliminate the duplicate edges by
“healing” the geometry (see Step 5: Heal the Geometry, below).
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Step 5: Heal the Geometry
1. Heal the imported geometry.
GEOMETRY

→ FACE

→ SMOOTH/HEAL REAL FACES

This command sequence opens the Smooth/Heal Real Faces form.

a) Select All from the option menu to the right of Faces.
b) Unselect the Smooth faces option.
c) Select the Heal geometry option.
d) Retain the Stitch faces option.
This option helps ensure connectivity between edges in the healed geometry.
e) Click Apply.
GAMBIT heals the geometry and eliminates duplicate edges in the model.
(NOTE: Connected edges are shown as blue in the graphics window.)
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Step 6: Clean Up Holes
In this step, you will clean up “holes” in the model (see Figure 14-4) to ensure that
the airplane geometry faces can be stitched together to form a continuous surface. In
this case, the geometry includes three holes: one near the tail, one near the cockpit,
and one that lies in the symmetry plane for the airplane geometry. The face you create
from the “hole” that lies in the symmetry plane will be connected (in a later step) to a
rectangular face that represents the symmetry plane of the flow volume.

Holes

Figure 14-4: Holes in airplane geometry
1. Clean up holes in the geometry.
TOOLS

→ CLEANUP

→ CLEAN UP HOLES

This command sequence opens the Clean Up Holes form.
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GAMBIT automatically populates the Items list with the edge sets that constitute
holes in the model.
a) Select the first item (edge set) in the Items list.
GAMBIT automatically highlights the set of edges near the airplane tail as
shown in Figure 14-5.
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Figure 14-5: Set of edges comprising the first hole listed in the Items list
The Clean Up Holes form provides only one method for eliminating holes—
Create face from wireframe.
b) Click the A/N pushbutton in the vertical array of pushbuttons located to the right of
the Items list.
The A/N (“Apply/Next”) pushbutton applies the Create face from wireframe
method to remove the hole from the tail area then updates the Items list and
automatically selects the next item (the hole near the cockpit) in the Cleanup
domain.
c) Click A/N again to eliminate the next hole in the Cleanup domain.
GAMBIT eliminates the hole near the cockpit and automatically highlights
the remaining item (corresponding to the hole that lies in the symmetry plane).
d) Click Apply to eliminate the remaining hole by creating the airplane symmetry face.
e) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full airplane geometry in the graphics window.
Figure 14-6 shows the airplane geometry with shaded views of the three new
faces.
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New faces

Figure 14-6: Airplane geometry with three new faces
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Step 7: Create a Brick around the Airplane Body
1. Create a brick.
GEOMETRY

→ VOLUME

→ CREATE VOLUME

This command sequence opens the Create Real Brick form.

a) Enter a value of 1500 for the Width of the brick.
b) Enter 700 for the Depth and 700 for the Height.
c) Retain the Direction:Centered option.
d) Click Apply.
2. Click the FIT TO WINDOW command button
at the top left of the Global Control
toolpad to see the brick and full airplane body in the graphics window.
3. Align one face of the brick with the symmetry plane of the airplane geometry.
GEOMETRY

→ VOLUME

→ MOVE/COPY/ALIGN VOLUMES

This command sequence opens the Move / Copy Volumes form.

© Fluent Inc., Sep-04

14-17

Procedure

AIRPLANE GEOMETRY

a) Select (Shift-left-click) the brick in the graphics window.
b) Retain Move (the default) under Volumes in the Move / Copy Volumes form.
c) Retain the Operation:Translate option.
d) Enter (250, -350, 0) under Global to move the brick 250 units in the x direction
and -350 units in the y direction.
Note that GAMBIT automatically fills in the values under Local as you enter
values under Global.
e) Click Apply.
at the top left of the Global Control
4. Click the FIT TO WINDOW command button
toolpad to see the full brick and airplane body in the graphics window.
GAMBIT aligns the brick and airplane geometry as shown in Figure 14-7.
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Figure 14-7: Brick and airplane body
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Step 8: Delete the Brick High-level Geometry
In Step 10: “Create the Flow Volume,” you will stitch the faces of the brick with those
of the airplane geometry to create an enclosed flow volume. You cannot simply
subtract the airplane body from the brick to produce the flow volume, because you
used “virtual geometry” to clean up the airplane body, and GAMBIT cannot perform
Boolean operations on virtual geometry. Instead, you must create a virtual volume by
stitching the virtual faces of the airplane geometry and the real faces of the brick. To
do so, you must first delete the brick volume while retaining its lower-level geometry
(faces).
1. Delete the brick while retaining its faces.
GEOMETRY

→ VOLUME

→ DELETE VOLUMES

This command sequence opens the Delete Volumes form.

a) Select (Shift-left-click) the brick in the graphics window.
b) Unselect the Lower Geometry option.
c) Click Apply.
GAMBIT deletes the brick volume, but retains all of its component faces,
edges, and vertices.
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Step 9: Connect Faces on the Symmetry Plane
When you stitch faces to form a volume, it is not always necessary to specify all of the
faces to be stitched. In Step 10: “Create the Flow Volume,” you will specify only two
of the many faces to be used in creating the flow volume, and GAMBIT will
automatically add the others when performing the stitch operation. To successfully
carry out the stitch operation, you must first connect the symmetry face on the
airplane geometry to the symmetry face on the brick.
1. Connect the two symmetry faces.
GEOMETRY

→ FACE

→ CONNECT/DISCONNECT FACES

This command sequence opens the Connect Faces form.

a) Click in the Faces pick-list field.
b) Select the two symmetry faces (faces A and B in Figure 14-8).
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B
A

Figure 14-8: Airplane and brick symmetry faces
c) Select the Real and Virtual (Tolerance) option.
d) Select the T-Junctions option.
e) Click Apply.
GAMBIT connects the symmetry faces.
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Step 10: Create the Flow Volume
Now that you have connected the symmetry faces, you can create the flow volume by
specifying only two of the many faces that will be used to enclose the volume.
1. Stitch the faces to form the flow volume.
GEOMETRY

→ VOLUME

→ STITCH FACES

This command sequence opens the Stitch Faces form.

a) Click in the Faces pick-list field.
b) Select one face of the flow volume—for example, the bottom face (C) shown in
Figure 14-9.
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C

Figure 14-9: Face specified for the face-stitch operation
c) Retain the Number:Single volume option.
d) Select the Type:Virtual option.
e) Click Apply.
GAMBIT stitches the airplane geometry faces and the brick faces external to
the airplane geometry to create the flow volume.
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Step 11: Clean Up Sharp Angles
The imported geometry contains several sharp angles and short edges that can
complicate your ability to mesh the flow volume. In the next two steps, you will use
automatic GAMBIT cleanup operations to eliminate the sharp angles and short
edges.
1. Automatically eliminate sharp angles in the airplane geometry.
TOOLS

→ CLEANUP

→ CLEAN UP SHARP ANGLES

This command sequence opens the Clean Up Sharp Angles form.

a) Click the Default pushbutton located on the right side of the Maximum angle text
box.
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When you click the Default pushbutton, GAMBIT displays the Maximum angle
default value (20) and populates the Items list with three face-vertex pairs that
meet the maximum-angle criterion. In this case, you will use an automatic
operation to eliminate all three of the sharp angles.
b) Click Auto in the vertical array of pushbuttons located to the right of the Items list.
GAMBIT uses face-merge operations to automatically remove all of the sharp
angles from the model. (NOTE: In general practice, you should exercise
caution when using the Auto pushbutton to execute cleanup operations. Lessexperienced GAMBIT users should select items one at a time in the Items list
and use the Apply and/or A/N pushbuttons, instead.)

c) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full flow-volume geometry in the graphics window.
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Step 12: Clean Up Short Edges
1. Automatically eliminate the short edges in the model.
TOOLS

→ CLEANUP

→ CLEAN UP SHORT EDGES

This command sequence opens the Clean Up Short Edges form.

a) Click the Default pushbutton located on the right side of the Maximum length text
box.
When you click the Default pushbutton, GAMBIT displays the Maximum length
of edges to be included in the Items list and populates the Items list with all
edges in the Cleanup domain that meet the Maximum length criterion. By
default, the Maximum length value is 10 times greater than the arc length of
the shortest edge in the Cleanup domain.
b) Unselect the Zoom:Auto option.
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By default, GAMBIT automatically zooms in on any item currently selected
for a cleanup operation and displays the labels of the entities involved in the
operation. If you retain the Zoom:Auto option in this case, GAMBIT will zoom
in on every edge as it is removed from the model, thereby making it difficult to
follow the cleanup operation in the graphics window.
c) Click Auto in the vertical array of pushbuttons located to the right of the Items list.
GAMBIT removes all but eight of the short edges from the model. Figure
14-10 shows the full geometry after removing the edges.

Figure 14-10: Airplane geometry after cleaning up short edges
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Step 13: Modify the Size Function Defaults
Size functions allow you to control mesh quality and prevent the creation of highly
skewed elements. For example, size functions can be used to specify the rate at
which volume mesh elements change in size in proximity to a specified boundary.
In this tutorial, you will use size functions to control mesh density in the regions
surrounding the airplane geometry surfaces. Before creating and attaching the
size functions, you will modify four of the size function defaults.
Edit → Defaults…
This command sequence opens the Edit Defaults form.
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1. Select the TOOLS tab at the top of the form.
GAMBIT displays the available default settings for three “tools” operations—
coordinate system, size-function, and cleanup.
2. Select the SFUNCTION radio button.
GAMBIT displays the size-function defaults variables.
3. Use the Modify pushbutton on the Edit Defaults form to modify four size-function
defaults.
a) Set the MIN_ELEM_SIZE default variable to 0.01.
b) Set the CURVATURE_CHECK_FACE_EDGES default variable to 1.
c) Set the BGRID_MAX_TREE_DEPTH default variable to 20.
d) Set the BGRID_NONLINEAR_ERR_PERCENT default variable to 15.
The BGRID_MAX_TREE_DEPTH and BGRID_NONLINEAR_ERR_PERCENT
values specified here represent moderate, intermediate values. For information concerning the use of such variables to control mesh quality, see “Create
Size Function” in Section 5.2.2 of the GAMBIT Modeling Guide .
4. Click Close to close the Edit Defaults form.
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Step 14: Apply Size Functions to Control Mesh Quality
In this step, you will create and attach two types of size functions to control mesh
sizes in the regions adjacent to the airplane geometry surfaces. You will apply the size
functions to all faces associated with the external airplane surfaces (that is, all but the
airplane symmetry face). Before creating the size functions, however, you will modify
the graphics display to facilitate picking the size-function source and attachment
entities.
1. Render invisible all faces that are not associated with the size functions.
a) Click the SPECIFY DISPLAY ATTRIBUTES
Control toolpad.

command button on the Global

This action opens the Specify Display Attributes form.

b) Click in the Volumes list box to make it active.
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GAMBIT automatically activates the Volumes check box, indicating that the
display specifications are to apply to any specified volumes.
c) Select the volume in the graphics window.
d) Select the Visible:Off option.
e) Unselect the Lower topology option.
f) Click Apply.
GAMBIT turns off the display of the volume but retains the display of its
bounding faces. Now, you will turn off display of all faces other than the
symmetry plane and the airplane body.
g) Click in the Faces list box to make it active.
GAMBIT automatically activates the Faces check box, indicating that the
display specifications are to apply to any specified faces.
h) Select all six faces of the brick and the airplane symmetry face (see Figure 14-11).

Figure 14-11: Flow volume and airplane symmtery face (shaded)
i) Select the Visible:Off option.
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j) Retain the Lower topology option.
k) Click Apply.
GAMBIT turns off the display of all faces that are not associated with the
airplane surface geometry (see Figure 14-12).

Figure 14-12: Graphics display after change in display attributes
l) On the Specify Display Attributes form, click Close to close the form.
2. Create and apply a fixed size function to the airplane geometry.
a) Open the Create Size Function form.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.
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a) Retain the Type:Fixed option.
b) On the Source option button, select the Faces option.
c) Select the five narrow faces on the trailing edges of the wing and nacelle (see the
shaded faces in Figure 14-13).
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Narrow faces
Figure 14-13: Five narrow faces on trailing edges of wing and nacelle
d) On the Attachment option button, select the Faces option.
e) Select all of the faces displayed in the graphics window by Shift-left-dragging the
mouse to create a rectangular selection box around the airplane geometry.
When you Shift-left-drag the mouse to create a selection box in the graphics
window, GAMBIT selects all displayed entities touched by or enclosed within
the box. In this case, GAMBIT populates the Attachment:Faces list with all of
the faces associated with the airplane geometry surfaces.
f) In the Start size text box, enter the value 0.3.
g) In the Growth rate text box, enter the value, 1.3.
h) In the Size limit text box, enter the value, 5.
i) Click Apply to create and attach the size function.
3. Create a curvature size function and apply it to all faces associated with the airplane
geometry.
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a) On the Create Size Function form, select the Type:Curvature option.
b) On the Source option button, retain the Faces option.
c) Click in the Source:Faces list box to make it active.
d) Select all of the displayed faces by Shift-left-dragging the mouse in the graphics
window to create a rectangular selection box around the airplane geometry.
e) On the Attachment option button, retain the Faces option.
f) Click in the Attachment:Faces list box to make it active.
g) Select all of the faces displayed in the graphics window by Shift-left-dragging the
mouse to create a rectangular selection box around the airplane geometry.
h) In the Angle text box, enter the value 20.
i) In the Growth rate text box, retain the value, 1.3.
j) In the Size limit text box, retain the value, 5.
k) Click Apply to create and attach the size function.
You can view the size functions by means of the View Size Function command
on the Size Function toolpad.
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Step 15: Mesh the Airplane Body Surface
In this step, you will mesh all of the surfaces associated with the airplane geometry
(excluding the airplane symmetry face).
1. Create triangular meshes on the surfaces of the airplane geometry.
MESH

→ FACE

→ MESH FACES

a) Click in the Faces list box to make it active.
b) Select all of the faces displayed in the graphics window by Shift-left-dragging the
mouse to create a rectangular selection box around the airplane geometry.
c) Select the Elements:Tri option.
d) Retain the Type:Pave option.
e) Under Spacing, retain the Interval size of 1.
f) Click the Apply button at the bottom of the form.
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GAMBIT meshes the faces as shown in Figure 14-14, Figure 14-15, and
Figure 14-16.

Figure 14-14: Airplane surface mesh—whole airplane

Figure 14-15: Airplane surface mesh—cockpit area
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Figure 14-16: Airplane surface mesh—partial wing and nacelle
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Step 16: Apply a Size Function to the Symmetry Plane
Now that you have meshed the airplane body surfaces, you will use the meshes on the
edges that bound the airplane symmetry face to define a size function created on the
symmetry plane (that is, the flow-volume symmetry face). To facilitate selecting the
appropriate edges when defining the size function, you will first make invisible all
faces other than the flow-volume symmetry face.
1. Render invisible all of the faces other than the flow-volume symmetry face.
a) Click the SPECIFY DISPLAY ATTRIBUTES
Control toolpad.

command button on the Global

This action opens the Specify Display Attributes form.

b) Select the Faces check box and ensure that the All option is selected.
c) Select the Visible:On option.
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d) Select the Mesh:Off option.
e) Click Apply.
GAMBIT renders the geometry visible and the mesh invisible.

f) Click the FIT TO WINDOW command button
at the top left of the Global
Control toolpad to see the full model geometry in the graphics window.
g) Click the Faces list box to make it active.
h) Select all of the faces associated with the airplane geometry by Shift-left-dragging
the mouse from the lower right toward the upper left to create a rectangular
selection box around the airplane geometry (see Figure 14-17).
Selection box

Figure 14-17: Entire model with selection box
When you Shift-left-drag the mouse from the lower right toward the upper left
to create a selection box in the graphics window, GAMBIT selects only those
entities completely enclosed within the box. In this case, GAMBIT populates
the Faces list with all of the faces associated with the airplane geometry.
i) Manually select (Shift-left-click) all faces of the flow volume brick except the
symmetry face.
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j) Select the Visible:Off option.
k) Click Apply.
GAMBIT renders the model invisible except for the flow-volume symmetry
face (see Figure 14-18).

Flow-volume symmetry face

Figure 14-18: Flow-volume symmetry face
l) Click Close to close the Specify Display Attributes form.
2. Create a meshed size function and apply it to the flow-volume symmetry face.
TOOLS

→ SIZE FUNCTIONS

→ CREATE SIZE FUNCTION

This command sequence opens the Create Size Function form.
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a) Select the Type:Meshed option.
b) On the Source option button, select the Edges option.
c) Select all of the edges that bound the airplane symmetry face by Shift-left-dragging
the mouse from the lower right toward the upper left to create a rectangular
selection box around the airplane symmetry face (see Figure 14-19).
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Selection box

Edges bounding airplane symmetry face

Figure 14-19: Edges that bound airplane symmetry face
d) On the Attachment option button, select the Faces option.
e) Click in the Attachment:Faces list box to make it active.
f) Select the flow-volume symmetry face (see Figure 14-18, above).
g) In the Growth rate text box, enter the value, 1.3.
h) In the Size limit text box, enter the value, 75.
i) Click Apply to create and attach the size function.
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Step 17: Mesh the Symmetry Plane
In this step, you will mesh the flow-volume symmetry face to facilitate meshing of the
flow volume itself.
1. Create triangular meshes on the surfaces of the airplane geometry.
MESH

→ FACE

→ MESH FACES

a) In the graphics window, select the flow-volume symmetry face.
b) Select the Elements:Tri option.
c) Retain the Type:Pave option.
d) Under Spacing, retain the Interval size of 1.
e) Click the Apply button at the bottom of the form.
GAMBIT meshes the flow-volume symmetry face as shown in Figure 14-20.
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Figure 14-20: Triangular paved mesh on flow-volume symmetry face
2. Render all of the geometry visible.
a) Click the SPECIFY DISPLAY ATTRIBUTES
Control toolpad.

command button on the Global

This action opens the Specify Display Attributes form.
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b) Select the Visible:On option.
c) Click Apply.
GAMBIT renders the entire model visible, including the mesh (see Figure 1421).
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Figure 14-21: Flow volume with meshed faces
d) Click Close to close the Specify Display Attributes form.
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Step 18: Mesh the Flow Volume
1. Mesh the flow volume using a tetrahedral meshing scheme.
MESH

→ VOLUME

→ MESH VOLUMES

This command sequence opens the Mesh Volumes form.

a) Select (Shift-left-click) the flow volume in the graphics window.
b) Retain the Elements:Tet/Hybrid option.
c) Retain the Type:TGrid option.
d) Under Spacing, enter an Interval size of 50.
e) Click the Apply button at the bottom of the form to mesh the volume.
GAMBIT meshes the volume as shown in Figure 14-22.
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Figure 14-22: Meshed airplane flow volume
As an alternative to the procedure described in Steps 16, 17, and 18, above, you
could attach a mesh size function to the flow volume, using the meshed airplane
body surfaces as sources for the size function, and mesh the flow volume directly.
Such a procedure would produce a smoother distribution of mesh elements within
the volume but would significantly increase the meshing time and number of
elements created.
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Step 19: Examine the Mesh
1. Click the EXAMINE MESH

command button on the Global Control toolpad.

This action opens the Examine Mesh form.

a) Retain the Display Type:Plane option at the top of the form.
The Examine Mesh form allows you to view mesh characteristics for various types
of 3-D mesh elements. In this case, the volume mesh consists entirely of
tetrahedral elements; therefore, you must specify the viewing of such elements.
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b) Retain the 3-D Element option, and click the tetrahedral button
the form.

at the top of

, thereby enabling the viewing
By default, GAMBIT enables the brick button
of hexahedral elements. In this case, you can retain or disable (by clicking) the
brick element button without affecting the mesh display—because the volume
mesh does not contain any hexahedral elements.
Figure 14-23 and Figure 14-24 show x-y and y-z cutting planes through the mesh.

Figure 14-23: Cutting plane (x-y) showing tetrahedral elements
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Figure 14-24: Cutting plane (y-z) showing tetrahedral elements
You can view element quality by range by selecting the Display Type:Range option,
and clicking one of the histogram bars near the bottom of the Examine Mesh form.
Figure 14-25 shows the elements with EquiAngle Skew values between 0.7 and 0.8.
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Figure 14-25: Display of elements with EquiAngle Skew values between 0.7 and 0.8
c) Click the Close button at the bottom of the Examine Mesh form to close the form.
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Step 20: Export the Mesh and Save the Session
1. Export a mesh file for the airplane and flow volume.
File → Export → Mesh…
This command sequence opens the Export Mesh File form.

1. Enter the File Name for the file to be exported (Airplane.msh).
2. Click Accept on the Export Mesh File form.
The file will be written to your working directory.
3. Save the GAMBIT session and exit GAMBIT.
File → Exit
GAMBIT will ask you whether you wish to save the current session before you
exit.

Click Yes to save the current session and exit GAMBIT.
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14.5 Summary
This tutorial illustrated how to import geometry from an external CAD package as a STEP
file, use GAMBIT healing and clean-up tools to make the geometry suitable for meshing,
apply size functions, and mesh the geometry.

14-56

© Fluent Inc., Sep-04

